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Medical Education Technologies, Inc.®

iStan® Simulator Software and Users Guide©

FOR DEMONSTRATION, LICENSE PURCHASE AND USE

ATTENTION:  USE OF THE SOFTWARE IS SUBJECT TO THE METI SOFTWARE LI-
CENSE TERMS SET FORTH BELOW.  BY INSTALLING, COPYING, DOWNLOAD-
ING OR OTHERWISE USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE 
TERMS OF THIS LICENSE AGREEMENT.  YOU SHALL INFORM ALL USERS OF THE 
SOFTWARE OF THE TERMS AND CONDITIONS OF THIS AGREEMENT.

METI SOFTWARE LICENSE TERMS

Medical Education Technologies, Inc. (METI) is licensed to provide the Software, which 
is an integral part of its series of Simulation Systems.  The Software is licensed for use 
on a designated single computer system provided with the purchase of a simulator.  
Software consists of the graphical user interface, physiological models, scenario pro-
cess, data acquisition and control software, and patient scenarios.

The following terms govern your use of the enclosed Software unless you have a sepa-

rate written agreement with METI.

License Grant

(a) Restricted License

METI grants you, the user, a non-exclusive license to use one copy of the Software un-
der the terms and conditions stated herein.  You agree that all beta releases, upgrades, 
enhancements, maintenance releases, patches, bug-fixes or other modification to the 
Software provided to you shall be governed by the terms and conditions, including the 
limited warranty, exclusive remedies and limitation of liability provisions, contained in 
this agreement.  In addition, you agree that any Software Development Kits, Application 
Programming Interfaces, communication protocols or other information necessary in 
the development of third party applications provided to you by METI shall be governed 
by the terms and conditions contained in this agreement.  The license granted herein 
shall be perpetual provided you comply with the terms hereof.  

Except to the extent that such prohibition is not permitted by law, you may not reverse 
compile, reverse assemble or otherwise reverse engineer any portion of the software or 
create derivative works based upon the METI software, without prior written consent 
from METI.

Designated Equipment
iStan Simulator
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(b) Evaluation Licenses

METI may provide demonstration versions of the Software at no charge to you, for 
evaluation purposes only.  This evaluation Software is licensed to you with all the rights 
set out in the above, but with a limited license terms, operability and/or functionality.  
You agree and acknowledge that METI provides evaluation Software solely for demon-
stration purposes and not for long-term use.  On your accepted order and payment of 
the applicable fee, METI will provide a key or other mechanism to you for conversion of 
an evaluation-limited license to a non-evaluation full restricted license.

Ownership

The Software is owned and copyrighted by METI and/or its licensors.  Your license con-
fers no title or ownership in the Software and is not a sale of any rights in the Software.  
METIís licensors may protect their rights in the event of any violation of these License 
Terms.

Trademarks

This Software Agreement does not grant you any rights in connection with any trade-
marks or service marks of METI.

Copyright

All title and copyrights in and to the Software, the accompanying printed materials, and 
any copies of the Software are owned by METI and/or its licensors.  All title and intellec-
tual property rights in and to the content that may be accessed through use of the Soft-
ware is the property of the respective content owner and may be protected by applica-
ble copyright or other intellectual property laws and treaties. This agreement grants you 
no rights to use such content.  If this Software contains documentation that is provided 
only in electronic form, you may print one copy of such electronic documentation.

Copies and Adaptations

You may only make copies or adaptations of the Software for archival purposes or when 
copying or adaptation is an essential step in the authorized use of the Software.  You 
must reproduce all copyright notices in the original Software on all copies or adapta-
tions.  You may not copy the Software onto any newsgroup websites or similar system. 
Source code, if provided, is so the licensee may combine or modify the Software.  Such 
modified or combined programs, or any derivative programs, or parts thereof, are the 
property of METI and are subject to this licensing agreement.  Any other use, including 
the distribution, sale or licensing of this software, the manuals or program listing, or any 
portion thereof, shall not be made without written approval by METI.
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Transfer

Your license will automatically terminate upon any transfer of the Software.  Upon trans-
fer, you must deliver the Software, including any copies and related documentation, to 
the transferee.  The transferee must accept these License Terms as a condition to the 
transfer.

Termination

This agreement shall be in effect until terminated or, in the case of evaluation software, 
until your license to use evaluation Software expires as designated by METI.  You may 
terminate this agreement at any time by destroying all copies of the Software and cor-
responding documentation. This agreement will terminate immediately without notice 
from METI if you fail to comply with any provision of this agreement.  Upon termination, 
you must destroy all copies of the Software in your possession or control.

Export Requirements

You may not export or re-export the Software or any copy or adaptation in violation of 
any applicable laws or regulations.

U.S. Government Restricted Rights

If the licensee of this Software is an instrumentality of the U.S. Government, then the 
rights conveyed with respect to the listed software are those minimum rights identified 
in FAR 52.227-14 and/or DFARS 252.227-7013.

LIMITED SOFTWARE WARRANTY AND DISCLAIMERS

METI supplies Software on its own behalf or as a licensed distributor of third party pro-
prietary owners.

(a) METI owned Software

METI warrants to you that, in the case of any Software it has identified as its own 
property, the Software will substantially conform to the applicable METI specifications 
in effect at the date of installation and for a period that is consistent with the warranty 
offered or extended with the purchase of a simulation system.  METIís sole obligation 
under this warranty is limited to responding to your calls and to using all reasonable 
endeavors to correct reported problems by supplying you with a corrected version of 
the Software.

DISCLAIMER: TO THE EXTENT ALLOWED BY LOCAL LAW, METI DOES NOT WAR-
RANT THAT OPERATION OF ITS SOFTWARE WILL BE UNINTERRUPTED OR ERROR 
FREE, OR THAT ANY DEFECTS IN THE SOFTWARE ARE CORRECTABLE OR WILL BE 
CORRECTED; OR THAT FUNCTIONS CONTAINED IN ITS SOFTWARE WILL OPER-
ATE IN THE COMBINATIONS WHICH MAY BE SELECTED FOR USE BY YOU TO MEET 
YOUR REQUIREMENTS. METI’S WARRANTY OBLIGATIONS WILL BE VOID IF ITS 
SOFTWARE IS MODIFIED WITHOUT THE PRIOR WRITTEN CONSENT OF METI.  
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(b) Third Party Proprietary Software

All third party proprietary Software is supplied with the benefit of warranties, if any, of-
fered by the third party owners and reproduced by METI.  TO THE FULLEST EXTENT 
PERMITTED BY LAW, METI DOES NOT ITSELF WARRANT THIRD PARTY PROPRI-
ETARY SOFTWARE IN ANY WAY, INCLUDING BUT NOT LIMITED TO ITS PERFOR-
MANCE, RELIABILITY OR FUNCTIONALITY, AND METI DOES NOT ACCEPT ANY 
RESPONSIBILITY FOR PERFORMANCE OF WARRANTY TERMS BY THIRD PARTY 
SOFTWARE OWNERS.

EXCEPT FOR THE EXPRESS WARRANTIES STATED ABOVE, METI DISCLAIMS AND 
EXCLUDES ALL OTHER WARRANTIES WHETHER EXPRESS OR IMPLIED IN LAW 
OR OTHERWISE TO THE FULLEST EXTENT PERMITTED BY LAW, AND THE ABOVE 
WARRANTIES ARE IN LIEU OF ALL OBLIGATIONS AND LIABILITIES ON THE PART OF 
METI FOR DAMAGES ARISING OUT OF OR IN CONNECTION WITH THE SOFTWARE, 
OR YOUR USE OF THE SOFTWARE, INCLUDING WITHOUT LIMITATION ANY WAR-
RANTY OF MERCHANTABILITY, SATISFACTORY QUALITY OR FITNESS FOR A PAR-
TICULAR PURPOSE.

LIMITATION OF LIABILITY: EXCEPT TO THE EXTENT PROHIBITED BY LOCAL LAW, IN 
NO EVENT WILL METI OR ITS AFFILIATES OR SUPPLIERS BE LIABLE FOR DIRECT, 
SPECIAL INCIDENTAL, CONSEQUENTIAL OR OTHER DAMAGES (INCLUDING LOST 
PROFIT, LOST DATA, OR DOWNTIME COSTS), ARISING OUT OF THE USE, INABILITY 
TO USE, OR THE RESULTS OF THE USE OF THE SOFTWARE, WHETHER BASED ON 
WARRANTY, CONTRACT, TORT, OR OTHER LEGAL THEORY, AND WHETHER OR NOT 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

NOTE: EXCEPT TO THE EXTENT ALLOWED BY LOCAL LAW, THESE WARRANTY 
TERMS DO NOT EXCLUDE, RESTRICT OR MODIFY, AND ARE IN ADDITION TO, THE 
MANDATORY STATUTORY RIGHTS APPLICABLE TO THE LICENSE OF THE SOFT-
WARE TO YOU.

If you have any questions about your rights and responsibilities under this Software 
license, please contact Medical Education Technologies, Inc. 6000 Fruitville Road, Sara-
sota, FL 34232 (USA).

License/Copyright



Declaration of Conformity

Application of 

Council Directive (s):	 	 Low Voltage Directive 73/23/EEC,

					     EMC Directive 89/336/EEC

	
Standard (s) to which			 

Conformity is declared:		  EN61010, EN55011, EN61000-3-2, 

					     EN61000-3-3, EN61000-4-2, EN61000-4-3, 

					     EN61000-4-4, EN61000-4-5, EN61000-4-6, 

					     EN61000-4-8, EN61000-4-11

Manufacturer’s Name: 		  Medical Education Technologies, Inc.

Manufacturer’s Address:		  102 Cattlemen Road

					     Sarasota, FL  34232

					     U.S.A.

Type of Equipment:			  Patient Care Simulator — iStan®

Model No.:				    iStan-100

		

I, the undersigned, hereby declare that the equipment specified above conforms to the above 
Directive (s) and Standard (s).

Place:					    United States of America

Date:					     May 20, 2008

			 
						    

						    
					                     		              (Full Name)	

 
									           (Position)

Medical Education Technologies, Inc. Vice President of Engineering 

Carlos Moreno
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iStan Specifications
Size	

	 Mannequin/Simulator 		  72” H x 22” W x 12” D  (183cm x 56cm x 30cm)

	 Instructor Workstation		  1” H x 14.1” W x 9.6” D  (2.5cm x 36cm x 24cm)

Weight
	 Mannequin/Simulator	 	 124lbs (56kg)

	 Instructor Workstation		  5.4lbs (2.5kg)

Environmental Requirements
Ambient Temperature Range

	 Mannequin/Simulator

		  Operation:		  40°F to 104°F	  (4°C to 40°C)

		  Storage:		  40°F to 122°F  (4°C to 50°C)

		 Relative Humidity: 	 0% to 90% noncondensing

	 Instructor Workstation

		  Operation:		  50°F to 95°F  (10°C to 35°C)

		  Storage:		  -13°F to 113°F  (-24°C to 45°C)

		 Relative Humidity: 	 0% to 90% noncondensing

Maximum Altitude	

	 Instructor Workstation	

		  Maximum operating altitude: 	10,000 ft

		  Maximum storage altitude: 	 15,000 ft

		  Maximum shipping altitude: 	 35,000 ft
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Power
	 Mannequin/Simulator

		  AC Input:		  AC 90 – 240VAC, 50/60Hz

		  Consumption:		 Maximum 150W (Charging), 100W nominal

		  Internal Batteries:	 16.8V 100-watt-hour lithium-ion, rechargeable

		  Run Time:		  7 to 8 hours (Typical) 

	 Instructor Workstation

		  AC Input:		  AC 100 – 240VAC, 50/60Hz

		  Consumption:		 Maximum 85W (Charging)

		  Internal Battery:	 10.8V 60-watt-hour lithium-polymer, rechargeable

		  Run Time:		  2 to 4 hours (Typical)

Replacement Fuse
	 F1, DC Power In – 8A, 32VDC (250VAC), 5 x 20mm, IEC 60127-2/2 (Fast Acting)

Communications
	 Simulator Network 

		  Wired:		  10/100 Ethernet or 

		  Wireless:	 IEEE 802.11g

	 Wireless Voice

		  537 MHz to 819MHz (Country Specific)

Electrotherapy
	 Defibrillation:		  20 to 360 joules (Monophasic, Biphasic)

	 Pacing	:		  20ma to 180ma

Air Supply 
When using the optional external compressed air kit in conjunction with the facility sup-
ply source and facility wall adapter. 

	 Maximum pressure: 50 psi to 120 psi 
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Cautions/Warnings
Please read and understand these cautions and warnings before you begin using the 
iStan system. 

USE OF THIS EQUIPMENT IN AN UNSPECIFIED MANNER, MAY IMPAIR 
DESIGNED PROTECTION.

Your safety is in your hands. Be sure to follow the instructions on the proper setup, 
breakdown and use of the iStan system. 

SHOCK HAZARD

Electrical Safety
This product must be connected to an electrical outlet that is properly grounded. •	
Precautions should be taken so that grounding or polarization is not defeated.

Do not place defibrillator paddles on or adjacent to the ECG patient electrodes. •	
Contact between defibrillator paddles and the electrodes may cause injury to the 
user and damage to the equipment.

Always use the supplied power cords. Do not substitute.•	

Operate the system from a power source with the following rating: •	

	 - 115VAC, 50/60 hertz (cycles per second) (e.g., North America, Japan)

	- 230VAC, 50/60 hertz (cycles per second) (e.g., Europe)

Do not allow excess fluids to flow on or into electronic parts.•	

Do not attempt to disassemble the simulator or service any of the electrical          •	
components other than the changing of fuses.

Always remove the power cable and have simulator turned off when replacing fuses.•	

Replace F1 with a •	 32VDC (250VAC), 5 x 20mm, IEC 60127-2/2 fast acting fuse/rated 
for 8 amperes.

Always use the supplied power adapter to charge or run simulator from AC.•	

Latex Warning

METI simulators incorporate latex into their design. When performing certain mainte-
nance procedures, the latex can become exposed. Users with latex sensitivity should 
take necessary precautions when handling the simulator while performing those proce-
dures.

Cautions/Warnings
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General Use Warnings
Electrical System

Operate the system from a power source with the following rating:  115VAC, 50/60 •	
hertz (cycles per second)  (e.g. North America, Japan), and 230VAC, 50/60 hertz 
(cycles per second) (e.g. Europe)

Do not operate the iStan system in rain. Apply water to the mannequin only in ac-•	
cordance with the supported clinical procedures identified in this User Guide.

Do not allow excess fluids to flow on or into electronic parts.•	

CO2 Production System
Care must always be taken when using high-pressure equipment.•	

Do not disassemble or alter regulator.•	

Store CO•	 2 canisters in dry location between 32° and 104° F. (0 to 40°C). Do not ex-
pose CO2 canister to heat above 140° F as rupture may occur.

Never point CO•	 2 canister towards your face or someone nearby.

Use only METI specified CO•	 2 canisters.

Wear protective gloves and eye protection when removing canister from regulator assembly.•	  

Bleeding and Secretion System
DO NOT modify the tank or any assemble component. •	

ALWAYS protect eyes, skin and clothing against accidental exposure.•	

NEVER exceed 35 strokes while pressurizing the tank.•	

ALWAYS read and follow instructions for creating trauma fluids (e.g. blood). NEVER •	
fill the tank with more than 6 liters (1.6 gallons) of fluid. 

After use, ALWAYS release pressure and clean the tank. DO NOT store liquids in the tank.•	

ALWAYS release tank pressure before servicing. NEVER transport or ship in a pres-•	
surized and/or full state or leave a pressurized tank unattended.

Mannequin
Do not disassemble factory-assembled parts of the mannequin.•	

Do not clean the mannequin with chemical solvents. Use water and a light soap solution only.•	

Make sure that mannequin is set up on a stable, sturdy work surface to  •	
avoid collapsing and causing injury to users.

iStan should be operated in ambient temperatures below 104 degrees Fahrenheit •	
(40 degrees Celsius). Prolonged operation (>4hrs) in ambient temperatures greater 
than 104 degrees Fahrenheit (40 degrees Celsius) may result in anomalous behavior 
and out of specification performance.

Do not introduce foreign substances into the airway - with the exception of small •	
amounts of approved lubricant. Only perform invasive procedures supported by the 
system as described in the applicable sections of the User Guide. 

Do not pick the mannequin up by the limbs — support head and leverage weight with •	
torso. It may be necessary to have the help of a second person to lift and move iStan.

Cautions/Warnings
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Introduction
As the worldwide leader in patient simulation technology and education, Medical 
Education Technologies, Inc.® (METI®) is excited to introduce iStan™. With METI’s 
proprietary human physiology model at its core, iStan is designed to answer the need 
for a product that delivers more realism, more clinical features and more flexibility than 
other simulators. Simply put, iStan is like no other simulator before it.

iStan
iStan allows for the physical assessment of various clinical signs (e.g. heart/breath/
bowel sounds, palpable pulses, chest excursion, airway patency, etc.) that are 
dynamically modeled using mathematical algorithms of human physiology and 
pharmacology.

The simulator can be placed on standard operating room tables, an ICU bed, on the 
ground or even in a vehicle (in the case of a simulated accident). iStan can also be 
seated in an upright position.

In addition, iStan has the assessment, airway, cardiovascular, genitourinary, ACLS and 
trauma features familiar to METI customers plus many new specially designed features 
such as cyanosis and capillary refill, trismus, jugular vein distension, SpO2 finger probe, 
fluids on board, bilateral autoinjection, intracranial pressure, intraosseous sites, flail 
chest and programmable speech. 

Wireless and tetherless, iStan takes simulation education to a new and exciting level of 
realism.
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Weight Distribution

iStan is uniquely designed to emulate human weight distribution. This means that when 
iStan is lifted, certain components (e.g., head) respond in similar fashion to the way 
human muscles react to support themselves when lifted. This design allows learners to 
gain an understanding of how to lift and move a real person. 

Skin

Modeled from a cast of a real person, the skin of iStan truly acts, looks and feels like 
real human skin, right down to the goose bumps (cutis anserina). Small “pores” on 
iStan’s forehead have the ability to secrete clear fluid, simulating diaphoresis. 

Information on how to care for iStan’s skin can be found in the iStan Care and 
Maintenance section.

Skeletal Structure

Designed from the inside out, METI has created the first patient simulator truly based 
around a human-like skeletal structure, a revolutionary development in itself. But iStan 
also closely mimics the anatomical workings of the human body at a level of realism 
not possible with other simulators. Spine, neck, arms and hips all mimic the degrees of 
movement of a real person. 

Wireless

iStan is fully wireless and battery operated for amazing portability and versatility. 
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Contained in this User Guide
This User Guide has been designed for quick access to information on how to use and 
maintain your iStan system. Please make sure that you read and follow the Cautions/
Warnings on the pages preceding the Table of Contents. This is for your safety and 
your learner’s safety, as well as for the protection of your simulator.

Each subsequent section has been designed to keep valuable information at your 
fingertips. Before using the system, follow the step-by-step instructions included in the 
iStan Setup section.

The iStan Software Features section provides instructions on the use of the various 
software features as well as how to create and save a new patient.

Using iStan includes information on how the simulator and software components work 
and the functionality that each supports. Various clinical interventions are explained 
in this section along with how these interventions isolate critically important learning 
objectives. In addition, a description is provided of the METI preconfigured patients, as 
well as detailed instructions on how to develop and save your own patients.

We encourage you to follow the iStan care and maintenance guidelines found in 
the iStan Care and Maintenance section, as this will ensure that your system is 
functioning optimally. Warranty details, as well as clean up and care information, are 
included in this section, making it a very important part of keeping your system in good 
working condition.



1.4

Introduction

Equipment Overview
iStan has been designed to be used in any learning environment. iStan’s standard fea-
tures are easily integrated into a laboratory setting or remote locations.

Standard Components Inventory

iStan comes with all the necessary equipment for establishing an educational simulation 
center. 

Detailed descriptions of this equipment can be found in the section iStan Standard 
Equipment (see page 1.6).

As you would with any shipment, cross-check this inventory with your METI packing 
invoice to verify that all components have been received.                                                                                                                

CO2 Canisters (4) 

Standard Equipment

iStan Simulator

Instructor Workstation

Power Cord (Recharger)

Inventory Kit

Wireless Microphone

Trauma Fill Tanks (2)
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Optional Components Inventory

Optional equipment is available to accommodate special customer requirements. For 
example, options like an air compressor, the Waveform Display Monitor and the Trau-
ma/Disaster Casualty Kit enable instructors to create real-life scenarios at authentic 
locations. 

Detailed descriptions of this equipment can be found in the section Optional Equipment 
for iStan (see page 1.9).

Contact METI Customer Support at 866-462-7920 if there are any questions or if op-
tional equipment is needed.

Optional Equipment

Waveform Display Monitor 

Trauma/Disaster Casualty Kit (TDCK)

iStan Replacement Lithium Battery Pack (4)

Moulage Kit

Intracranial Pressure

iStan Learning Modules

Tool Kit

External Compressed Air Kit

Air Compressor

Hands-Free Training Cables
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iStan Standard Equipment
The design of the iStan system allows students to focus on the patient simulator while 
giving instructors the ability to create an endless number of possible clinical situations.

Full-Body Wireless Simulator

All patient assessments and clinical interventions are played out on the iStan man-
nequin, which represents a human patient. At 5 feet 10 inches (177.5 cm) in height 
and weighing 124 pounds (56 kg), iStan is fully operational in the supine, lateral, prone 
and seated positions. The simulator offers features like arm pronation and supination, 
breath, heart and bowel sounds, palpable pulses, patient voice, genitourinary features 
and airway management features. 

The simulator is rechargeable using the Power Cord provided. See page 5.7 for instruc-
tions on recharging the battery.

Instructor Workstation

The Instructor Workstation is a laptop computer that utilizes METI HPS6 Software to 
operate as the main simulation control center. 

The computer runs the underlying mathematical models that generate the physiological 
data that is realized on the simulator. Instructors control the simulator session from the 
Workstation by selecting patient profiles and scenarios that meet the objectives of the 
training module.

IMPORTANT: All METI computer components are preconfigured for use 
with the iStan system. There are no software installation or configuration 
steps required. Only approved METI applications should be installed or 
run on the iStan computer system.
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CO2 Canisters 

Four CO2 canisters are included with iStan for use with a disposable ETCO2 detector. 

Inventory Kit

iStan comes with a number of accessories and replacement components. 

Included in the Inventory Kit are:

Body bag•	

iStan Start-Up Kit (Quick Start Chart, Setup Map, User Guide CD)•	

iStan Logo Accessories•	

Red food coloring•	

Priming syringe•	

Roll (4 ft) of VHB tape and roll of 2 inch wide red tape (for cricothyrotomy)•	

iStan replacement skins (right arm, left arm and two cricothyrotomy skins)•	

BP adapter kit•	

Silicone lubricant•	

Intraosseous replacements (manubrium, left tibial, right tibial)•	

IV vein splice kit•	

iStan priming tube•	

iStan ECG posts•	

Pacing/Defibrillation disks•	

ICP interface cable (with optional ICP iStan)•	

ICP drainage catheters (with optional ICP iStan)•	

Condensation drain•	

Wound umbilical assembly•	

SpO•	 2 probe
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Wireless Microphone

iStan contains a wireless receiver that enables the user to communicate through the simu-
lator using a microphone. The clip-on microphone is attached to a transmitter that may be 
attached to a belt or waistband.

The microphone is battery-operated and has a power switch on the top to turn it on and off

Trauma Fill Tanks

Fluids are supplied to the simulator using a trauma fill tank. Two tanks are supplied so that 
one tank may be used for distilled water and red food coloring (for simulated blood) and the 
other tank used for distilled water (for clear fluids).

These tanks should be cleaned after use, but even with cleaning, it is best to dedicate one 
tank to simulated blood. 
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Optional Equipment for iStan
Additional components enable the iStan system to be customized to fit the specific 
needs of a wide variety of education environments.

Waveform Display Monitor

When launched, the Waveform Display software appears on the Instructor Workstation. 
However, to view the patient physiological changes on a separate, larger viewing space, 
a Waveform Display Monitor can be purchased as an option for use with iStan. This 
monitor plugs directly into the Instructor Workstation using a video cable. 

Once the Waveform Display Monitor is configured, the Waveform Display software ap-
pears automatically on the monitor when launched. Using the Waveform Display moni-
tor and software, instructors and students can monitor the progress of various interven-
tions and protocols on the patient.



1.10

Introduction

Trauma Disaster Casualty Kit (TDCK)

The TDCK adds to the fidelity of a training session by providing the means to add a 
continuous flow of blood from the simulator while using the Moulage Kit to give a realis-
tic look to the injury or condition (product #TF-005).

Moulage Kit

The Moulage Kit may also be ordered separately.

The kit provides the materials needed to create wounds on iStan (product #MODS-999).
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Intracranial Pressure

An Intracranial Pressure feature is available with iStan that allows for the simulation of 
intracranial lesions, hematomas, tumors, infection and impaired crebrospinal fluid (CSF) 
dynamics.

iStan Replacement Lithium Battery Pack

Under normal usage, a battery pack should last up to two years.

Tool Kit

To simplify common adjustments and periodic repairs, METI has put together a kit con-
taining tools selected for use with the simulator (product #TOL-001).
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External Compressed Air Kit

The External Compressed Air Kit gives the user the ability to connect iStan to a METI 
compressor, tank, or wall air using the kit’s hose and fittings. When connecting to wall 
air, the kit attaches to the customer’s wall adapter. 

The internal pump turns off automatically when external compressed air is sensed.

The External Compressed Air Kit includes a flexible 30ft (9m) hose attached to a preset air 
regulator, a fitting for air compressors and adapters for wall or tank air (product #AIR-006). 

Air Compressor

An air compressor (product #AIR-003) designed for quiet operation is available for 
same-room use, and an alternative air compressor (product #AIR-002) is available for 
situations where the compressor resides in a location, such as a storage room, set 
apart from the simulator. 

                                     

Both Air Compressors are AC powered and include a regulator and an air hose with the              
appropriate connector fitting. 

A 220VAC/50 Hz version of the Quiet In-Room Air Compressor (product #AIR-004) is 
also available.
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Hands-Free Training Cables

Hands-Free Training Cables connect to most popular defibrillators and cardiac pacing 
units and take the place of non-reusable electrode pads. 

Three different cable designs are available to support the most popular defibrillation and 
pacing equipment. Each cable kit includes posts that attach to the defibrillator or pace 
locations on iStan.

Physio-Control (Medtronic, Inc.)

		

(product #ACC-005)

Zoll (Zoll Medical Corporation)

		

(product #ACC-006)

Philips (Koninklijke Philips Electronics, N.V.)

		

(product #ACC-007)
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iStan Educational Development

IStan Basic and Advanced courses offer learners at all levels in-depth instruction in the 
setup, operation, development of scenarios and maintenance related to the use of iStan.

The iStan Basic course provides learners with an overview of the system and its 
components, as well as an introduction to patient creation and scenario design.

iStan Basic - two days at METI facility (TRN-011)•	

iStan Basic On-Site - two days at learner-defined facility (TRN-013)•	

iStan Basic On-Site Physician Instructor - two days at learner defined facility with •	
physician-led instruction (TRN-015)

The iStan Advanced course builds upon the concepts introduced in the prerequisite 
Basic course. After a quick review of the Basic course, Advanced instruction spends 
the majority of the two days providing learners with the ability to design patients and 
scenarios that can be used immediately upon completion of the course.

iStan Advanced - two days at METI facility (TRN-012)•	

iStan Advanced On-Site - two days at learner defined facility (TRN-014)•	

iStan Advanced On-Site Physician Instructor - two days at learner defined facility •	
with physician-led instruction (TRN-016)

iStan Learning Modules

METI Learning Modules enhance the use of the simulator by providing preprogrammed              
scenarios and corresponding support documentation (i.e. course objectives, instructor’s 
notes) that can be readily integrated into a lesson plan, a specific curriculum or an 
educational program.

iStan Disaster Medical Readiness (DMR) Learning Module - EDU-018•	

iStan Advanced Cardiac Life Support (ACLS) Learning Module - EDU-020•	

iStan Cardiopulmonary Critical Situations Learning Module - EDU-021•	

iStan Adult Nursing Learning Module - EDU-022•	

iStan Tactical Medical Care - Military (TMCM) Learning Module - EDU-024•	

iStan Emergency Medical Services (EMS) Learning Module - EDU-023•	

The Program for Nursing Curriculum Integration for iStan

The METI Program for Nursing Curriculum Integration (PNCI®) focuses on the 
educational concepts and competencies of existing undergraduate nursing curriculums. 
Developed in partnership with leading nursing schools, the PNCI’s foundation is the 
Integration Roadmap, a four-semester guide that identifies and charts opportunities for 
learning through simulation.

The Program for Nursing Curriculum Integration for iStan is product #EDU-019.
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iStan Setup
The following pages will guide you through assembling and configuring iStan. Below is 
a list of the steps required to prepare iStan for operation.

Setting Up iStan

Place iStan in the Work Area1

Power on iStan2

3

4

Power on the Instructor Workstation

Connect to the Wireless Network

Connect the SpO2 Probe (Optional)

Connect and Power On Monitor (Optional)

Insert the CO2 Canister (Optional)

Fill the Fluid Reservoirs (Optional)
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Before Beginning Setup
Proper operation of the iStan simulation unit requires correct configuration. Before 
setting up the system, keep in mind these basic guidelines:

Understand the Cautions/Warnings information located in the Introduction section of 
this User Guide.

Follow the sequence of steps carefully,

Complete all steps in order, and

Do not power on any components until instructed in the text.

KEEP all original shipping materials, including the BOXES - warranty and repair items 
must be return shipped to METI in their original packaging. 

Because shipping materials should be stored and retained, be sure that all protective 
packing materials and unused ancillary computer parts are secured as well.

If unpacking iStan for the first time, careful use of a box cutter protects both the 
packaging and the product.

A Setup Map and Quick Start Chart cover these same steps in abbreviated fashion 
and are included in this User Guide.
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Step 1: Place iStan in the Work Area
Select a work area with enough room for all equipment, providing ample space for 
easy access to the simulator. At least a 10' x 12' (3 meter x 4 meter) work area is 
recommended for movement of learners and positioning of components around the 
simulator. 

iStan and the Instructor Workstation may all be operated from their batteries, allowing 
for wireless use. 

In a lab environment, make sure that a multi-plug AC power outlet exists within the 
workspace to recharge the simulator and its powered components. 

Before placing the simulator on a surface, be certain that surface can easily support 
200 pounds. 

NEVER lift the simulator by the LIMBS. Leverage the torso of the simulator and support 
the head while lifting. 
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Step 2: Power on iStan
Carefully pull back the skin on iStan’s left hip and move the protective foam a.	
aside.

Locate the power (toggle) switch on the edge of the side plate.b.	

Flip the power switch to the ON position.c.	

Carefully return the skin and foam to its position covering the switch.d.	

iStan can be operated continuously for seven to eight hours without recharging or 
running from a power source.

For instructions on recharging the battery, see page 5.7.

Flip the Power Switch 
from OFF to ON.
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Step 3: Power on the Instructor Workstation
Place the Instructor Workstation (laptop) at the location (e.g. desk, table, gurney) a.	
where it will be used. 

The Instructor Workstation has battery power. Check to be sure that the battery is 
fully charged before relying on the laptop without an AC power source.

To charge the Instructor Workstation:

	 (1)  Plug the AC power adapter into the power port on the laptop.

	 (2)  �Plug the other end of the AC adapter into a surge-protected AC power 
outlet.

To turn on the Instructor Workstation, open the cover and press the power button b.	
located in the upper-right-hand corner of the keyboard area.

When battery power 
is low, the power cord 

may be attached to 
charge the Instructor 

Workstation
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Step 4: Connect to the Wireless Network (If Necessary)
The wireless network should automatically connect when the Instructor Workstation is 
powered on. If there is an instance when the network does not automatically connect, 
follow these steps.

Click once on the airport icon a.	  located at the top-right-hand corner of the 
screen.

Select the airport network. It will be called b.	 iSTANXXX (where “XXX” is the unit 
number)

Enter the Password, which will be c.	 istanxxx (where “xxx” is the unit number).

Click d.	 OK.

The HPS6 software can now be launched (see Starting the Application on page 3.1).
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Optional: Connect the Workstation to a Monitor 
A monitor may be purchased to provide a separate means of viewing the Waveform 
Display software.

To connect the Waveform Display Monitor to Instructor Workstation:

Connect the Apple cable adapter to the video cable. Tighten the thumbscrews on a.	
the video cable to secure the connection.

Plug the remaining end of the Apple cable adapter into the port on the Instructor b.	
Workstation with the same icon.

Plug the remaining end of the video cable into the back of the Waveform Display c.	
Monitor and tighten the thumbscrews to secure the connection.

Press the power button on the Waveform Display Monitor. The waveform display d.	
software appears on the monitor.

For audio through the monitor, connect the audio cable and extension from the 
monitor’s speaker port to the Instructor Workstation’s external speaker port (see Using 
the Waveform Display Monitor’s Speakers on page 2.9).
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Running the Monitor from a Power Source

To to run the monitor from a power source:

Connect the Waveform Display Monitor’s AC power cord to the port in the back a.	
of the monitor. 

Plug the cable into a surge-protected AC power outlet.b.	

Detecting the Monitor

If the Waveform Display Monitor does not display the waveform software, select the 
Display icon  in the upper-right-hand corner of the screen and click on Detect 
Displays.

This option is also made available by selecting System Preferences under the Apple 
menu. When the Display window appears, select the Display icon. The Display window 
appears. Arrange the monitor’s display by selecting Arrangement from the Display 
window and dragging the display icon to the desired location. The Mirror Displays box 
should NOT be checked.

Connect the power cord
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Using the Waveform Display Monitor’s Speakers

The Waveform Display Monitor has external speakers that can be connected to the 
Instructor Workstation so that the sounds produced come through the monitor’s       
speakers instead of those on the Instructor Workstation.

Monitors also come with an audio cable and an audio extension cable. Use of the 
extension cable is dependent upon the distance between the Workstation and Display 
Monitor. 

Plug one end of the audio cable into the speaker port (not the headphone port) at a.	
the back of the monitor.

Plug the other end of the audio cable into the analog external speaker port b.	
identified by the Headset Icon on the Instructor Workstation.

The system is now configured to display the Waveform Display software on the external 
monitor.
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Optional: Connect the SpO2 Probe
Connect and attach the SpO2 probe before powering on iStan. 

Lift the skin on iStan’s left side and locate the SpOa.	 2 jack in the simulator.

Connect the SpOb.	 2 probe to the SpO2 jack in the simulator.

Place the SpOc.	 2 probe on iStan.

The probe is now integrated into the physiological model, the results of which are 
shown on the Waveform Display.
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Optional: Insert the CO2 Canister
Some scenarios rely on the simulation of exhalation of CO2. The following instructions 
will show you how to safely connect the CO2 canister to the umbilical in the simulator.

WARNING: Careful handling, including the use of hand and eye protection, is required in 
the use of CO2 canisters. 

Please read and understand all the important cautions and warnings on removing 
canisters as well as safety steps that must be used when handling CO2 canisters.

Use of CO2 Canisters

Store the CO•	 2 canisters in a dry location between 32° and 104° F. (0 to 40°C)

Do not expose the CO•	 2 canister to heat above 140° F as rupture may occur.

Never point the CO•	 2 canister towards your face or someone nearby.

Use only METI specified CO•	 2 canisters.

Do not remove cannister from regulator base until empty. Canister end becomes •	
punctured when screwed into regulator base.

Never ship the CO•	 2 canister attached to the regulator assembly. 

Assembly of the CO2 Regulator

Care must always be taken when using high-pressure equipment.•	

Do not disassemble or alter regulator.•	

Dry completely if the regulator becomes wet.•	

Discontinue use of this equipment if leakage or visible damage is evident.•	

Insertion of the CO2 Canister

To insert the CO2 canister:

Locate the regulator (shipped in the inventory bag). a.	

While holding the regulator firmly, carefully screw the COb.	 2 canister into the 
regulator as far as it will go. The final turns will puncture the CO2 canister, which 
is necessary for correct operation.

CAUTION: Do not loosen the canister once it has been screwed into the regulator 
assembly until the contents are exhausted and pressure relieved.
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CAUTION: Unscrewing the canister before it is empty results in the sudden release 
of all high-pressure gas with a possibility of liquid CO2 spray. Unprotected skin could 
receive freezing burns.

Lift the skin and move the foam at the simulator’s right midsection and locate the a.	
CO2 pneumatic umbilical hose inside the side tray.

Attach the blue COb.	 2 pneumatic umbilical hose to the connection on the regulator.

Place the COc.	 2 canister, regulator and hoses inside the simulator. Use the Velcro 
mounting surface to secure this assembly to the tray. A properly installed 
assembly will have the CO2 canister sloping down toward the rear of the 
mannequin.

Carefully reposition the foam and pull the skin back over the simulator to its d.	
original location.

Once the canister and regulator assembly is in place, CO2 is measurable with a 
disposable ET CO2 detector during patient exhalations.

Based on the training environment, a CO2 canister may last from 10 minutes (rapid 
breathing) to 25 minutes.

See important Cautions and Instructions for removing, transporting and disposing of the 
CO2 canisters on page 5.23.
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Optional: Prepare the Secretion System
ONLY distilled water or distilled water containing food coloring should be used with the 
secretion system. 

A mixture of no more than 29ml (1 oz) red food coloring with 3.8 liters (1 gallon) of 
distilled water should be used to create “blood.” The blood mixture should be created 
in advance in a separate distilled water container. 

NOTE: The higher the ratio of food coloring, the greater the possibility of staining.

Using the Trauma Fill Tank

The Trauma Fill Tank provides the means by which the simulated blood is transported to 
the on-board blood reservoir.

CAUTIONS and WARNINGS

Carefully follow all instructions for using the Trauma Fill Tank. Pay 
particular attention to the following cautions and warnings:

ALWAYS read and follow instructions for creating trauma fluids (e.g. •	
blood).

ALWAYS protect eyes, skin and clothing against accidental expo-•	
sure.

After use, ALWAYS release pressure and clean the tank.•	

ALWAYS release tank pressure before servicing.•	

DO NOT modify the tank or any assemble component.•	

DO NOT store liquids in the tank.•	

NEVER transport or ship in a pressurized and/or full state.•	

NEVER leave a pressurized tank unattended.•	

NEVER fill the tank with more than 6 liters (1.6 gallons) of fluid.•	

NEVER exceed 35 strokes while pressurizing the tank.•	
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Assembling the Trauma Fill Tank

Careful assembly of the Trauma Fill Tank helps to ensure proper operation.

Step 1: Connect the Trauma Fill Tank Umbilical to the Tank Assembly

To connect the umbilical to the Trauma Fill Tank:

Insert the pink siphon tube approximately 1/2 inch into the pink hose insert.  a.	
(Otherwise, the tank will pump only air.)

Lubricate (with silicone or water) the black o-ring on the pink hose insert.b.	

Push into the threaded tank nipple until fully sealed.c.	

Screw the hose nut onto the threaded tank nipple and firmly hand tighten.d.	

Step 2: Attach the Overflow Bottle to the Tank Assembly

To attach the Overflow Bottle to the Trauma Fill Tank:

Connect the umbilical male connector to the female bottle lid fitting.a.	

Clip the bottle to the tank using the attached biner mechanism.b.	

Operating the Trauma Fill Tank

Be careful to complete the following steps correctly to ensure proper use and  
maintenance of the iStan and its peripherals.

Step 1: Pour the Fluid into the Trauma Fill Tank

Pour the desired amount of fluid into the Trauma Fill Tank, being careful to NOT 
to exceed 6 liters (1.6 gallons) of fluid.

NOTE: The left thigh tank is smaller (0.8 liters) and used for clear fluids (urine, 
diaphoresis, tears and ear, nose and mouth secretions). The right thigh tank 
is larger (1.8 liters) and used for blood (chest tube drainage and ear, nose and 
mouth secretions).

Four (4) liters of simulated blood provides enough fluid to fill the right thigh 
reservoir twice. The amount of blood used in a training session will vary with the 
patient, the wounds simulated and the learner’s experience.

Step 2: Connect the Trauma Fill Tank Umbilical to the Simulator

Attach the tank’s umbilical to the simulator by matching and connecting the 
fittings labeled in blue and yellow.
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For clear fluids, separate the skin on the left side of the simulator at the hip to a.	
reveal a bundle of hoses.

For blood, the hoses can be located by separating the skin on the right side of 
the simulator at the hip. 

Locate the blue FILL hose and yellow VENT hose.b.	

Connect the FILL (with the blue label) and VENT (with the yellow label) hoses to c.	
the METI tank. Connections are male to female.

.                             
                          Connect the Vent Hose	               Connect the Fill Hose

Both connections must be made for correct operation.

Step 3: Pressurize the Trauma Fill Tank and Fill the Reservoir

An integrated hand pump is used to create the pressure for the Trauma Fill Tank. 

WARNING: To prevent ejected pump assembly and/or solution from striking and 
injuring you, NEVER stand with your face or body directly over the top of the tank 
when pumping or loosening the pump.

To operate the pump and fill the reservoir:

Ensure the yellow relief valve on the front of the tank is closed. a.	

Unlock the pump handle by turning counter-clockwise. (Be careful not to loosen b.	
the pump from the tank.) 

Stroke the pump handle up and down from 25 to 35 times to transport c.	
approximately 1 liter of fluid to the reservoir. NEVER exceed 35 strokes while 
pressurizing the tank.

Lock the pump handle back into the pump assembly by turning clockwise.d.	

Watch the Overflow Bottle located on the tank assembly. When liquid begins to e.	
appear in this bottle, the reservoir is full. (Filling the 1.8 liter blood reservoir takes 
approximately 3 to 5 minutes while filling the 0.8 liter clear reservoir takes 1 to 3 
minutes.)
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Step 4: Release Pressure from the Trauma Fill Tank

Immediately release pressure from the tank by turning and holding the yellow pressure 
relief knob clockwise until all air pressure is gone. 

If pressure will not release using the relief knob:

Place a rag over the top of the tank and pump handle.a.	

While firmly pushing down on the pump handle, slowly turn the handle counter-b.	
clockwise.

WARNING: NEVER leave a pressurized tank unattended.

Step 5: Disconnect the Trauma Fill Tank Umbilical from the Simulator

Step 6: Clean the Simulator and Fluid System

When the simulation is completed and the Trauma Fill Tank has been disconnected, 
remove the fluids and clean the simulator (see Cleaning the Simulator and the Fluid 
System on page 5.12).

Step 7: Clean the Trauma Fill Tank

Before storing the Trauma Fill Tank, make sure the equipment is clean (see Cleaning the 
Trauma Fill Tank and Umbilical on page 5.19).

Step 8: Store the Trauma Fill Tank

After cleaning, the Trauma Fill Tank assembly should be stored securely for future use.

Allow the interior of the tank to dry by loosening the pump assembly. Do NOT a.	
leave the pump assembly out of bottle, however, because dust will contaminate 
the system.

Loosely wrap the Trauma Tank Umbilical around the neck of the tank to protect it.b.	

Store all components in a clean, dry area.c.	
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Starting the Application
Power on the Instructor Workstation (see the iStan Setup section for details).

After the OS X operating system loads, a small Users window appears, displaying two 
choices, Administrator and HPS User.

Select 1.	 HPS User. The Login window opens, displaying the Password field.

Enter “hps” in the 2.	 Password field.

Click the 3.	 Login button or press the return key on the keyboard.

The Instructor Workstation should automatically connect to the wireless network. 4.	
If the network does not automatically connect, follow the instructions on page 2.6 
to establish a wireless connection.

To start the HPS6 application, click the 5.	 HPS6 Launcher icon located in the Dock.

 
The Dock

The HPS6 application launches, displaying the HPS menu bar and the Patient Palette. 

Enter “hps” 
in the Password 

field

The Login Window

Click the 
HPS6 Launcher 

icon
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Patient Start Up
When the HPS6 application is launched, a small window called the Patient Palette 
appears. The Patient Palette displays a list of all the currently running patients.

The Patient Palette

The toolbar icons (New, Open, Show and Stop) represent options that are also 
available on the HPS menu bar. The Show and Stop icons are disabled until a patient 
file is opened.

Patient files can also be opened using the menu options or the shortcut keys found on 
the menu.

Any opened patient files 
appear in the window of 

the Patient Palette

Click New or Open 
icons to create a new 

patient file or access an 
existing one
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Opening a Patient File

Once the software is launched, open a preconfigured or any saved, user-defined patient 
by clicking the Open icon in the upper-left corner of the Patient Palette. The Open file... 
window appears, displaying the available patient files.

Opening a Patient File

Use the drop-down menu to navigate to the desired Patient file. You may also click the 
Patients icon to navigate directly to METI preconfigured Patients. Click the Home icon 
to navigate to the HPS User’s top-level directory. Once you have located the desired 
Patient file, click on the file to select it and click the Open icon or double-click the file 
name to start the patient and open the Patient window.

Double-click the file 
name to open the Patient 
window for the selected 

patient

Shortcut to list of 
preconfigured patients

Shortcut to Home 
directory
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Locating Patient Files

The preconfigured patient files are stored in the Patients directory within the 
HPSVersion6 folder. However, newly created files are saved in the Users/Shared 
directory, accessed using the drop-down menu on the Open File window to navigate to 
the proper location.

Locating Patient Files

Creating a New Patient

To create a new patient, click on the New icon and select the Untitled iStan Patient 
option.

Creating a New Patient

The Patient Palette indicates that the system is preparing the untitled iStan patient 
based on the underlying patient, iStan. By starting with iStan, who displays normal, 
healthy vital signs and physiology, new patients each have an established point from 
which to customize parameters. Once the new patient is prepared, the Patient window 
opens with the new, undefined patient.

Navigate to the correct 
location by using the  

navigational menu, selecting 
the folder, and clicking Open

The New icon
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Using the Patient Menu
The Patient menu located on the menu bar also contains the options for opening and 
creating new patients.

The Menu Bar

Several of these options can be used as alternatives to the buttons and icons on the 
Patient Palette and the Patient window. Options can be chosen by either selecting them 
with the cursor or by using the shortcut keys (described below) shown on the right next 
to the corresponding option.

The Patient Menu

Opening a Recent Patient File

As a shortcut, patients files that have been used recently can be opened from the menu 
bar by selecting the Open Recent option from the Patient menu.

Opening a Recently Viewed Patient

The last ten patient files that have been opened are displayed in a menu to the right of 
Open Recent. Once a patient file is selected, the Patient window opens to display the 
corresponding patient.
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Utilizing Shortcut Keys
Many options shown on the HPS menu offer shortcut key alternatives that are displayed 
to the right of the option’s name. 

Save As... Option with Shortcut Keys

For example, the Save As option is performed by simultaneously selecting the Shift, 
Command (  ), and S keys, represented by the symbols on the right.

The Patient Window
Once the patient file is prepared and loaded, the Patient window appears with the name 
of the patient (e.g. iStannette) as well as the name of the host server (e.g. localhost).

The Patient Window

This window opens by default to display the Heads Up Display and the Simulation tab.

Using the Patient Toolbar Icons

The Patient toolbar is located beneath the title bar, displaying several icons used to 
provide basic system functionality.

Menu options for these functions can also be found on the menu bar.

The Patient Toolbar

The patient’s name appears in the title bar. 
The number indicates the number of patient 

files opened during the active session
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Save

Clicking the Save icon saves the active patient file. Files can also be saved using 
the Save option located in the Patient menu or by simultaneously holding down the 
Command (  ) and S keys.

When the Save icon is clicked, the current version of the patient file overwrites 
(replaces) the previous version. Preconfigured patients, such as iStannette, cannot be 
overwritten, so selecting Save prompts a warning requiring the patient to be saved to 
the Users/Shared directory as a new patient file.

When saving a new patient file, the Save file as ... window appears, providing the 
means of naming the patient file and navigating to a location in the directory where the 
file can be stored.

Stop

Clicking the Stop icon prompts a warning to save the patient file. 

 
Lost Changes Warning Box

Clicking the Save button on the Warning box functions in the same way as choosing 
the Save icon (see Save above) while clicking Cancel returns the user to the Patient 
window without saving the file. Clicking Don’t Save closes the active Patient window 
without recording any unsaved changes to the patient file.

The patient file can also be stopped by clicking the Stop icon on the Patient Palette.

Logs

Clicking the Logs icon opens the Logs Drawer at the bottom of the Patient window. 

The Logs Drawer

The buttons on the Logs Drawer provide access to the Event Log, Physiologic Data 
Log and Drug Log. The menu option for showing the Logs Drawer is found under the 
Window menu in the menu bar. When the Logs Drawer opens, the Event Log appears 
by default.
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The Logs Drawer displays three buttons on the left:

Event Log (default) - chronological list of parameter adjustments, patient 
assessments, interventions and administered drugs

Physiologic Data Log - record of patient’s heart rate, blood pressure, arterial 
blood gas values and temperatures

Drug Log - chronological list of all drugs administered to the patient, either as a 
bolus, via an infusion, or autoinjected.

Each time the patient is started, the system automatically captures the information that 
is stored in these three logs. The files that represent this data are saved in the Logs 
folder located inside the HPSVersion6 folder on the hard drive.

Clicking the Log Viewer button on the Logs Drawer creates a separate window for the 
selected log.

Opening a Log Viewer

The Event Log

The Event Log displays a chronological list of events that are time-stamped based on 
the simulated running time of the patient in hours, minutes and seconds.

The Event Log

Parameter modifications and some patient assessment or user interventions such as 
pulse palpation, defibrillation or pacing are listed in the Event Log, which also document 
if the intervention was initiated by the user or resulted from a change specified in a 
running scenario.

The Event Log does not record events such as the application of a facemask to the 
patient, changes in ventilator settings or the auscultation of heart or breath sounds. 
Patient assessment or similar user interventions must be recorded independently.

Click the Log 
Viewer Button
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The Physiologic Data Log

The Physiologic Data Log lists more than 20 different physiological parameters, and is 
updated every five seconds and recorded based on the simulated time of the patient in 
hours, minutes and seconds.

Selecting an item on the log pauses the updating process, the auto-scrolling, until that 
item is clicked again, removing its selection.

The order in which the physiological data appears can be rearranged in both the Logs 
Drawer and the Log Viewer. To rearrange, click on the column header and drag the 
column to the desired location.

Moving Data in the Physiologic Data Log

Because a large amount of data is recorded in the Physiologic Data Log, the horizontal 
and vertical scroll bars can be used to locate needed information.

Columns can be reordered 
by clicking and dragging 

them to a different location
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The Drug Log

The Drug Log records all drugs administered to the patient, either as a bolus, via an 
infusion, or autoinjected.

Bolus dose logs display when the drug was given, the drug’s name, the dose amount 
administered and the origin of the dosage (i.e. User or Scenario).

Drug infusion logs record when the infusion was started (or discontinued), the drug’s 
name and the rate of infusion, either as dose per unit time or as the dose per kilogram 
per unit time (normalized infusion). An infusion is considered to be “running” at the set 
rate until the infusion is altered, turned off or the patient is stopped.

Each entry is recorded based on the simulated time of the patient in hours, minutes and 
seconds.

Bolus Data in the Drug Log

Bolus doses in the Drug Log are recorded as individual entries and are not the 
cumulative dose given to the patient. In the example shown above, a single epinephrine 
dose of 200 mcg followed by a second epinephrine dose of 200 mcg appears as two 
separate entries of 200 mcg and 200 mcg (as shown in the image above), NOT as one 
entry of 200 mcg followed by a total of 400 mcg.
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The Logs Folder

The Logs folder holds the data files from each of the logs for every patient session. 
Located in the HPSVersion6 folder, the Logs folder is accessed by navigating the Mac 
OS X drive.

The Logs Folder

The three log files created for each patient session correspond to the Drug, Event and 
Physiologic Data logs for that session. A number is created sequentially as a prefix 
to each file (in groups of three) with the largest number representing the most recent 
session. The log files are tab-delimited, which allows them to be imported into Excel.

The Logs folder is located 
inside the HPSVersion6 folder 
installed under Applications
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Detach Tab

When the Detach Tab icon is clicked, a separate window appears displaying the active 
tab. 

A Detached Simulation Tab

When a tab such as the Condition tab has multiple menu options (e.g. Trauma and 
Assessment), then the active option is displayed in the new window. Multiple tabs can 
be detached and used to isolate specific controls. 

The menu option for detaching tabs is found under the Window menu in the HPS menu 
bar.

Recorder

Clicking the Recorder icon opens the Event Recorder, a separate window that initially 
displays a list of the patients opened during the current session. 

Event Recorder

Click the Detach Tab 
icon to create a separate 

window for the information 
on the selected tab
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To record events, select the patient and click the Record button. Each event created 
using the parameters available under the various tabs is recorded and listed in the 
Event Recorder window. 

To stop the recording process, click the Stop button. To clear an event, select the event 
and click the Clear event button. To clear all events, select the patient name and click 
the Clear events button. 

The menu option for displaying the Event Recorder is located under the Window menu 
(see Using the Event Recorder on page 3.63).

Patient Time

The Patient Time display keeps track of the simulation time. By default, the digital 
readout records and presents real time.

Patient Time

Three buttons appear to the right of the readout showing icons for the Pause, Play and 
Fast Forward functions. The active button has a red icon.

Pause - “freezes” the simulation in its current state. Any ongoing parameter 
changes, drug effects or scenario events remain suspended until either the Play 
or Fast Forward buttons are clicked. While time is paused, all parameters cycle 
through a continuous loop of approximately 10 seconds. Changes made during 
the use of Pause are not saved or put into effect.

Play - keeps track of the simulation time for the patient. Parameter changes, 
drug effects and scenario events play out at their normal, model-driven rate.

Fast Forward - runs the physiological models at approximately four times normal 
speed. Parameter changes, drug effects and scenario events continue at an 
accelerated pace until either the Pause or Play buttons is clicked. Spontaneously 
breathing patients breathe at an accelerated rate.

Fast Forward

Play

Pause

Simulation Time
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Connection Icons

The two connection icons, Disconnect and Connections, appear on the right side of 
the Patient toolbar. Clicking the Connections icon opens the Connect to Simulator 
drawer.

Connection Icons and Connect to 
Simulator Drawer

A list of available simulators appears in the Connect to Simulator drawer.

Select the appropriate simulator and click Connect, or

Double-click on the appropriate simulator.

Even if only one simulator is present (which is often the case), the connection process 
must be followed.

When the software and simulator are successfully connected, the connection drawer 
closes and the Disconnect icon is enabled.

To close the drawer without connecting to the simulator, click on the Connections icon. 
To disconnect the software from a patient mannequin, click on the Disconnect icon.

To switch the simulator from one active patient to another: 

Click the 1.	 Disconnect icon on the toolbar or the Disconnect button on the 
Drawer.

Select the desired patient file in the Patient Palette and click the 2.	 Show icon.

Click the 3.	 Connections icon to open the drawer.

Select the simulator in the 4.	 Connect to Simulator drawer and click the 
Connections icon or the Connect button at the bottom of the drawer.
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Viewing the Heads Up Display (HUD)
The Heads Up Display (HUD), located on the left side of the Patient window, displays 31 
selected patient parameters that register the patient’s physiological condition.

The Heads Up Display (HUD)

When adjustments are made to the parameters in the software, the underlying models 
determine all the appropriate physiological changes, and the effects of the adjustments 
appear on the HUD.
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HUD Parameters
Parameter Name Units Notes

HR Heart Rate bpm (beats/min)
MAP Mean Arterial Pressure mmHg
C.O. Cardiac Output lpm (liters/min)
SpO2 Pulse Oximeter Saturation %
Hct Hematocrit % Determined dynamically based on blood and fluid losses and 

intravenous infusion of colloids, crystalloids, packed red blood cells 
and whole blood, hence helping determine the O2 transport in the 
blood.

Isch. Idx. Ischemic Index (unitless) See page 3.17
ABP Arterial Blood Pressure mmHg
PAP Pulmonary Arterial Pressure mmHg
CVP Central Venous Pressure mmHg
CS-X Cervical Spine X Coordinate Based on sensored horizontal movement of the head.
ICP Intracranial Pressure mmHg
CS-Y Cervical Spine Y Coordinate Based on sensored vertical movement of the head.
Left Vol. Left Lung Volume ml Measured volume inside the mannequin, ideally, the alveolar volume.
Right Vol. Right Lung Volume ml Measured volume inside the mannequin, ideally, the alveolar volume.
Spont. VT Spontaneous Tidal Volume ml Not a measured volume, but a desired tidal volume generated by the 

models. Tidal volumes measured at the patient circuit (mechanical 
ventilation) generally do not match the value displayed on the HUD 
and often report a value less than the desired tidal volume.

PACO2 Alveolar Carbon Dioxide mmHg The partial pressures of respiratory gases (CO2 and O2) in the 
patient’s alveoli. A software model of the lungs controls these values.

PAO2 Alveolar Oxygen mmHg The partial pressures of respiratory gases (CO2 and O2) in the 
patient’s alveoli. A software model of the lungs controls these values.

Spont. RR Spontaneous Respiratory Rate bpm 
(breaths/min)

Determined by the underlying physiological models. For a 
spontaneously breathing patient, this value should match the 
observed respiratory rate of the mannequin. For a mechanically 
ventilated patient, Spont. RR does not match the value displayed on 
the ventilator.

Alv. N2O Alveolar Nitrous Oxide mmHg The partial pressures of the anesthetic agent in the mannequin’s 
lungs.

Alv. Iso. Alveolar Isoflurane mmHg The partial pressures of the anesthetic agent in the mannequin’s 
lungs.

Alv. Sevo. Alveolar Sevoflurane mmHg The partial pressures of the anesthetic agent in the mannequin’s 
lungs.

Alv. Halo. Alveolar Halothane mmHg The partial pressures of the anesthetic agent in the mannequin’s 
lungs.

Alv. Enf. Alveolar Enflurane mmHg The partial pressures of the anesthetic agent in the mannequin’s 
lungs.

pH pH (unitless) Respiratory acidosis or alkalosis simulated in real time depending 
on the alveolar concentration of CO2.

PaO2 Arterial Oxygen mmHg
PaCO2 Arterial Carbon Dioxide mmHg
PvO2 Venous Oxygen mmHg
PvCO2 Venous Carbon Dioxide mmHg

TBody Body Temperature ˚C Not tied to the underlying physiological models. Fahrenheit unavailable.
Weight Patient Weight kg Sets the patient’s weight used by the pharmacological models. The 

patient’s body mass index and body structure (e.g. lean, muscular, 
obese, tall or short) cannot be altered or defined.

TBlood Blood Temperature ˚C Linked to the oxyhemoglobin dissociation curve. Thus, hyperthermia 
causes a rightward shift, while hypothermia causes a leftward shift 
to the standard oxyhemoglobin dissociation curve. Beyond this, not 
tied to the underlying physiological models. Fahrenheit unavailable.
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The Ischemic Index

The Ischemic Index is a measure of the myocardial ischemia modeled using classical 
determinants. When an unfavorable oxygen supply/demand ratio occurs, myocardial 
ischemia follows. The lower the Ischemic Index, the greater the myocardial ischemia. 
The Ischemic Index is derived through the underlying HPS models and cannot be 
measured clinically. 

Favorable supply/demand ratios (slower heart rates, higher blood oxygenation levels) 
generally result in a higher Ischemic Index value, whereas unfavorable supply/demand 
ratios (faster heart rates, lower blood oxygenation levels) generally result in a lower 
Ischemic Index value.

Model-Driven ECG Rhythm Ischemic Index (I.I.)
Normal Sinus Rhythm (NSR) I.I. ≥ 0.90

Mild ST Segment Depression 0.90 > I.I. ≥ 0.70

Moderate ST Segment Depression 0.70 > I.I. ≥ 0.60

Premature Ventricular Contractions (PVCs) 0.60 > I.I. ≥ 0.40

Ventricular Tachycardia (VTach) 0.40 > I.I.

Ventricular Fibrillation (VFib) 1 minute after VTach

Asystole 1 minute after VFib

The patient’s response to myocardial ischemia may be altered using the Ischemic 
Index Sensitivity parameter found in the Cardiovascular tab under the Heart menu. To 
make the patient less sensitive to ischemia, lower the value below the default setting. To 
make the patient more sensitive, increase the value above the default setting.
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Working with Tabs

Beneath the toolbar on the right side of the Patient window is a series of tabs that 
provide access to the physiological controls used during a simulator exercise.

The Seven Tabs

The tabs display seven different categories offering varying functionality:

Simulation (default) - view patient information and medical history

Scenario - run and create patient scenarios

Condition - set parameters for assessment and trauma conditions

Drugs - administer drugs

Fluids - affect plasma and blood volumes as well as urine output

Cardiovascular - set a wide array of parameters affecting cardiovascular 
physiology

Respiratory - control airway, lung and respiratory control parameters

Clicking on a tab displays the functionality available for selecting and setting 
parameters within the identified category. Several categories are further divided into 
sub-categories found on a pull-down menu.
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Numeric and Discrete Parameters

On the Condition, Cardiovascular and Respiratory tabs, parameter settings provide a 
large number of alternatives creating a wide range of physiological responses.

There are two types of parameters:

Numeric - set either a measured value (e.g. 20 ml) or a multiplied value (e.g. 
Heart Rate Factor 2.0 is two times the baseline Heart Rate)

Discrete - select one of two or multiple options

Once a parameter is selected and set, the patient’s physiology changes according to 
the model for that parameter.

Numeric parameters are generally changed by clicking in the relevant field and entering 
a new value in place of the existing one. In some cases, a slider is available that moves 
through the range of parameter values until established at the desired numeric value.

Discrete parameters are changed by clicking on the appropriate option (radio button).

Parameter Settings

Once a parameter is selected, the panel to the right displays the available settings.

Setting Parameters

Click the radio buttons for the desired discrete parameters and enter or use the slider to 
establish the numeric parameters. Then, click the Set button.

Click Set
Select a tab, a sub-category 

and a parameter

Click the desired discrete parameters

Enter or use the slider to 
set numeric parameters
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The new parameter values immediately begin to affect the patient’s physiology. 
Depending on the parameter and its settings, changes can be dramatically 
instantaneous or can take place more slowly over time.

Values Increasing Over 60 Seconds

In the example above, Intrapleural Volume in the left lung is set at 730 ml over 60 
seconds. Gradually, the effects of this change will appear on the HUD as the volumes 
for the left lung decreases. If the Onset time had been set to 0 (the default), the change 
would have taken place immediately.

In some instances, the parameter setting produces a model-driven response.

Five parameters have this capability:

Fixed Neuromuscular Blockade (located under Assessment on the Condition 
tab and under Respiratory Control on the Respiratory tab)

Fixed Heart Rate (located under Heart on the Cardiovascular tab)

Fraction of Inspired O2 Override (located under Lung on the Respiratory tab)

Respiratory Rate Override (located under Respiratory Control on the 
Respiratory tab)

Tidal Volume Override (located under Respiratory Control on the Respiratory 
tab)

These parameters all have a default setting of -1 that signals the software to perform 
physiological changes based on the models without instructor intervention. 

Changes to values can take 
place gradually (Onset) over 

an established time
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In the example below, setting the Fixed Heart Rate to -1 means the heart rate 
automatically rises when the selected patient becomes hypovolemic. The loss of 
volume is factored into the mathematical models and results in a compensatory rise in 
the simulator’s heart rate.

Setting an Automatic Response

Setting the value to any other number (e.g. 60 beats/min) fixes the parameter at that 
number regardless of the underlying patient physiology and learner interventions such 
as drug administration.

 The -1 parameter setting 
allows the models to drive 

the patient’s responses
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Saving Data
Patient information can be saved locally on the hard drive or transferred to external 
storage via a CD or a USB memory device. Files are created in a simple text (TXT) 
format. Consequently, transferred files can be printed on any computer (PC or Mac) that 
has printing capability.

Backing up files is especially important when custom patients and scenarios have been 
created. Whenever important files exist, it is recommended that the files be stored on a 
second source and a hard copy of the records be generated.

Saving Patient Files

Before the Patient window is closed, the patient file can be saved using either the Save 
icon on the Patient window or the Save or Save As options located on the Patient 
menu. Clicking the Stop icon on the Patient window also prompts a warning that 
provides an option to save.

If the file is being saved for the first time, the Save file as ... window appears. 
Navigate to the Shared directory. As a shortcut, clicking on the Home icon navigates 
automatically to the user’s default directory.

Saving a New Patient File

Enter the new name in the Selection field and click Save.

All customized patients and scenarios should be saved in the Users/Shared folder.

By default, patient files are stored in the preset /Users/Shared folder. However, files can 
be stored in any folder on the hard drive. The navigational pull-down menu at the top of 
the window provides the means for locating the appropriate folder. 

Click on the Home icon 
to navigate to the user’s 

default directory
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Saving as Text or PDF Files

HPS files can be saved in a text (TXT) format, so the files can be opened by any word 
processing software.

Saving as a Text file removes most formatting. To print in the most readable format, 
open the file and reformat the document. The contents of the text document can also 
be selected, copied, and pasted into word processing software for further modification.

Screenshots of the current screen may be saved in a PDF format by selecting Print 
from the Patient menu to activate the Print dialog. On the Print dialog, open the PDF 
pull-down menu on the lower left and select the Save as PDF option. The Save dialog 
appears, providing a Save As field for the file’s name and a Where navigational field to 
locate the place where the file is to be saved. Click Save to save the screenshot as a 
PDF. 

Moving Files Using a USB Memory Device

Once files have been saved on the Instructor Workstation, they can be moved to 
another computer using a USB memory device.

To transfer files using a USB memory device:

Insert the USB memory device into an available USB port on the Instructor 1.	
Workstation. An icon appears on the desktop indicating that the memory device 
has been recognized.

Locate the appropriate folder on the hard drive under HPSVersion6 containing 2.	
the file(s) to be saved.

Drag the file(s) from the folder on the hard drive to the memory device icon on the 3.	
desktop. The files are copied automatically onto the device.

Double-click on the memory device icon to open the window for the device and 4.	
confirm the files have been copied.

Drag the icon to the Trash to disconnect the memory device.5.	

Remove the memory device from the USB port.6.	

USB Memory Device Icon
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Moving Files Using a CD

Saved files can be moved to another computer using a CD.

To transfer files using a CD-ROM:

Insert a blank CD in the CD drive on the front of the Instructor Workstation. A 7.	
dialog box appears with a field highlighted by default for labeling the CD.

Naming the CD

Enter the new name in the 8.	 Name field (overwriting the default name).  

Click 9.	 OK.

Locate the folder with the information you wish to save (e.g. log files, custom 10.	
patients, custom scenarios).

Select and drag the appropriate files from the drive to the CD.11.	

Dragging Files to a CD

Double-click on the CD icon to open the window for the CD and confirm the files l.	
have been copied.

Drag the CD file to the Trash icon on the Dock. When the CD file is over the m.	
Trash, the icon changes to a Burn CD icon.

Click OK

Enter a name 
for the CD in the 

Name field
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Burn CD Icon

A dialog box appears with the options to Burn, Cancel or Eject.

Burn CD Dialog

CDs can also be burned by selecting the File menu from the Finder and then selecting 
the Burn Disc option.
Click the Burn button on the dialog box. Once burning is complete, the CD reappears 
on the desktop.

To remove the CD from the CD-ROM drive, drag the CD file to the Trash icon in the 
Dock. The icon changes to an Eject icon, and the CD is ejected.

CDs can also be ejected by selecting the CD file and choosing the Eject option from 
the Finder’s File menu or by pressing the Eject key.

Printing Files
Printing should not be performed from the Instructor Workstation. Instead, transfer the 
needed files to a CD or USB memory device and insert the CD or memory device into a 
computer with printing capabilities.
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Tabs
Patient physiology and background is created and controlled through the HPS6 
software using the patient parameter settings in tabbed sections that organize all of the 
various parameters by system and functionality.  

The Simulation Tab

The Simulation tab appears when the patient file is opened. This tab provides basic 
information about the patient such as the patient’s name, history and photograph.

The Simulation Tab

Information on user-created patients must be provided by the instructor. 

Get basic 
information on 

the patient

Read the 
patient’s history
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The Scenario Tab

Selecting the Scenario tab opens a window providing the tools needed to create or 
play patient scenarios that duplicate clinical situations by automatically simulating 
patient responses to a series of events. 

The Scenario Tab

By default, Player is selected in the Show pull-down menu and the Scenario Player is 
displayed on the Scenario tab.

Initially, 12 preconfigured scenarios can be opened from the Scenario menu:

Angina with Cardiac Arrest•	

Anterior Myocardial Infarction•	

Asthmatic with Pneumothorax•	

COPD Exacerbation with Respiratory Failure•	

Heart Failure with Pulmonary Edema•	

Inferior Myocardial Infarction•	

Organophosphate Exposure•	

Pneumonia with Septic Shock•	

Severe Young Asthmatic•	

Splenic Rupture with Pneumothorax•	

Stab Wound to the Chest•	

Subdural Hematoma•	

Additional scenarios can be created or scenarios can be modified using the Scenario 
Editor (discussed later in this section).

Choose 
the Player or 
Editor option

Play scenarios 
selected from the 

Scenario pull-down 
menu
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Playing Scenarios

Any patient may be selected for any available scenario; however, patients with 
preestablished conditions may not work well with scenarios anticipating a patient 
with a different physiological status. For example, selecting a patient with profound 
neuromuscular blockade for a scenario expecting a spontaneously breathing patient will 
not yield the results expected by the scenario author. 

To play a scenario:

Open the scenario using the 1.	 Scenario pull-down menu on the Scenario tab.

Navigate between the states of the scenario by using the buttons at the bottom 2.	
of the Scenario tab.

Add interventions (learner, instructor, or automatic) when desired.3.	

Patients respond realistically to all scenario events and interventions.

Opening a Scenario

To open a scenario, select either Open or Open Recent from the Scenario pull-down 
menu.

Opening a Scenario

Selecting Open activates the Open file window, displaying the available scenario files. 

Selecting iStan Scenarios

Select Open 
from the Scenario 
pull-down menu

Select the desired 
file from the available 

Scenarios

Click the Open button 
once the desired scenario 

has been selected

Selecting a file enters 
the file name in the  

Selection field
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In the Open file window:

Locate the folder that contains the scenarios using the navigational pull-down 1.	
at the top of the window. (The preconfigured scenarios are located in the iStan 
Scenarios folder.) 

Select the desired scenario file.2.	

Click 3.	 Open (or double-click on the scenario file).

The chosen scenario appears in the Scenario panel.

When you select Open Recent from the Scenario pull-down menu, the most recently 
used (with a limit of ten) scenarios appear as options.

Opening a Recently Used Scenario

Select the desired scenario from the list.

The chosen scenario appears in the Scenario panel.

Multiple scenarios can be opened at one time. Additionally, it is possible to run multiple 
patients with multiple scenarios, but doing so may result in a drop in the computer’s 
performance. 

Select the desired scenario 
from the Open Recent list.
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Understanding the Scenario Script

When a scenario appears, the states that comprise the scenario appear in the Scenario 
panel.

An Opened Scenario

The simulation begins in the first listed state. In the example above, this state has been 
labeled Baseline. Selecting a state reveals the Events and Transitions headings for that 
state. 

Selecting a State

Each state contains both headings, but not all states have events and/or transitions. 

The name of the active  
scenario appears in the 
Opened Scenarios box

The name of the active 
state appears in the Current 

State box
The states that comprise 
the scenario appear in the 

Scenario panel

Selecting a state reveals 
the Events and Transitions 

headings
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Select a state’s Events or Transitions heading to see the events or transitions for that 
particular state.

Expanding Events and Transitions

States may contain any number of events and/or transitions. 

Events set specific parameters that take place when a state is active. Certain events are 
set to take place over a period of time.

Transitions offer conditional parameters that take place only when (and if) conditions 
are met. In other words, when a parameter fulfills a condition (e.g. if Time in State > 240 
seconds), a specific action takes place (e.g. then go to Ventricular Tachycardia). For 
more information on Transitions, see page 3.53.

To view all the events and transitions for a scenario, click the Expand All button.

Expand All and Collapse All Buttons

Click the Collapse All button to return to a view showing only the scenario’s states.

Selecting the Events and 
Transitions headings reveals the 

state’s events and transitions

Click the Collapse All button to 
show only the statesClick the Expand All button to 

reveal all events and transitions
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Navigating Between States

Generally, scenarios are designed with states that begin at the top and ending at the 
bottom. The preconfigured scenarios included with iStan are designed in this fashion. 
However, scenarios can be created that intentionally skip or repeat states, often 
depending on the nature of the intervention. Since scenarios are usually developed with 
a specific order in mind, reversing or altering that order may cause unrealistic results.

To move from the active state to the state that follows, click the Next button.

Moving from One State to the Next State

The name of the new active state appears in the Current State box and the time that 
state has been active is shown in the State time box.

In the example above, clicking Next while the Pneumothorax state is active makes the 
Tension Pneumothorax state, the next state in sequence, the active state.

To move from the active state to any other state (no matter the sequence), select the 
desired state and click the Go to button.

Changing States with the Go to Button

The selected state becomes active and its name appears in the Current State box.

Click the Next button to move to 
the next state (downward) on the list

Time for each state begins as 
soon as that state becomes active and 

is recorded in the State time box

Click the Go to button to make 
the selected state active

Select the desired state
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Closing Scenarios

Scenarios run until closed. To close a scenario, select the Close option from the 
Scenario menu.

Closing a Scenario

Even though a scenario has closed, the physiological changes made to the patient 
during the scenario remain.

Working with Multiple Scenarios

The patient’s condition may be affected by events from any active scenario; therefore, 
running multiple scenarios enables the instructor to alter patient physiology using the 
states defined in more than one scenario.  

Switching Scenarios

To switch between multiple open scenarios, select the desired scenario from the pull-
down list to the right of the Scenario box.

Switching between Open Scenarios

The selected scenario becomes available for manual adjustments, but the physiological 
changes dictated by both scenarios continue to take place.

It is also possible to simultaneously run multiple patients with scenarios, but this is not                    
recommended because computer performance is often hampered when two or more 
patients and the Waveform Monitor Display are operating.

Repeating Scenarios

The physiological changes made to the patient remain unless returned to their baseline 
numbers by further events and transitions in the scenario. In other words, the condition 
of the patient retains the effects of the scenario events unless specifically reset. 

To be sure that a scenario is identically repeated, close the original scenario and stop 
the patient. Then, reopen the same patient and open the same scenario.

Select Close to 
close the scenario

With multiple scenarios 
open, choose the desired 

scenario from the  
pull-down list
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Editing Scenarios

In addition to the twelve preconfigured scenarios, new or revised scenarios can be 
created and saved using the Scenario Editor. 

To create or edit a scenario:

Select the 1.	 Editor option from the Show menu at the top of the Scenario tab.

Selecting the Scenario Editor

Select the 2.	 New, Open or Open Recent option from the Scenario menu to 
choose whether to create a new scenario or to open and edit an existing one. 

Add states, events and transitions as desired by selecting the 3.	 New State, New 
Event and New Transition options from the Scenario menu.

Save the new or modified scenario using the 4.	 Save or Save As options from 
the Scenario menu. Naming the file using the Save file as navigational window 
during the Save function also names the scenario.

Once a scenario has been saved to a folder on the hard drive, that scenario is available 
for all patients.

A more detailed explanation of the method of editing and creating scenarios is 
contained in the pages that follow.
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Modifying Existing Scenarios

Either to permanently change or to create a new version of an existing scenario, in the 
Scenario Editor:

Open an existing scenario by selecting the Open or Open Recent option from the 
Scenario menu.  

Opening an Existing Scenario

When Open is selected, the Open file window appears, providing the navigational tools 
to locate, select and open the appropriate scenario file.

Opening the Scenario File

Select the scenario 
and click Open
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Selecting the Open Recent option displays the most recently used (with a limit of ten) 
scenarios as options.

Opening a Recently Used Scenario

The scenario file opens in the Scenario Editor. When the opened scenario appears, 
options become active for adding, editing and saving states, events and transitions on 
the Scenario menu. 

The Editor Scenario Menu

See below for details on adding or editing new states (see page 3.38), new events (see 
page 3.41) or new transitions (see page 3.53).
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Developing New Scenarios

To create a new scenario in the Scenario Editor, select New from the Scenario menu.

Opening a New Scenario

The new scenario initially displays only an Untitled name and a blank Scenario panel.

The New Scenario’s Initial Panel

Once the Untitled scenario appears, options are available on the Scenario menu for 
adding states, events and transitions as well as for saving the new scenario.

See below for details on adding or editing new states (see page 3.38), new events (see 
page 3.41) or new transitions (see page 3.53) or for saving the scenario (see page 3.61).
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Adding, Editing and Deleting States

Scenarios are organized by the states that are simulated with the patient as diagnoses 
and interventions take place. As organizing structures, states by themselves do not 
cause changes to the patient’s physiology. Those occur based on the events and 
transitions defined for the state.  

States are added in a set sequence and cannot be moved. Creating states in the 
order they occur in the scenario enables easier navigation using the Next button, but 
navigation can occur in any order and scenarios may involve skipped or repeated 
states, dependent on user intervention (see page 3.32).

To create a new state, select the New State option from the Scenario menu.

Creating a New State

The new state (initially named NewState) appears in the Scenario panel.

Selecting a New State
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Select NewState to display the Events and Transitions headings and to activate the 
Change state name to field in the lower panel.

Display a New State

Enter the new name in the Change state name to field and click the Apply button.

Renaming a New State

The new name appears in the Scenario panel.

To edit the name, select the state in the Scenario panel, highlight the old name in the 
Change state name to field, enter the new name, and click Apply.
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After creating the state, events and transitions are added to define the state. (See below 
for details regarding adding events and transitions.) 

Additional states in the scenario are added in order and cannot be moved.

If the exact sequence of states is unknown when the scenario is first being created, 
it may be helpful to add unidentified states between known states to ensure a proper 
progression of states when the scenario is finished. These unidentified states can then 
be later defined as necessary intermediate states or deleted if they are unneeded. 

Editing State Names and Deleting States

States can be deleted by first selecting the state and then choosing clear from the edit 
menu or pressing the delete key.

All events and transitions defined for the deleted state are also deleted.
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Adding, Editing and Deleting Events

Events set the specific parameters that take place when the state is active. An event 
may alter a parameter (e.g. Increase the Heart Rate Factor), administer a drug (bolus or 
infusion) or trigger the move to a new destination within the scenario. 

To add events to a state:

Select the state in the Scenario panel1.	

Choose an option from the list displayed by selecting the 2.	 New Event option from 
the Scenario menu.

Editing Event Names and Deleting Events

Set the parameters for the event. (The type of parameter is determined by the 3.	
type of event.)

Editing an Event

Once an event has been created, it can be modified by selecting it and entering new 
values for its parameters. This occurs in the same way that the event was created and 
defined.

Deleting an Event

To delete an event, select the event and press the delete key. Deletions are irreversible. 
Always be sure that the event is not needed before performing the delete function. 

Events can also be deleted by selecting them and then selecting the Clear option from 
the Edit menu.
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There are six different options for new events:

New “Set” Event

New “Bolus” Event

New “Call” Event

New “Go To” Event

New “Infusion” Event

New “Multiply” Event

Each of these options has a unique purpose and different parameter settings.

“Set” Events

A “set” event establishes a specific parameter within a scenario.  All adjustable 
parameters (i.e. numerical and discrete) can have a “set” event. A parameter that has a 
“set” value remains unaffected at that setting until changed by another event, such as 
another set event or a user intervention.

In some cases, the “set” event can have an “onset” time, thereby allowing for smoother         
hemodynamic or respiratory changes. For example, the event set Heart Rate Factor to 
1.5 over 1 minute changes the Heart Rate Factor parameter from the patient’s default 
value to a value of 1.5 over a minute’s time. In these cases, the destination value (e.g. 
1.5) can be greater than or less than the starting value.

When a parameter is set to a specific value, the instructor can change the parameter 
to a new value to override the scenario’s instructions. However, if an “onset” time is 
established in the scenario instructions, it is NOT possible to override the command 
until the onset of the value has completed. 

“Set” events should be avoided in transitions. As an example, to set the eyes to closed 
when SpO2 is less than 90 percent, create a transition called “If SpO2 < 90%, then go 
to state Eyes Closed.” The “Eyes Closed” state would then contain an event “set Eyes: 
Blink Control to Eyes Closed.”
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To establish a “set” event:

Select the appropriate state. 1.	

Choose 2.	 New “Set” Event from the New Event option of the Scenario menu.

Selecting a New “Set” Event

The phrase set ? to ? appears beneath the Events heading of the selected state.

Select 3.	 set ? to ?. The lower panel changes to display three fields beginning with 
the set field.

Selecting a Parameter to Set

Using the pull-down list, complete the 4.	 set field by selecting the parameter.
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Generally, the default value for the parameter appears in the value field on the second 
line.

Depending on the nature of the parameter, change the value field by entering a 5.	
new value or by selecting a value from a pull-down list.

Selecting a Value for the Parameter

Once the correct value is selected or entered, click the 6.	 Apply button.

Setting the Parameter Values

The new “set” event appears under the Events heading of selected state.

(OPTIONAL for ONSET values) If the parameter is numerical and is to be onset 7.	
over time, complete the final field in the panel by entering a decimal value for 
minutes. (e.g. 0.5 is equivalent to 30 seconds.)

Selecting an Onset Value for the Parameter

Click 8.	 Apply.
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“Bolus” Events

A “bolus” event is used to administer a drug bolus within the scenario. For example, the 
event give bolus of epinephrine 1000 mcg in an active state automatically administers 
1000 mcg of epinephrine to the patient, irrespective of any user input or the patient’s 
physiology. The effects of the drug are not removed until the patient is stopped or until 
additional physiological changes have reversed their influence.

To add a “bolus” event:

Select the appropriate state.1.	

Choose 2.	 New “Bolus” Event from the New Event option of the Scenario menu.

Selecting a New “Bolus” Event

The phrase give bolus of ?? appears beneath the Events heading of the 
selected state.

Select3.	  give bolus of ??. The lower panel changes to display two fields beginning 
with the give bolus of field.

Selecting the Drug for the Bolus Event

Using the pull-down list, select the appropriate drug from the list and complete 4.	
the give bolus of field.
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Depending on the drug selected, the second field displays a measurement of 
either mg or mcg (milligrams or micrograms).

Highlight the 5.	 ? in the measurement field and enter the bolus dose (e.g. 1000 
mcg).

Entering and Applying the Bolus Dose

Click 6.	 Apply.

The new “bolus” event appears under the Events heading of selected state. 

“Call” Events

A “call” event includes the events and transitions of one state within another state. In 
other words, a call State B event added to State A makes the events and transitions 
of State B a part (or subroutine) of State A. In this way, the use of a “call” event allows 
states to be used multiple times without the necessity of redefining their events and 
transitions.

For example, in a scenario where the same three events are repeated in multiple states, 
a state named “Do Three Things” can be used to define those three events, so that this 
state can be subsequently called to be included in other states when appropriate. 

A “call” event only works within one scenario and only works to call states.

To add a “call” event:

Select the appropriate state.1.	
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Choose 2.	 New “Call” Event from the New Event option of the Scenario menu.

Selecting a New “Call” Event

The phrase call ? appears beneath the Events heading of the selected state.

Select3.	  call ?. The lower panel changes to display the call field.

Selecting a State to Call

Using the pull-down list, select the appropriate state from the list to complete the 4.	
call field.

Click 5.	 Apply.

The new “call” event appears under the Events heading of selected state.

A “Call” Event
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“Go To” Events

A “go to” event moves the scenario automatically from one state to another state. In 
other words, instead of navigating manually between states using the Next and Go to 
buttons on the Scenario Player, the instructor can design the scenario to move from 
state to state without additional involvement. However, the use of a “go to” event ad-
vances the scenario without any modifications, so interventions have no effect until this 
movement is complete.

A “go to” event only works within one scenario and only works to move to another 
state. Because a “go to” event moves the scenario to a different state, no other events 
listed after the “go to” event take effect.

To add a “go to” event:

Select the appropriate state.1.	

Choose 2.	 New “Go To” Event from the New Event option of the Scenario menu.

Selecting a New “Go To” Event

The phrase go to ? appears beneath the Events heading of the selected state.

Select 3.	 go to ?. The lower panel changes to display the go to field.

Choosing a State to go to from the Selected State 
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Using the pull-down list, select the appropriate state from the list to complete the 4.	
go to field.

Click 5.	 Apply.

The new “go to” event appears under the Events heading of selected state.

A “Go To” Event

“Infusion” Events

An “infusion” event is used to administer a drug infusion (or to stop a drug infusion) 
within the scenario. Once an infusion is administered, it continues to run until stopped 
either through an additional event in the scenario or user intervention. Infusions are set 
at an infused rate (mcg/min) or as a normalized infusion (mcg/kg/min). 

For example, the event infuse nitroglycerin at 5 mcg/min starts a 5 mcg/min infusion 
of nitroglycerin, irrespective of any user input or the patient’s physiology. 

The effects of the drug are not removed until the patient is stopped or until additional 
physiological changes have reversed their influence.

To add an “infusion” event:

Select the appropriate state. 1.	

Choose 2.	 New “Infusion” Event from the New Event option of the Scenario 
menu.

Selecting a New “Infusion” Event
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The phrase infuse ? at ? appears beneath the Events heading of the selected 
state.

Select 3.	 infuse ? at ?. The lower panel changes to display two fields for entering 
the drug name and the rate of dosage.

Choosing the Drug to be Infused

Using the pull-down list, select the appropriate drug from the list to complete the 4.	
infuse field.

Complete the infusion dosage by entering an amount in the dosage field and 5.	
selecting a rate of infusion (i.e. mcg/min or mcg/kg/min) from the measurement 
pull-down list.

Click 6.	 Apply.

An “Infusion” Event

The new “infusion” event appears under the Events heading of selected state.
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“Multiply” Events

A “multiply” event is used to apply a factor to a numerical parameter that increases or 
decreases the existing value of that parameter. Unlike a “set” event, which can multiply 
the default value of a numerical parameter, the “multiply” event factors against the 
patient’s current physiological values. 

For example, the event multiply Heart Rate Factor by 1.5 over 1 minute(s) changes 
the heart rate from its current value to a value 1.5 times greater over the course of 
a minute. On the other hand, the event multiply Heart Rate Factor by 0.5 over 1 
minute(s) reduces the current heart rate in half over that same time period. (In contrast, 
setting the Heart Rate Factor of 1.5 over 1 minute establishes a heart rate 1.5 times the 
patient’s default value and NOT the current value.)

As shown in the example above, the “multiply” event can have an “onset” time, thereby 
allowing for smoother hemodynamic or respiratory changes. Only when the onset of the 
value has completed can the instructor manually change the parameter’s values.

To add a “multiply” event:

Select the appropriate state. 7.	

Choose 8.	 New “Multiply” Event from the New Event option of the Scenario 
menu.

Choosing New “Multiply” Event

Selecting a New “Multiply” Event

The phrase multiply ? at ? appears beneath the Events heading of the selected 
state.
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Select 3.	 multiply ? to ?. The lower panel changes to display three fields beginning 
with the multiply field.

Choosing the Parameter to be Multiplied

Using the pull-down list, complete the 4.	 multiply field by selecting the parameter.

Choose only numerical parameters that may be factored. Discrete parameters 
(e.g. Breath Sounds, Pupil Dilation) are shown in the list, but selecting these 
parameters may produce unexpected results. 

Highlight the 5.	 ? in the value field to enter a factor to increase or decrease the 
parameter’s rate.

(OPTIONAL for ONSET values) If the parameter is to be onset over time, 6.	
complete the final field in the panel by entering a decimal value for minutes. (e.g. 
0.5 is equivalent to 30 seconds and 2.0 is two minutes.)

Choosing the Parameter to be Multiplied

Once the correct value is selected or entered, click the 7.	 Apply button.

The new “multiply”  event appears under the Events heading of selected state.
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Adding, Editing and Deleting Transitions

Transitions are conditional expressions (if X, then Y) that direct the scenario based 
on preestablished contingencies. The first part of the expression (the “if” phrase) 
establishes the contingency while the second part (the “then” phrase) defines the action 
to be taken. “If” phrases specify relationships (i.e. equals, greater than, less than, etc.) 
between values for time, drugs, conditions and physiological factors and the command 
set forth in the “then” phrase.

For example, the transition “if Time in State > 60 seconds then go to Patient_short_
of_breath” moves the scenario to the Patient_short_of_breath state after the specified 
amount of time, 60 seconds, has passed. Other transitions could offer alternative paths 
in the scenario by requiring an action to be set in motion by the patient’s physiological 
condition or the cumulative dosage of a drug administered to a patient. In some cases, 
these actions will not occur because they are triggered only when the condition is met.

To add transitions to a state:

Select the state in the Scenario panel.1.	

Choose the 2.	 New Transition option from the Scenario menu.

Selecting a New Transition

The phrase if ? = ? then go to ? appears beneath the Transitions heading of the 
selected state.

“Set” events should be avoided in transitions. As an example, to set the eyes to closed 
when SpO2 is less than 90 percent, create a transition called “If SpO2 < 90%, then go 
to state Eyes Closed.” The “Eyes Closed” state would then contain an event “set Eyes: 
Blink Control to Eyes Closed.”
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Select3.	  if ? = ? then go to ?. The lower panel changes to display five fields 
beginning with the if field.

Selecting the Transition

Using the pull-down list, select the desired condition from the 4.	 If field.

Selecting the Condition

When a condition is selected, the field below changes to display the 
measurement for the condition field’s value.

Selecting a Relationship for the Condition
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Select the relationship from the pull-down list in the field to the right of “5.	 is.”

There are six available relationships.

Condition Relationships
Symbol Meaning

= equal to

≠ not equal to

> greater than

≥ greater than or equal to

< less than

≤ less than or equal to

Enter or select a value for the value box that follows the relationship field.6.	

If a numerical parameter is chosen as the condition, the measurement that appears the 
value box corresponds to the chosen parameter. If a discrete parameter is selected, a 
pull-down list with the available parameter settings becomes active. 

As conditions in transitions, drug parameters are measured on a per kilogram (of the 
patient’s weight) basis. Transitions are triggered when the administered dose meets or 
exceeds the entered value (in mcg/kg or mg/kg) divided the patient’s weight (e.g., 70 kg 
for iStan).

Choosing an Action

The chart on the following page shows the units of measure for each of the available 
drug units.
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Drug Units Drug Units Drug Units
Adenosine mg/kg Esmolol mg/kg Nitroglycerin mcg/kg

Alfentanil mcg/kg Etomidate mg/kg Nitroprusside mcg/kg

Amiodarone mg/kg Fentanyl mcg/kg Norepinephrine mcg/kg

Atracurium mg/kg Flumazenil mg/kg Pancuronium mg/kg

Atropine mg/kg Glycopyrrolate mg/kg Phentolamine mg/kg

Bicarbonate mcg/kg Isoproterenol mg/kg Phenylephrine mcg/kg

Bretylium mg/kg Ketamine mg/kg Procainamide mg/kg

Calcium mg/kg Labetalol mg/kg Propranolol mg/kg

Cisatracurium mg/kg Lidocaine mg/kg Propofol mg/kg

Curare mg/kg Lorazepam mg/kg Quinidine mg/kg

Diazepam mg/kg Methohexital mg/kg Remifentanil mcg/kg

Digoxin mg/kg Metocurine mg/kg Rocuronium mg/kg

Diltiazem mg/kg Metoprolol mg/kg Succinylcholine mg/kg

Dobutamine mcg/kg Meperidine mg/kg Sufentanil mcg/kg

Dopamine mcg/kg Midazolam mg/kg Thiopental mg/kg

Doxacurium mg/kg Mivacurium mg/kg Vasopressin Units/kg

Droperidol mg/kg Morphine mg/kg Vecuronium mg/kg

Edrophonium mg/kg Naloxone mcg/kg Verpamil mg/kg

Ephedrine mg/kg Neostigmine mg/kg

Epinephrine mcg/kg Nifedipine / sl mg/kg

Complete the then field by selecting the action caused by fulfillment of the 7.	
specified condition.

The fields following the “then” field change to provide the appropriate definition for the 
chosen action. These fields correspond to the fields used to define events discussed 
earlier in this User Guide.

Action Reference Pages
call See Pages 3.46 and 3.47

give bolus of See Pages 3.45 and 3.46

go to See Pages 3.48 and 3.49

set See Pages 3.42 through 3.44

infuse See Pages 3.49 and 3.50
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Complete the action expression by entering or selecting information for each of 1.	
the fields.

Completing the Transition

Click 2.	 Apply.

The new transition appears under the Transitions heading of the selected state.

Defibrillation Transitions

When creating automated transitions using the Defibrillation variable, note that after 
defibrillation the system takes up to three seconds for the values to return from the 
sensed value (e.g. 360 Joules) to the original value of zero. To prevent unintended 
successive transitions, a state with a three-second delay may be required between 
successive states that transition on defibrillation. 

Sample Transitions for a Defibrillation Scenario 
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Editing Transitions

Once a transition has been created, it can be modified by selecting the transition in the 
Scenario panel and altering both the parameters and their values. Transitions are edited 
in the same manner in which they are created.

Deleting Transitions

To delete a transition, select the transition in the Scenario panel and press the delete 
key. Deletions are irreversible. Always be sure that the transition is not needed before 
performing the delete function.

Transitions can also be deleted by selecting them and then selecting the Clear option 
from the Edit menu. 

Changing the Location of Events and Transitions

Events and transitions can be moved within the scenario by using either a drag and 
drop method or the Cut and Paste commands. (For a review of dragging, See Dragging 
on page 7.4 of the Appendix).

Within a state, events occur simultaneously regardless of order except in the cases of 
“call” or “go to” events. When a “call” event occurs, the called state’s events take place 
prior to any subsequent events in the original state. Whenever a “go to” event occurs, 
the scenario shifts to the “go to” state and no further events are run from the original 
state.

Transitions occur only when their conditions are met.

Events and transitions can be moved to correct any problems with their original 
locations.   

To drag an event or a transition to a different location:

Click on the event or transition and hold the mouse button down.1.	

Drag the event or transition to the new location. (An indicator line appears as the 2.	
event or transition name is dragged past possible locations.)
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Dragging an Event to a New Location

Release the mouse button, dropping the event or transition into the desired 3.	
location.

To cut and paste an event or transition into a different location:

Select the event or transition.1.	

Choose the 2.	 Cut option from the Edit menu [or use the Command (  ) + X 
shortcut keys]. The event or transition disappears from its original location. 

Select the new state where the event or transition will be located.3.	

 Choose the 4.	 Paste option from the Edit menu [or use the Command (  ) + V 
shortcut keys].
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Copying Events and Transitions

Events and transitions can be copied and pasted within any state of the scenario by 
using the Copy and Paste commands.

To copy and paste an event or transition into another state in the scenario:

Select the event or transition. (Only one event or transition can be selected at a 1.	
time.)

Choose the 2.	 Copy option from the Edit menu [or use the Command (  ) + C 
shortcut keys]. The event or transition is copied onto the unseen clipboard. 

Select the new state where the event or transition will be located.3.	

Choose the 4.	 Paste option from the Edit menu [or use the Command (  ) + V 
shortcut keys]. If needed, the newly copied event or scenario can now be edited.

Using the same method, an event or transition can also be copied and pasted into a 
different scenario.

To copy and paste an event or transition into another scenario:

Select the event or transition. (Only one event or transition can be selected at a 1.	
time.)

Choose the 2.	 Copy option from the Edit menu [or use the Command (  ) + C 
shortcut keys]. The event or transition is copied onto the unseen clipboard. 

Open the second scenario using the 3.	 Open or Open Recent options from the 
Scenario menu.

Select the state in the second scenario where the event or transition will be 4.	
located.

Choose the 5.	 Paste option from the Edit menu [or use the Command (  ) + V 
shortcut keys]. If needed, the newly copied event or scenario can now be edited.
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Saving Scenarios

To use the scenario with any patient the scenario file must be named and saved. 

Modified preconfigured files must be renamed before they can be saved. Renamed 
preconfigured scenarios and user-created scenarios can be overwritten, so multiple 
saves can be performed on those scenarios as changes are made. Saving a scenario 
file removes the previous version of that scenario. 

Initially, new scenarios appear in sequence as Untitled files (e.g. Untitled1 or 
Untitled2).

To save a scenario:

Select the 1.	 Save [or use the Shift + Command (  ) + V shortcut keys] or the 
Save as option from the Scenario menu. When saving a preconfigured file, only 
the Save as option functions because the file must be renamed.

Selecting Save As

Named scenario files are saved automatically with the Save option.

New, unnamed scenario files that are saved or any files saved using the Save as 
option activate the Save file as navigational window. 

Navigate to the /Users/Shared folder, where the scenario files are to be stored. As 2.	
a shortcut, click the Home icon to go to the Users directory for quick access to 
the Shared folder.
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Enter the name for the scenario in the 3.	 Selection field. 

The full file path for a scenario or patient is limited to a maximum of 104 characters. 

For example:  
/Users/Shared/subdirectory1/subdirectory2/reallygoshdanglongpatientorscenariofilename 

If a longer file path name is created, the scenario cannot be saved.

Navigating to the Scenario File’s Folder

Click 4.	 Save.

The scenario file is now available to all users with access to the folder where the file was 
saved.
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Using the Event Recorder

The Event Recorder records parameter changes made to the active patient. These 
recorded changes can subsequently be added to a scenario as events. By observing 
the physiological changes to the patient, modifications to the parameter values can be 
made using the Event Recorder prior to adding those events to the scenario.

	 Open the Event Recorder by clicking the Recorder icon on the Patient toolbar.

The Recorder Icon

The Event Recorder opens as a separate window, displaying a list of the names of 
all the patient files opened during the session. Patient files that have been closed are 
included in this list.

By default, the status field shows that the Event Recorder is Stopped.

Select the active patient whose events are to be recorded.1.	

Starting to Record

Click the 2.	 Record icon.

The status field shows that the Event Recorder is Recording.

A red blinking circle appears in the Stop icon while events are recorded.
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Set the new parameters, observing the physiological changes in the patient.4.	

Parameters are set using the Condition, Drugs, Fluids, Cardiovascular and Respiratory 
tabs, discussed later in this section.

Recording Events

Reset the parameters until the desired physiology is achieved. 

As an example, the Event Recorder shown below displays the Shunt Fraction and 
Tidal Volume Factor parameters found in the Respiratory Control section beneath 
the Respiratory tab and the Eyes: Blink Speed parameter found in the Assessment 
section of the Condition tab. 

The Tidal Volume Factor parameter has been reset in this example (from 0.75 to 0.1).

Managing Events in the Event Recorder

Events and closed patient files can be deleted from the Event Recorder. 

To remove an event, select the event and either press the delete key or click the Clear 
icon. To clear all the events from an active patient, select the patient file and either 
press the delete key or click the Clear Events icon. To remove a closed patient file (and 
all its events), select the patient file and either press the delete key or click the Remove 
icon.

To stop recording events, click the Stop icon.

Events recorded in the Event Recorder cannot be saved unless moved to a scenario. 
(See Copying Recorded Events to a Scenario.) 

To close the Event Recorder, click the red button in upper left-hand corner of the 
window or, with the Event Recorder active, choose the Close Window option from the 
Window menu.
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Copying Recorded Events to a Scenario

Recorded events can be copied from the Event Recorder to a scenario in the Scenario 
Editor by using either a drag and drop method or the Copy and Paste commands. (For 
a review of dragging, See Dragging on page 7.4 of the Appendix).

To copy a recorded event to a scenario using drag and drop:

Select the event to be copied in the1.	  Event Recorder, holding down the mouse 
button.

Drag the event to its new location in the scenario. A blue line appears to indicate 2.	
where the event is being placed.

Dragging a Recorded Event to a Scenario

Release the mouse button. The event is now in the scenario.3.	

To copy a recorded event to a scenario using the Copy and Paste commands:

Select the event to be moved in the Event Recorder.1.	

Choose the 2.	 Copy option from the HPS Edit menu [or use the Command (  ) + 
C shortcut keys]. The event is copied onto the unseen clipboard. 

Select the state in the scenario where the event will be located.3.	

Choose the 4.	 Paste option from the HPS Edit menu [or use the Command (  ) + 
V shortcut keys]. If needed, the newly copied event can now be edited.
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The Condition Tab

Selecting the Condition tab opens a window that provides a means of changing parameter 
settings that control patient conditions related to assessment, ICP, sounds and trauma. By 
default, Assessment is selected in the Show pull-down menu located above a panel with 
a list of Parameters and a panel with settings for those parameters. At the bottom of the 
window is a Description of the selected parameter.

The Condition Tab

Each parameter has settings designed to accurately affect the patient’s physiology. 

Assessment ICP Sounds Trauma

Capillary Refill: Big Toe Autoregulation Gain Factor Bowel Autoinjection Enable

Capillary Refill: Thumb Catheter: Intercranial Pressure Breath Bleeding: Ch1 - Location

Convulsions Cerebral Autoregulation Status Heart Bleeding: Ch1 - Type of Hemorrhage

Cyanosis: Fingertips CO2 Reactivity Factor Throat Bleeding: Ch2 - Location

Cyanosis: Toes Craniectomy Voice Bleeding: Ch2 - Type of Hemorrhage

Diaphoresis: Forehead CSF Injection/Removal Bleeding: Flush

Eyes: Blink Control CSF Outflow Resistance Factor Chest Compression Efficacy

Eyes: Blink Speed Head Elevation Chest Tube Air Flow Rate

Eyes: Pupil Diameter ICP Override Chest Tube Air Leak Type

Eyes: Tearing Intercranial Elastance Factor Chest Tube Enable

Fixed Neuromuscular Blockade Intercranial Venus Resistance Factor Chest Tube Flow Rate

ICP Override Position of CO2 Regulation Curve Flail Chest

Jugular Vein Distension (JVD) Time Constant of CO2 Reactivity Intrapleural Volume

Microphone Volume Needle Decompression

Perfusion Intensity Pericardial Fluid (Acute)

Secretion: Ears Secretion: Ears

Secretion: Mouth Secretion: Nose

Secretion: Nose Secretion: Mouth

Temperature: Blood Trismus

Temperature: Body

Trismus

Weight
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The Drugs Tab

Selecting the Drugs tab opens a window that provides a means of administering 
medications from the Instructor Workstation. Based on normal clinical practices, 
medications may be given as a bolus, an infusion or as an infusion based on the 
patient’s weight in kilograms (normalized infusion). 

By default, All drugs is selected in the pull-down menu located above the window 
showing the available drugs. In the All drugs view, each drug is listed in alphabetical 
order, regardless of classification.

The Drugs Tab

The pull-down menu offers the option of selecting a specific drug category.

Drug Category

All Drugs

Narcotics

Hypnotics

Neuromuscular Blockers

Antagonists

Cardiovascular

ACLS

Once a drug is selected in the window, the bottom panel displays the settings for 
administering the selected drug. When the Pharmacology Editor is used to create 
a new drug and that drug is used to modify the system or the patient, a separate 
category, User Generated, appears at the bottom of the menu. For information on the 
Pharmacology Editor see Appendix C - Drug Integration at the end of this User Guide.
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The Fluids Tab

Selecting the Fluids tab opens a window that provides a means of controlling the 
amount of fluid lost by or infused into the patient. The upper panel provides scrollable 
access to the various fluid parameters and the bottom panels display the controls for 
entering the amount of fluid to be lost or infused and establishing the time frame during 
which the fluid loss or infusion will take place.

The Fluids Tab

Currently, there are seven fluids that can be controlled using the Fluids tab.

Fluids

Fluid Loss Volume (Blood)

Fluid Loss Volume (Plasma)

Infusion (Colloids)

Infusion (Crystalloids)

Infusion (Packed Red Blood Cells)

Infusion (Whole Blood)

Urinary Output

See also page 4.45 for Fluid Parameters Affecting Circulation and page 4.54 for Urinary 
Output.
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The Cardiovascular Tab

Selecting the Cardiovascular tab opens a window providing a means of changing 
parameter settings that control patient conditions related to the circulatory system. 
Catheters is selected in the Show menu located above the Parameters panel and 
the panel with the settings for those parameters. At the bottom of the window is a 
Description of the selected parameter.

The Cardiovascular Tab

The Show menu contains five sub-sections, each with its own set of parameters.

Catheters External 
Cardiac 
Stimulation

Heart Pulses Systemic

Cardiac Output 
Measurement

Defibrillation Baroceptor Gain (Cardiac) 
Factor

Carotid Baroceptor Gain (Overall) Factor

Catheter: Arterial Pacing Capture 
Threshold

Cardiac Rhythm Override Brachial Baroceptor Gain (Peripheral) Factor

Catheter: Central 
Venous

Pacing 
Current

Contractility Factor: Left 
Ventricle

Radial Baroceptor Maximum Pressure

Catheter: 
Intracranial Pressure

Pacing Rate Contractility Factor: Right 
Ventricle

Femoral Baroceptor Minimum Pressure

Catheter: 
Pulmonary Artery

Fixed Heart Rate Popliteal Elastance: Extrathoracic Arteries

PA Catheter Balloon 
Inflation (wedge)

Heart Rate Factor Posterior 
Tibial

Elastance: Intrathoracic Arteries

Ischemic Index Averaging Dorsalis 
Pedis

Elastance: Pulmonary Arteries

Ischemic Index Sensitivity Resistance Factor: Pulmonary Vasculature

Pericardial Fluid (Acute) Resistance Factor: Systemic Vasculature

Resistance Factor: Aortic Valve Resistance Factor: Venous Return

Resistance Factor: Mitral Valve Venous Capacity Factor

Resistance Factor: Pulmonic Valve
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The Respiratory Tab

Selecting the Respiratory tab opens a window providing a means of changing 
parameter settings that control patient conditions related to the pulmonary system. 
Airway is selected by default in the Show menu, which also contains options for 
Lung and Respiratory Control. These two options also display a Parameters panel 
and a panel with the settings for those parameters. At the bottom of the Lung and 
Respiratory Control windows is a Description of the selected parameter.

The Respiratory Tab

The Show menu contains three sub-sections, each with its own set of parameters.

Airway Lung Respiratory Control
Airway Occluder Chest Wall Capacity CO2 Production Factor

Laryngospasm Chest Wall Compliance Factor CO2 Set-point

Swollen Tongue Distended Chest Wall Compliance Factor Fixed Neuromuscular Blockade

Bronchial Occlusion Fixed Alveolar Enflurane I to E Ratio (1:x)

PEEP Fixed Alveolar Halothane O2 Consumption

Trismus Fixed Alveolar Isoflurane PetCO2-PaCO2 Factor

Fixed Alveolar Sevoflurane Respiratory Gain Factor

Flail Chest Respiratory Quotient

Fraction of Inspired O2 Override Respiratory Rate Factor

Functional Residual Capacity Respiratory Rate Override

Intrapleural Volume Shunt Fraction

Lung Compliance Factor Tidal Volume Factor

pH Shift Tidal Volume Override

Venous CO2 Shift Volume/Rate Control Factor
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Using iStan
Once iStan has been set up (see Section 2: iStan Setup), the software has been loaded 
and a patient started and connected (see Section 3: iStan Software Features), the 
simulator is ready for learner interventions.

The Patient Window

Changes to the patient’s physiology can be manifested in the simulator and on 
the Waveform Display using the software accessed on the Patient window. To run 
a scenario, select the Scenario tab to access the Player menu (see page 3.27). 
Physiological changes can also be made directly using the Condition, Drugs, Fluids, 
Cardiovascular and Respiratory tabs.

Certain features, such as the pupil size of the eyes, require physical adjustments. In 
addition, further realism can be created by using moulage techniques with the simulator.  

Connect the software 
to the simulator

Use the parameters 
on the tabs to control the 

patient’s physiology
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Patient Profiles
An unlimited number of unique patient profiles are possible for iStan, which comes 
with five patient profiles already configured that can provide a baseline for modified or 
customized patients:

iStan - a healthy 33-year-old male 

iStannette - a healthy, pregnant 29-year-old female

iGranny - an elderly former smoker 

iSoldier - a slightly larger male than iStan with a higher metabolic rate 

iTruck Driver - a 61-year-old male with a history of tobacco and alcohol use
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iStan

iStan

Name, Age and 
Gender

iStan D. Ardman (“iStandard Man”, “iStan”), 33-year old, male

History of 
Present Illness

Otherwise healthy adult with compound ankle fracture requiring open reduction and 
internal fixation (ORIF).

Past Medical 
History

None; No known drug allergies. Denies tobacco, alcohol, and IV drug use. Runs 2 miles 
several times a week.

Past Surgical/
Anesthetic 
History

Tonsillectomy at age 6, general anesthesia without complications. No family history of 
anesthetic problems.

Review of 
Systems

CNS: Negative for stroke
Cardiovascular: Negative for hypertension, angina, dyspnea on exertion
Pulmonary: Negative for Chronic Obstructive Pulmonary Disease, asthma, recent 
upper respiratory infection
Renal/Hepatic: Negative for renal failure, jaundice
Endocrine: Negative for diabetes, thyroid disease
Hematological/Coagulopathy: Negative for anemia, bruising

Current 
Medications

None

Physical 
Examination

General: Healthy adult male, average build, in no distress
Weight, Height: 70 kg, 6 feet 0 inches (72 inches)
Vital Signs: HR 70 beats per minute, BP 116/51 mmHg, RR 11 breaths/minute, SpO2 
98%
Airway
Full dentition, no loose teeth, full range of motion of neck and
temporomandibular joints, wide oral opening, 4 finger breath mandible, Mallampati 
Classification 1
Lungs: Relaxed respiration, with clear bilateral breath sounds
Heart: Regular rate and rhythm. Normal S1, S2; no S3, S4, murmur, or rub

Laboratory, 
Radiology and 
Other Relevant 
Studies

Hemoglobin 14.4 g/100 ml and Hematocrit 42.3%

Narrative A healthy adult male who runs two miles several times a week suffers a compound 
ankle fracture and requires ORIF. Patient has no systemic illness or other health 
problems.  He received general anesthesia uneventfully as a child and there is no 
family history of anesthesia problems.  Physical examination reveals no anesthetic 
concerns. Patient refuses regional anesthesia and requests general anesthesia.
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iStannette

iStannette

Name, Age and 
Gender

iStannette, 29-year old, female

History of 
Present Illness

40-week intra-uterine pregnancy, uncomplicated prenatal course.

Past Medical 
History

None; No known drug allergies. Denies tobacco, alcohol, and IV drug use.

Past Surgical/
Anesthetic 
History

None. No family history of anesthetic problems.

Review of 
Systems

CNS: Negative for stroke, seizure syncope
Cardiovascular: Negative for hypertension, angina, dyspnea on exertion
Pulmonary: Negative for Chronic Obstructive Pulmonary Disease, asthma, recent 
upper respiratory infection
Renal/Hepatic: Negative for renal failure, jaundice
Endocrine: Negative for diabetes, thyroid disease
Hematological/Coagulopathy: Negative for anemia, bruising

Current 
Medications

None

Physical 
Examination

General: Term parturient
Weight, Height: 90 kg (pre-pregnancy weight was 70 kg), 5 feet 8 inches (68 inches)
Vital Signs: HR 90 bpm, BP 106/68 mmHg, RR 16 breaths/minute, SpO2 98%
Neurologic: Intact; reflexes are hyperactive
Airway: No loose teeth. Full range of motion of neck, 3 finger breath (fb) oral opening, 3 
fb mandible, Mallampati Classification 3
Lungs: Breath sounds clear and equal bilaterally
Heart: Regular rate and rhythm without murmur, rub or gallop
Abdomen: Term pregnancy with 40 cm fundal height, Fetal Heart Rate 150’s
Extremities: 1+ pretibial edema; pulses 2+ bilaterally

Laboratory, 
Radiology and 
Other Relevant 
Studies

CBC: Hemoglobin 11.6 g/100 ml; Hematocrit 34%
Electrolytes: All within normal limits
Chest X-ray: Clear
ECG: Normal sinus rhythm at 90 beats per minute, normal complexes

Narrative None.
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iGranny

iGranny

Name, Age and 
Gender

iGranny, 73-year-old, female

History of 
Present Illness

Otherwise healthy, geriatric adult.

Past Medical 
History

No known drug allergies. Essential hypertension for the past 26 years. 1 Pack-a-day 
smoker for the past 40 years (quit smoking 10 years ago.) Walks 2 miles a day.

Review of 
Systems

CNS: Negative for stroke
Cardiovascular: Positive for hypertension, angina, dyspnea on exertion
Pulmonary: Positive for Chronic Obstructive Pulmonary Disease, Emphysema
Renal/Hepatic: Negative for renal failure, jaundice
Endocrine: Negative for diabetes, thyroid disease
Hematological/Coagulopathy: Negative for anemia, bruising

Current 
Medications

Hydrochlorthiazide 10mg every day by mouth and Aspirin 81mg every day by mouth

Physical 
Examination

General: Healthy geriatric female, average build, no distress
Weight/Height: 55kg, 5 feet 2 inches (62 inches)
Vital Signs: HR 84 beats per minute, B/P 154/87, RR 17 breaths/minute, SpO2 96%
Airway: Full dentition with upper dentures, full range of 	 motion of neck and 
temporomandibular joints, wide oral opening, 3 finger breath mandible, Mallampati 
Classification 1
Lungs: Relaxed respiration, with clear bilateral breath sounds
Heart: Normal S1,S2; negative S3, S4, murmur or rub, History of Right Bundle Branch 
Block

Laboratory, 
Radiology and 
Other Relevant 
Studies

Hemoglobin 14.4 g/100 ml and Hematocrit 42.3%

Narrative A healthy geriatric female who walks in the shopping mall two miles a day. Patient has 
no systemic illness other than hypertension since the age of 47-years-old. She has 
delivered 3 live cesarean births without complications. She has received anesthesia 
without complications. Both parents deceased of natural causes. No family history of 
cardiac disease. Patient is being seen for general yearly check-up.



4.6

Using iStan

iSoldier

iSoldier

Name, Age and 
Gender

iSoldier, 20-year old, male

History of Present 
Illness

Otherwise healthy adult

Past Medical 
History

None; No known drug allergies. Denies tobacco, alcohol, and IV drug use. Runs 4 miles 
several times a week.

Past Surgical/
Anesthetic 
History

None. No family history of anesthetic problems.

Review of 
Systems

CNS: Negative for stroke
Cardiovascular: Negative for hypertension, angina, dyspnea on exertion
Pulmonary: Negative for Chronic Obstructive Pulmonary Disease, asthma, recent 
upper respiratory infection
Renal/Hepatic: Negative for renal failure, jaundice
Endocrine: Negative for diabetes, thyroid disease
Hematological/Coagulopathy: Negative for anemia, bruising

Current 
Medications

None

Physical 
Examination

General: Healthy adult male, average build, in no distress
Weight, Height: 85 kg, 6 feet 0 inches (72 inches)
Vital Signs: HR 78 beats per minute, BP 108/51 mmHg, RR 14 breaths/minute, SpO2 
97%
Airway: Full dentition, no loose teeth, full range of motion of neck and 
temporomandibular joints, wide oral opening, 4 finger breath mandible, Mallampati 
Classification 1
Lungs: Relaxed respiration, with clear bilateral breath sounds
Heart: Regular rate and rhythm. Normal S1, S2; no S3, S4, murmur, or rub

Laboratory, 
Radiology and 
Other Relevant 
Studies

Hemoglobin 14.4 g/100 ml and Hematocrit 42.3%

Narrative The soldier is typically free from chronic disease requiring ongoing medical care and 
slightly larger than the 70 kg iStan used in civilian scenarios. Because he is involved 
in intense physical activity, the soldier’s basal metabolic rate is higher than a civilian 
counterpart. Forced to work in extreme thermal conditions, core temperature may be 
altered. Hot climates are particularly troublesome: ambient heat, the increased metabolic 
rate from physical activity, and an inability to dissipate heat through multiple layers of 
clothing (to include flak jackets) combine to produce an individual who is hyperthermic, 
hypermetabolic, and dehydrated. Sweat losses as high as 3000 ml/hr have been reported 
in athletes undergoing intense physical activity. Hypovolemia from dehydration is 
compounded by the significant blood losses associated with combat injuries.
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iTruck Driver

iTruck 
Driver

Name, Age and 
Gender

iTruck Driver, 61-year old, male

History of 
Present Illness

Referred for surgical repair of infra-renal abdominal aortic aneurysm.

Past Medical 
History

Allergic to Penicillin which causes hives and wheezing. Essential hypertension for 20 years. 
Currently taking enalpril (Vasotec) and furosemide (Lasix). Coronary artery disease with anterior 
wall myocardial infarction five years ago. Stable angina since, left substernal chest pain radiating 
down left arm, with 1-2 episodes per month. Never at rest, most often with anxiety (e.g., fighting 
with wife) and always relieved with sublingual nitroglycerin. Sees cardiologist regularly, who 
states that the patient is optimally medically managed. Recent thallium scan shows reversible 
perfusion defect in lateral wall. Cardiac echo reveals normal valve function, increased left atrial 
and left ventricular size, hypokinetic anteroseptal wall, estimated Ejection Fraction=37%. Cardiac 
catheterization: PA=49/28 mmHg, PAOP (wedge) = 18 mmHg, CO=4.5 l/minute,  diffuse coronary 
artery disease but no surgically correctable lesions.
Long history of cigarette smoking (2 and a half packs of cigarettes per day for 41 years and Chronic 
Obstructive Pulmonary Disease. Chronic cough, white sputum, 1-2 teaspoons every day. Denies 
wheezing.  No shortness of breath at rest but dyspnea on exertion at 2-3 blocks walking. Admits to 
regular alcohol use in the form of 2-4 beers each night. Denies DTs. Denies IV drug use.

Past Surgical/
Anesthetic 
History

Transurethral resection of the prostate (TURP) 10 years ago under spinal anesthesia with 
no complications. Leg (tibial) fracture 20 years ago under general anesthesia with no 
complications. No family history of anesthetic problems.

Review of 
Systems

CNS: Negative for stroke, seizure, syncope
Cardiovascular: As above
Pulmonary: As above. Denies asthma or recent upper respiratory infection
Renal/Hepatic: Negative for renal failure, jaundice
Endocrine: Negative for diabetes, thyroid disease
Hematological/Coagulopathy: Negative for anemia, bruising

Current 
Medications

enalapril (Vasotec); furosemide (Lasix); nitroglycerin SL

Physical 
Examination

General: Healthy adult male in no distress
Weight, Height: 100 kg, 6 feet 0 inches (72 inches)
Vital Signs: HR 74 beats per minute, BP 180/97 mmHg, RR 13 breaths/minute, SpO2 95%
Airway: Upper and lower dentures, full range of motion neck , 3 finger breath (fb) oral 
opening, 3 fb mandible, Mallampati Classification 2
Lungs: Distant but clear bilateral breath sounds
Heart: Regular rate and rhythm. Normal S1, S2; no S3, S4, murmur, or rub

Laboratory, 
Radiology and 
Other Relevant 
Studies

CBC: Hemoglobin 16.0 g/100 ml; Hematocrit 47%
Electrolytes: All within normal limits
Chest X-ray: No infiltrates
ECG: Normal sinus rhythm, no ischemic changes

Narrative None.



4.8

Using iStan

Developing a New Patient
Patients are created either by modifying an existing patient or by clicking the New icon 
on the Patient Palette and selecting the Untitled Adult Patient option (see Creating a 
New Patient on page 3.4).

When a new patient is created, the Patient Window appears without information 
regarding the new patient’s name, history or photograph. However, the initial underlying 
physiology of the new patient is that of iStan, the healthy, preconfigured patient.

An Untitled iStan Patient

To complete the patient, new information needs to be added and the physiology 
changed (if desired).

Drag a picture file to 
the Image box and drop 

in the new photo

Edit the history by clicking to place 
the cursor and using standard editing 
tools to add, delete and format text
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Adding a Photograph

If desired, load a picture file (e.g. TIFF, JPEG, GIF) onto the laptop, select the file from 
the desktop, drag the file to the Image box to the left of the patient’s name, and re-
lease the file. The new picture appears in the Image box, replacing the text, “No Image        
Available.”

The recommended dimensions for the patient picture are 120x110 pixels. Larger pic-
tures take longer to save and extend the time needed to open a patient file.

Completing the Patient History

To create the patient’s history, click the mouse in the appropriate spot on the history 
field and enter the desired text. The standard Cut, Copy, Paste and Clear functions 
are available via the Edit menu when text is highlighted. Text formatting (i.e. Bold, 
Underline, Italics) is available via the Format menu. 

To remove the entire history, click anywhere in the text and choose the Select All option 
from the Edit menu before pressing the delete key. New text can be entered on the 
blank page.

Any changes to the history must be saved to have them for future reference. 
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Changing the Patient’s Physiology

A patient’s physiology is changed by adjusting the parameters available beneath the 
various tabs located on the Patient window. 

To create new physiology for the patient:

Select the appropriate tab (e.g. 1.	 Cardiovascular tab, Respiratory tab, etc.).

Select, when available, the appropriate tab sub-category (from the 2.	 Show pull-
down menu).

Choose the desired parameter (e.g. 3.	 Heart Rate Factor, Breath Sounds, etc.).

Change the values of the selected parameter.4.	

Allow the patient’s vital signs to stabilize. Cardiovascular changes usually 5.	
equilibrate rapidly whereas respiratory changes may take several minutes to 
stabilize.

Save (when desired) the new patient.6.	

New patients are saved using the Save icon on the Patient Window or the Save option 
located on the File menu. For more information on saving patient files, see Saving 
Patient Files on page 3.22. 
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Altering an Existing Patient
Any existing patient, either iStan, one of the other preconfigured patients or a previously 
saved user-defined patient, can be changed to display a different name, background or 
physiology.

The original file for a preconfigured patient cannot be overwritten, so a new file name 
must be created for edited versions of the preconfigured patients. Unless permanently 
modifying a user-defined patient file, any changes to a user-defined patient should be 
saved using the Save As option under the File menu. All changes must be saved to 
preserve the patient file for future use.

Editing the Patient History

To edit the patient’s history, highlight and type over the existing text. The standard 
Cut, Copy, Paste and Clear functions are available via the Edit menu when text is 
highlighted. Text formatting (i.e. Bold, Underline, Italics) is available via the Format 
menu. To remove the entire history, click anywhere in the text and choose the Select All 
option from the Edit menu before pressing the delete key. New text can be entered on 
the blank page.

Any changes to the history must be saved to have them for future reference.

Changing the Patient’s Physiology

A patient’s physiology is changed by adjusting the parameters available beneath the 
various tabs located on the Patient Window. 

To edit an existing patient:

Select the appropriate tab (e.g. 1.	 Cardiovascular tab, Respiratory tab, etc.).

Select, when available, the appropriate tab sub-category (from the 2.	 Show pull-
down menu).

Choose the desired parameter (e.g. 3.	 Heart Rate Factor, Breath Sounds, etc.).

Change the values of the selected parameter.4.	

Allow the patient’s vital signs to stabilize. Cardiovascular changes usually 5.	
equilibrate rapidly whereas respiratory changes may take several minutes to 
stabilize.

Save (when desired) the new patient. 6.	

Edited patients may be saved using the Save icon on the Patient Window or the Save 
As option located on the File menu. For more information on saving patient files, see 
Saving Patient Files on page 3.22. 
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Auditory and Ocular Physiological Signs
The iStan simulator has tri-state eyes and can be programmed to speak certain 
phrases, to provide pain ratings and to make a range of vocal sounds. iStan, with 
instructor support, can also answer learner questions via a speaker system and 
microphone. 

Programmable Speech

The Voice parameter is located on the Condition tab as one of the options located 
under the Sounds menu.

Programming Speech

Speech Sounds include a male or female voice that can utter a pain rating indicator 
from 0 to 10 or a series of possible other sounds. 

To play one of the Speech Sounds:

Choose the desired gender, Male or Female.1.	

Use the slider bar to set the volume.2.	

Select the desired sound from the scrollable 3.	 Speech Sounds list. The selected 
sound appears in the Speech Sounds field above the list.

Click the 4.	 Play button located to the right of the Speech Sounds field.

When programming Speech Sounds, a trigger for the sounds must be set prior to 
the chosen sound parameter. The trigger is set using a “Set” Event and choosing the 
Sounds: Voice: Speech Trigger option.

Select the Voice option 
from the Sounds menu located 

under the Condition tab

Choose the gender 
and set the volume

Use the scroll bars to locate 
and select either Speech 
Sounds or Vocal Sounds

Click the Play button to 
play the selected Speech
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Setting a Speech Trigger

After setting an event to trigger the speech to play, set a subsequent event for the vocal 
response. Note in the example above that three states have been created to allow for 
varying degrees of pain response.

Unlike Speech Sounds, Vocal Sounds play continuously and are emitted immediately 
when selected from the scrollable Vocal Sounds list. To stop playing one of the Vocal 
Sounds select None from the list. The active sound appears in the Vocal Sounds field 
above the list. The following Speech and Vocal Sounds are currently available:

Speech Sounds Vocal Sounds
“0” through “10” - Pain Ratings None

“Aching” Crying

Countdown Gagging

“Dull” Gasping

Grunt Groaning

“I can’t breathe” Long loud cough

Loud cough Long soft cough

“My belly hurts” Mumbling

“My chest is tight” Wheezing

“My leg hurts”

“No”

“Ouch”

“Ow, that hurts”

“Pressure”

Scream

“Sharp”

Short loud cough

Short soft cough

Soft cough

“Sometimes”

“Stabbing”

“Yes”
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Wireless Voice Capability

In addition to the pre-programmed speech, any response can be transmitted through 
the speakers using the wireless microphone. 

The microphone volume can be adjusted on the microphone and through the software 
using the Microphone Volume option located under the Assessment menu on the 
Condition tab.

Adjusting Microphone Volume

The patient must be connected to iStan for any volume adjustment to be effective.

Use the slider bar to 
set the volume
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Reactive Eyes

Each eye has reactive pupils and functional eyelids that blink.

The settings for Pupil Diameter are located on the Condition tab and accessed by se-
lecting the Eyes: Pupil Diameter option from the Assessment menu. 

Currently, there are three pupil options that are used to control the diameter of the 
pupils in both eyes: Automatic (default), Model Driven or a Fixed Pupil Size (8 to 2 
mm).  

Setting the Pupil Diameter to Automatic causes the pupils to re-size in response to 
changes in light. If both pupils are set to Automatic, both pupils re-size accordingly. 
Other settings allow the user to fix one or both pupils to a specific size.

If the Pupil Diameter is set to Model Driven, the pupil size is driven by the 
pharmacology of morphine. Pupil reactivity to light is not possible with this option. The 
pupillary response to other drugs can be scripted using the Scenario Editor.

Additionally, eyelids can be programmed to open and close spontaneously or can be 
fixed in the closed position. The settings for Blink Control are located on the Condition 
tab and accessed by selecting the Eyes: Blink Control option from the Assessment 
menu.

Setting Blink Control

Choosing the Automatic setting (which is also the default setting) sets the eyes in a 
blinking mode but allows the simulator to react to physiological changes that cause the 
eyes to close such as unresponsiveness or a comatose condition.

Though set in the Eyes Closed position, the eyelids can still be manually opened for 
clinical inspection.

After accessing the Eyes: Blink 
Control option under the Assessment 
menu of the Condition tab, select the 

desired Blink Control setting
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Blinking frequency can be set at one of three speeds: Normal (the default), Slow and 
Fast. To adjust the blinking frequency, select the Eyes: Blink Speed option from the 
Assessment menu on the Condition tab and select the desired speed.

Adjusting Blink Speed
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Basic Assessment Features
iStan has a variety of assessment parameters, some of which can be set to provide 
learners with the ability to evaluate certain physiological conditions.

Bowel Sounds

Learners can auscultate bowel sounds over each of four gastrointestinal quadrants, 
the Upper Right, Upper Left, Lower Right and Lower Left. The sounds can be 
independently set in each anatomical region to Normal, Hyperactive, Hypoactive or 
None (bowel sounds are absent). 

Setting Bowel Sounds

Choose the sound and the volume for each quadrant or for all four quadrants using the 
pull-down menu and slider bar beneath that quadrant’s description.

The patient must be connected to iStan for any volume adjustment to be effective.

The Bowel Sounds parameter is located on the Condition tab beneath the Sounds 
menu.
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Convulsions

iStan simulates convulsions when the Convulsions parameter is Enabled.

Convulsions

The Convulsions parameter is located on the Condition tab beneath the Assessment menu.

Diaphoresis

Diaphoresis of the forehead is simulated when the Diaphoresis: Forehead option is Enabled.

Diaphoresis

Clear fluids must be present to operate the Diaphoresis feature. See page 2.13 for in-
structions on preparing iStan’s Secretion system.
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Airway
iStan’s anatomically realistic upper airway provides for the opportunity to intubate (as 
well as apply other airway interventions) the patient, while various clinical signs (i.e. 
breath sounds, chest excursion, airway patency) can be physically demonstrated. 
A series of speakers inside the simulator can generate a range of breath and throat 
sounds used in diagnosing conditions.

Airway Features
Anatomy, Physiology 
and Clinical Signs

Clinical Interventions, Patient 
Monitoring and Scenarios.

Software Control Manual Control

Realistic Upper 
Airway (Oropharynx, 
Nasopharynx and 
Larynx)

Allows direct laryngoscopy, oral 
and nasal intubation and use of 
specialty airway devices. Senses if 
ET tube is correctly inserted.

None required. None required.

Trachea, Left and 
Right Mainstem 
Bronchi

Tracheal intubation results in 
bilateral chest excursion and 
breath sounds. Endobronchial 
intubation results in unilateral chest 
excursion and breath sounds.

None required. None required.

Esophagus, Lower 
Esophageal Sphincter 
and Stomach

Esophageal intubation results in 
gastric distension and the absence 
of breath sounds, chest excursion 
and CO2 output.

None required. None required.

Posterior Pharynx 
Swelling

Obstructs view of larynx to prevent 
intubation, but allows mask 
ventilation “can’t intubate, can 
0ventilate” scenario.

TAB: Respiratory
SHOW: Airway

None required.

Tongue Swelling 
(Moderate and 
Severe)

Hinders, but does not prevent 
intubation.

TAB: Respiratory
SHOW: Airway
OPTION: Swollen 
Tongue

None required.

Laryngospasm Closes vocal cords and prevents 
intubation and ventilation. When 
used with posterior pharynx 
swelling, creates a “can’t intubate, 
can’t ventilate” scenario.

TAB: Respiratory
SHOW: Airway

None required.

Bronchial Occlusion Completely obstructs right and/or 
left mainstem bronchi, simulating 
a lower airway obstruction (e.g. 
mucus plug). This yields an inability 
to ventilate the lungs.

TAB: Respiratory
SHOW: Airway

None required.

Trismus Simulates the presence of a 
masculatory muscle spasm.

TAB: Respiratory
SHOW: Airway

None required.

Articulated Mandible Allows for jaw thrust when sensors 
in the lower jaw are grasped in a 
clinically appropriate manner.

Cricothyroid 
Membrane

Allows needle cricothyrotomy, 
transtracheal jet ventilation, 
retrograde wire techniques and 
cricothyrotomy.

None required. See 
Cricothyrotomy,  
page 4.27.

Breakaway Teeth Upper front teeth can be dislodged 
if laryngoscopy is performed 
incorrectly.

None required. See Breakaway 
Teeth, page 
4.28.
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Realistic Upper Airway

The upper airway of iStan is designed to allow for intubation and laryngoscopy. Oral 
and nasal intubation can be performed using a variety of airway devices, including 
LMAs (3 cm), endotracheal tubes (7.5 cm), nasal-pharyngeal airways (30 mm) and 
oropharyngeal airways (90 mm).

Sensors detect right mainstem intubation, and the action is recorded in the Events 
log. In addition, the simulator exhibits a right unilateral chest rise, and the appropriate 
physiological changes result.

Intubation incorrectly applied into the esophagus will cause abdominal distension.

IMPORTANT 

Airways can be damaged by improper insertion of an airway adjunct (e.g. 
endotracheal tube). To protect the airway, lubricate the adjunct prior to insertion using 
the silicone spray provided.

Use ONLY the provided SILICONE SPRAY to lubricate the adjunct. NEVER use a 
water-based lubricant because of resulting residue damage.

Articulated Mandible

An articulated mandible permits jaw thrust so when sensors in the lower jaw are 
grasped in a clinically appropriate manner, the mandible may be extended.

This action is recorded in the Events log.
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Variable Upper/Lower Airway Resistance

Airway interventions can be necessitated and complicated by a number of variables. 
Located in the Airway menu found under the Respiratory tab are six parameters that 
affect ventilation and intubation.

Airway Occluder

Swelling of the posterior oropharynx (airway occluder) can be activated to obstruct the 
view of the larynx and prevent intubation, but allow mask ventilation of the patient’s 
lungs, thereby creating a “cannot intubate, can ventilate” scenario.

Selecting Airway Occluder

After locating the Airway Occluder option in the Airway menu found under the 
Respiratory tab, select the On button to activate the feature. The Airway Occluder 
option is set by default to Off. 
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Laryngospasm

A laryngospasm actuator closes the patient’s vocal cords and prevents both ventilation 
and intubation. When activated along with the Airway Occluder, a “cannot ventilate, 
cannot intubate” crisis scenario is achieved.

Selecting Laryngospasm

Activate the Laryngospasm option in the Airway menu by clicking the On button. The 
Laryngospasm option is set by default to Off. 
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Tongue Edema (Swelling) 

Tongue swelling can be activated to varying degrees (moderate or severe).

Selecting Swollen Tongue

After selecting the Swollen Tongue parameter from the Airway menu, choose either 
the Swollen (for severe swelling) or Semi-swollen option by clicking the corresponding 
button. The Swollen Tongue option is set by default to Not Swollen.
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Bronchial Occlusion

Bronchial Occlusion completely obstructs the right and left bronchi, simulating a lower 
airway obstruction (e.g. mucus plug). Improper intubation creates a mainstem occlusion, 
yielding an inability to ventilate the lungs. However, the right and left bronchi are not 
occluded individually.

Setting Bronchial Occlusion

After selecting the Bronchial Occlusion parameter from the Airway menu, choose 
either the Both, Left or Right lung option and then click the Occluded button. 

The rate of Resistance can also be set using either the slider bar or the rate fields. 
Using a slider bar or the time field, the Onset option allows for the increase in resistance 
to take place over a set period of time. Once the resistance and onset time have been 
entered, click the Set button to activate.

The default setting for Bronchial Occlusion is Unoccluded in Both lungs at a rate of 1 
cmH20/lpm@ 20 lpm.

Establish the rate of 
Resistance and the Onset 

time, then click the Set Button

Select the Both, Left or 
Right lung option and click the 

Occluded button
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PEEP 

The PEEP parameter specifies the amount of positive end expiratory pressure applied 
during mechanical ventilation. Setting this parameter results in clinically appropriate 
intrathoracic pressures and hemodynamic responses.

Setting PEEP

After selecting the PEEP option from the Airway menu, use either the slider bar or enter an 
amount in the rate field to establish the rate of pressure before clicking the Set button. 

PEEP must be set in both the software and on the ventilator.
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Trismus 

Enabling Trismus simulates the presence of a masculatory muscle spasm and thus 
makes opening the mouth difficult.

Trismus can be located under the Airway menu on the Respiratory tab.

Selecting Trismus

And, Trismus can also be found under the Condition tab in the Assessment menu.

Trismus located under the Condition Tab

To activate Trismus, click the Enable button.
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Cricothyrotomy

To replicate a needle cricothyrotomy:

Spray the silicone lubricant onto the airway adjunct prior to the simulation session. 

Locate the simulated cricothyroid membrane sealed with tape underneath the neck skin.

Follow standard clinical techniques and palpate to find the cricothyroid space. 

Puncture the space through the neck skin of the patient simulator and into the tape 
“membrane.” This puncture goes all the way through to the “trachea,” simulating the 
clinical procedure. 

Users must replace the tape that simulates the cricothyroid membrane after each 
cricothyrotomy.

A replacement neck skin, airway lubricant and spools of tape are available in the 
Replacement Kit.

Replacing the Cricothyrotomy Tape

Remove the old, punctured tape completely from the cricoid feature and use alcohol (an 
alcohol prep pad works well) to clean the glue residue from the surface. Allow to dry.

Cut an approximately 2.25 inch (6 cm) length of the double-sided tape from the roll 
provided.

Carefully remove the paper backing and lightly stretch the newly revealed adhesive side of 
the tape over cricoid hole and down the far side of the cricoid feature. Use the non-stick 
paper backing to press the tape against the cricoid feature.

Cut a 2.5 to 3.0 inch (7 to 8 cm) length of red tape and apply it over the cricoid feature and 
the tape.

Resealing the Membrane after a Puncture

To reseal the cricoid feature apply a small piece of red tape over the punctured area. This 
can be repeated a brief number of times, but when the number of layers impedes the 
cricothyrotomy, all existing tape must be removed and replaced with new tape.
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Teeth with Breakaway Incisors

iStan is equipped with Breakaway Teeth whose front incisors become dislodged with  
improper handling of a Laryngoscope. 

The teeth are tied to the upper denture with a lanyard, which prevents losing the teeth 
down the airway or misplacing them during storage.

Throat Sounds

Stridor throat sounds can be enabled by navigating to the Sounds menu beneath the 
Condition tab and choosing the Throat option. Then, select the Stridor option under 
the Throat Sound menu.

                               
Selecting Throat Sounds

The volume of the stridor sounds can be adjusted using the slider bar.

The patient must be connected to iStan for any volume adjustment to be effective.

None is the default Throat Sound. 
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Pulmonary
iStan uses both physical and mathematical models to achieve an extremely accurate 
simulation of respiration. iStan’s lungs react realistically to intubation as well as to 
pathophysiologic states. The patient’s chest rises and falls synchronously with the 
inflationary state of the underlying lungs.

Pulmonary System
Anatomy,            
Physiology and 
Clinical Signs

Clinical Interventions, Patient Monitoring 
and Scenarios.

Software Control Manual Control

Spontaneous, 
Self-Regulating 
Breathing

Normal tidal breathing and 
pathophysiological conditions such as 
atelectasis, pneumothorax, asthma and 
COPD.

None required, but 
adjustable
TAB: Respiratory
SHOW: Respiratory 
Control

None required.

Exhaled CO2 Measure the presence or absence of 
CO2.

None required, but 
adjustable
TAB: Respiratory
SHOW: Respiratory 
Control

CO2 canister is 
inserted, see 
page 2.11.

Symmetric and 
asymmetric 
Lung Ventilation

Tracheal, pathophysiologic conditions 
such as pneumothorax.

None required, but 
adjustable
TAB: Respiratory
SHOW: Respiratory 
Control

None required.

Chest Excursion Synchronized with ventilation 
(spontaneous or mechanical). Excursion 
depth proportional to tidal volume.

None required. None required.

Breath Sounds Normal and abnormal breath sounds 
are independently synchronized with 
ventilation of the right and left lungs. 
Breath sounds can be auscultated 
over anterior and posterior anatomic 
locations.

None required, but 
adjustable
TAB: Condition
SHOW: Sounds

None required.

Pulse Oximetry Oxyhemoglobin saturation (SpO2) 
automatically correlates with the oxygen 
concentration in the lungs and the 
intrapulmonary shunt fraction.

None required, but 
adjustable
TAB: Respiratory
SHOW: Respiratory 
Control

SpO2 probe is 
attached, see 
page 2.10.

Arterial Blood 
Gases

PaO2, PaCO2 and pH are continuously 
calculated and displayed on the HUD.

None required, but 
adjustable
TAB: Respiratory
SHOW: Respiratory 
Control

None required.

Venous Blood 
Gases

PvO2 and PvCO2 are continuously 
calculated and displayed on the HUD.

None required, but 
adjustable
TAB: Respiratory
SHOW: Respiratory 
Control

None required.



4.30

Using iStan

Breath Sounds 

Breath sounds are independently synchronized with ventilation of the left and right 
lungs. Eight anterior and six posterior speakers provide breath sounds that can be 
auscultated.

Choosing Breath Sounds

The Breath Sounds parameter is located on the Sounds menu beneath the Condition 
tab. 

Select either the Anterior or Posterior sounds. In addition to the Normal sounds, each 
quadrant is capable of independently emitting six additional sounds:

Wheezing•	

Crackles•	

Diminished•	

Rhonchi•	

Pleural Rub•	

Gurgling•	

Use the slider bar beneath the selected area to control the volume of the sounds.

The patient must be connected to iStan for any volume adjustment to be effective.

By default, Normal breath sounds are heard.

Select Anterior or 
Posterior breath sounds

Set each quadrant independently 
or choose All Breath Sounds
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Lung Parameters

Lung and chest wall capacity and compliance can be controlled through a set of 
options located on the Lung menu found on the Respiratory tab.

Selecting the Lung Menu

In addition to offering settings for volume and pressure in the lungs, these parameters 
also allow for the administration of oxygen as well as certain anesthetics. A parameter 
is also provided to allow Intrapleural Volume to accumulate to simulate conditions 
such as pneumothorax, hydrothorax or hemothorax. Lung parameters include:

Chest Wall Capacity•	

Chest Wall Compliance Factor•	

Distended Chest Wall Compliance Factor•	

Fixed Alveolar Enflurane•	

Fixed Alveolar Halothane•	

Fixed Alveolar Isoflurane•	

Fixed Alveolar Sevoflurane•	

Flail Chest•	

Fraction of Inspired O•	 2 Override

Functional Residual Capacity•	

Intrapleural Volume•	

Lung Compliance Factor•	

pH Shift•	

Venous CO•	 2 Shift
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Respiratory Control Parameters

The patient’s respiratory drive can be controlled through a set of options located on the 
Respiratory Control menu found on the Respiratory tab.

Selecting the Respiratory Control Menu

Respiratory Control parameters include:

CO•	 2 Production Factor

CO•	 2 Set-point

Fixed Neuromuscular Blockade•	

I to E Ratio (I:x)•	

O•	 2 Consumption

PetCO•	 2 - PaCO2 Factor

Respiratory Gain Factor•	

Respiratory Quotient•	

Respiratory Rate Factor•	

Respiratory Rate Override•	

Shunt Faction•	

Tidal Volume Factor•	

Tidal Volume Override•	

Volume/Rate Control Factor•	
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Cardiovascular
iStan produces realistic heart sounds and a wide range of pathophysiologic conditions 
synchronized to the QRS complex of the ECG and audible to a standard stethoscope.

Cardiovascular System
Anatomy,
Physiology and 
Clinical Signs

Clinical Interventions, Patient Monitoring 
and Scenarios.

Software Control Manual Control

Heart Sounds Normal and abnormal heart sounds are 
synchronized with the QRS complex of the 
ECG. Heart sounds can be auscultated 
over the left and right upper sternal 
border, right lower sternal border and 
apex.

None required; 
specific sounds can 
be selected.
TAB: Condition
SHOW: Sounds

None required.

3-Lead or 
5-Lead ECG

ECG waveforms can be viewed on a 
standard monitor and/or on the Waveform 
Display Monitor. Normal and abnormal 
cardiac rhythms are linked to patient 
physiology (e.g. blood pressure, cardiac 
output).

None required; 
specific rhythms can 
be selected.
TAB: Cardiovascular
SHOW: Heart

ECG monitor 
may be utilized.

Myocardial 
Ischemia

Myocardial oxygen supply and demand 
automatically influence the cardiac 
rhythm, yielding response to hypoxemia.

None required, but 
adjustable.
TAB: Cardiovascular
SHOW: Heart

None required.

Palpable 
Pulses

Carotid, brachial, radial, femoral, popliteal, 
posterior tibial and dorsalis pedis pulses 
can be palpated bilaterally and are 
synchronous with the cardiac cycle. A 
pulse deficit automatically occurs if the 
systolic arterial blood pressure falls below 
specified thresholds.

None required, but 
adjustable.
TAB: Cardiovascular
SHOW: Pulses

None required.

Manual Blood 
Pressure

Systemic blood pressure can be measured 
using the return-to-flow technique. 
Korotkoff sounds can also be auscultated.

None required. Use of modified 
blood pressure 
cuff.

Invasive 
Hemodynamic 
Monitoring

Various hemodynamic physiological 
indicators are registered and can be 
monitored.

None required, but 
adjustable.
TAB: Cardiovascular
SHOW: Catheters

None required.

Baroreceptor 
Reflex

Cardiovascular system automatically 
compensates for changing hemodynamic 
conditions.

None required, but 
adjustable.
TAB: Cardiovascular
SHOW: Heart and 
Systemic

None required.

Circulation Normal and abnormal circulation (e.g. 
hypovolemia, hypervolemia and right/left 
heart failure) can be adjusted.

None required, but 
adjustable.
TAB: Cardiovascular
SHOW: Heart

None required.

Jugular Vein 
Distension

The jugular veins can be distended for 
assessment.

None required, but 
adjustable.
TAB: Condition
SHOW: Assessment

None required.
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Pulses 

Fourteen pulse locations are activated, through sensors, by touch:

Carotid (2)•	

Brachial (2)•	

Radial (2)•	

Femoral (2)•	

Popliteal (2)•	

Posterior Tibial (2)•	

Dorsalis Pedis (2)•	

When a pulse is activated and when that pulse is no longer being palpated the action is 
recorded on the Events Log for later review.

The Pulses menu is located under the Cardiovascular tab.

Pulses

A pulse deficits occurs when the systolic arterial blood pressure falls below the 
threshold indicated at the bottom of the screen.

Palpable Pulse Thresholds
Carotid 60mmHg Popliteal 80mmHg

Brachial 80mmHg Posterior Tibial 80mmHg

Radial 90mmHg Dorsalis Pedis 80mmHg

Femoral 70mmHg
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Heart Sounds

Heart sounds can be independently set by adjusting the volume and the sound for each 
auscultatory area. The first heart sound involves valvular closure from the aortic and 
pulmonic valves, and the second heart sound is composed of the sound from mitral and 
tricuspid valve closure.

Choosing Heart Sounds

By default, heart sounds are set at a normal sound at a rate of less than or equal to 80 
beats per minute with their default volume equally for all areas. Each area may be set to 
the following sounds:

Normal (HR less than or equal to 80 beats per minute)•	

Normal (HR greater than 80 beats per minute)•	

S3•	

S4•	

S3 and S4•	

Early Systolic Murmur•	

Mid Systolic Murmur•	

Late Systolic Murmur•	

Pan Systolic Murmur•	

Late Diastolic Murmur•	

Normal and abnormal heart sounds are synchronized with the QRS complex of the 
ECG. Heart sounds can be auscultated over the left and right sternal border, right lower 
sternal border and apex.

The Heart Sounds parameter is located on the Sounds menu beneath the Condition tab.
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Jugular Venous Distension (JVD)

Distension of the jugular veins can be activated bilaterally to provide a visual and 
palpable assessment tool.

Choosing Jugular Vein Distension

The Jugular Vein Distension parameter is located on the Assessment menu beneath 
the Condition tab. 
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3-Lead or 5-Lead ECG

A 3-lead or 5-lead ECG is emitted from the appropriate positions for display on a standard monitor. 
A contact is available on iStan’s chest for each of five cables.

The simulator generates a normal sinus ECG, as well as a broad range of abnormalities such 
as myocardial ischemia, sinus tachycardia and bradycardia, ventricular fibrillation and asystole. 
The hemodynamic response to the arrhythmias is physiologically correct. Myocardial oxygen 
balance and cardiac ischemia automatically influence the cardiac rhythm resulting in a realistic 
and automatic response of the rhythm to hypoxemia. The degree of influence can be controlled or 
completely overridden by the instructor.

Five ECG leads 
are available
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Myocardial Ischemia

A myocardial ischemia rhythm from moderate to severe can be set using the Cardiac 
Rhythm Override parameter located under the Heart menu on the Cardiovascular tab.

In addition, the Ischemic Index Sensitivity parameter, also located on the Heart menu, 
can be used to set the relative sensitivity of the patient to myocardial ischemia.

Selecting Ischemic Index Sensitivity

The lower the value the patient has, the less sensitive the patient is to poor oxygenation 
and the less likely the patient is to go into a “death spiral.”

The Ischemic Index Averaging parameter, located above Ischemic Index Sensitivity 
on the Heart menu, determines how quickly myocardial ischemia develops in the 
presence of an unfavorable oxygen supply/demand ratio or how rapidly it resolves when 
myocardial oxygenation becomes favorable.

For additional information on the Ischemic Index, see page 3.17.
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Invasive Hemodynamic Monitoring

The invasive hemodynamic monitoring package provides the capability to measure and 
monitor:

Arterial blood pressure•	

Left ventricular pressure•	

Central venous pressure•	

Right arterial pressure•	

Pulmonary artery pressure•	

Pulmonary artery occlusion (wedge) pressure•	

Thermodilution cardiac output•	

The introduction and progressive insertion of a pulmonary artery catheter, synchronous 
with the appropriate waveforms, can be simulated with the results shown on the patient 
Waveform Display.

The Catheters menu that contains the parameters affecting hemodynamic monitoring 
is located on the Cardiovascular tab.

Selecting Cardiac Output Measurement

Cardiac Output Measurement can simulate the injection of 10cc iced saline into the 
pulmonary artery catheter.

The cardiac output is available as a “Continuous Cardiac Output” numeric on the 
Waveform Display.
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Catheter: Arterial can simulate zeroing a pressure transducer using the Atmosphere 
selection or cardiac catheterization procedures using the Left Ventricle selection.

Selecting Catheter: Arterial

The arterial pressure displayed on the Waveform Display is set using this parameter.

Catheter: Central Venous can simulate zeroing a pressure transducer using the 
Atmosphere selection.

Selecting Catheter: Venous

The central venous pressure displayed on the Waveform Display is set using this 
parameter.
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Catheter: Pulmonary Artery can simulate zeroing a pressure transducer using the 
Atmosphere selection.

Selecting Catheter: Pulmonary Artery

The pulmonary artery pressure displayed on the Waveform Display is set using this 
parameter.

Inflation of the pulmonary catheter balloon is simulated by selecting the Balloon 
Inflated option on the PA Catheter Balloon Inflation (wedge) parameter.

Selecting PA Catheter Balloon Inflation (Wedge)

The appropriate pulmonary artery, or “wedge,” waveform is then displayed on the 
Waveform Display.
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Baroreceptor Reflex

iStan’s cardiovascular system automatically compensates for changing hemodynamic 
conditions.

The Baroreceptor Gain (Overall) Factor adjusts the influence of mean arterial pressure 
(MAP) on heart rate, contractility, systemic vascular resistance, and venous capacity. 
Use the Baroreceptor Gain (Overall) Factor to adjust how vigorously the heart and 
vasculature respond to blood pressure changes.

Selecting Baroreceptor Gain (Overall) Factor

A Value above 1.00, the default, causes a stronger response to MAP changes. A Value 
less than 1.00 corresponds to baroreceptor depression.

The Baroreceptor Gain (Overall) Factor parameter can be located under the Systemic 
menu.

To adjust how vigorously the vascular responds to blood pressure changes, adjust 
the Value of the Baroreceptor Gain (Peripheral) Factor parameter located under the 
Systemic menu.
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Selecting Baroreceptor Gain (Peripheral) Factor

The Baroreceptor Maximum Pressure and Baroreceptor Maximum Pressure 
parameters define the mean arterial pressure (MAP) at which baroreceptor inhibitory 
activity on the heart is at its maximum and minimum.

  

	 Baroreceptor Maximum			    Baroreceptor Minimum

It is important to set both the Baroreceptor Maximum Pressure and Baroreceptor 
Maximum Pressure parameters at the same time for the software to recognize the 
baroreceptor reset.



4.44

Using iStan

Circulation

Circulation can be affected by blood or plasma loss, the infusion of fluids or changes to 
the contractility of the left or right ventricles.

Controlling Fluids

Selecting the Fluids tab opens a window that provides a means of controlling the 
amount of fluid lost by or infused into the patient. The upper panel provides scrollable 
access to the various fluid parameters and the bottom panels display the controls for 
entering the amount of fluid to be lost or infused and establishing the time frame during 
which the fluid loss or infusion will take place.

The Fluids Tab

There are six parameters on the Fluids tab that affect circulation.



4.45

Using iStan

Fluid Parameters Affecting Circulation
Fluid Event Use/Effect
Fluid Loss Volume (Blood) Reflects a decrease in total blood volume. “Blood Loss” proportionally 

decreases both the red blood cell volume and the plasma volume according 
to the current hematocrit.

Fluid Loss Volume (Plasma) Reflects a decrease in plasma volume. “Fluid Loss” decreases the plasma 
volume without changing the red blood cell volume. It refers collectively 
and generically to all fluid losses, including evaporative, transcellular (e.g. 
ascites, pleural effusion), bowel and third space fluid losses.

Infusion (Colloids) Reflects an addition to the plasma volume without changing the red 
blood cell volume. Colloids include modified fluid gelatin starch solutions 
(pentastartch and hetastarch), dextran and human albumin.

Infusion (Crystalloids) Reflects an addition to the plasma volume without changing the red blood 
cell volume. The term crystalloid is used to describe salt solutions for 
infusion, for example, normal saline, dextrose in water and Ringer’s Lactate.

Infusion 
(Packed Red Blood Cells)

A preparation of 70% red blood cells and 30% liquid plasma, often 
administered in severe anemia to restore adequate levels of hemoglobin and 
red cells without overloading the vascular system with excess fluids.

Infusion (Whole Blood) The term “whole blood” is used to refer to blood that has not been 
separated into its various components. It represents a preparation of 40% 
red blood cells and 60% liquid plasma.

To control fluids lost or infused:

Select the fluid by clicking on the icon in the scrollable window. The bottom panel 1.	
displays that fluid’s control settings.

In the 2.	 Value panel, use the slider to choose a value or enter the value in the field 
to the right of the slider. 

In the 3.	 Onset panel, click a radio button to select in Minutes or Seconds the time 
measurement for the fluid loss or infusion.  

Use the slider to choose the amount of time over which the fluid loss or infusion 4.	
will take place or enter that amount in the field to the right of the slider.

Click 5.	 Set.

The amount of fluid lost or infused appears in the Value fields as the loss or infusion 
takes place. This amount increases until the total value is achieved at the end of the 
onset time.
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Hematology Model

The physiological model calculates hematocrit values (i.e. percentage of total blood 
hemoglobin) dynamically and continuously, taking into account blood and fluid losses, 
as well as the intravenous infusion of fluids such as whole blood, packed red blood 
cells, colloids and crystalloids.

Instructors can create patients with both normal and pathophysiological hematocrit 
levels. In addition, learners discover how administering various fluids affects hematocrit, 
the oxygen-carrying capacity of blood, and the resulting patient response. 

The following important assumptions were made in the design of the Hematology 
Model:

Blood is comprised of two components: red blood cells and plasma.•	

Plasma is comprised of two components: colloid and crystalloid. The term colloid •	
is used to describe substances that generate a clinically significant colloid osmotic 
pressure, for example, fresh frozen plasma, albumin and hetastarch. The term 
“crystalloid” is used to describe salt solutions for infusion, for example, normal 
saline, dextrose in water and Ringer’s Lactate.

The mixing of blood and its various constituents is instantaneous and •	
homogeneous. In other words, one liter of crystalloid administered intravenously 
equilibrates immediately and homogeneously throughout the entire circulation.

This initial Hematology Model does not yet distinguish between the differing clinical •	
effects of colloids versus crystalloids. For example, osmotic pressures and capillary 
leakage rates are not taken into account. Likewise, fluid kinetics and how fluids 
distribute within the circulation, the interstitial, and intracellular spaces are also not 
presently modeled.
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In the Hematology Model, the following model variables, definitions and relationships 
have been established:

Red Blood Cell Volume: The volume of red blood cells within the circulation.

Plasma Volume: The volume of plasma within the circulation.

Total Blood Volume: The volume of blood (i.e. Red Blood Cell Volume + Plasma Volume)    
within the circulation.

Blood Volume Loss: The amount or rate of decrease in the total blood volume. A given 
amount or rate of blood loss proportionally decreases both the Red Blood Cell Volume 
and the Plasma Volume according to the current hematocrit.

Plasma Volume Loss: The amount or rate of decrease in the plasma volume. A given 
amount or rate of plasma loss decreases the plasma volume without changing the red 
blood cell volume. Plasma Volume Loss refers collectively and generically to all plasma 
fluid losses, including evaporative, transcellular (e.g. ascites, pleural effusion), bowel 
and third space losses.

Hematocrit: The ratio of Red Blood Cell Volume to Total Blood Volume, expressed as a       
percentage. 
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Adjusting Contractility

Cardiac output and blood pressure can be adjusted using the Contractility Factor: Left 
Ventricle and Contractility Factor: Right Ventricle parameters. 

     Contractility Factor: Left Ventricle	      Contractility Factor: Right Ventricle

The Contractility Factor parameters are located under the Heart menu on the 
Cardiovascular tab.
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Manual Blood Pressure

Blood pressure can be taken manually on the left arm.

Non-invasive blood pressure monitoring techniques can be used by attaching the standard cuff 
modified with a T-fitting and adapters.

The extension from the T-fitting is connected to the hose located inside the left upper-arm skin.

Connect the T-fitting extension to the hose and take the noninvasive blood pressure reading using 
the return-to-flow technique.

Store the modified blood pressure cuff with the system for future use.
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Korotkoff Sounds (5 phases)

Korotkoff sounds can be auscultated on the left arm.

To auscultate Korotkoff sounds,

Place the stethoscope on the left arm, just above the brachial pulse.1.	

Let the cuff pressure drop slowly by opening the valve on the bulb slightly.2.	

Monitor the pressure displayed on the cuff gauge.3.	

All five phases should be recognized:

Phase I - Clear, repetitive, tapping sounds (Systolic)

Phase II - Longer beats, with some swishing sounds

Phase III - Crisp, more intense rhythm sounds

Phase IV - Muffled, less distinct sounds

Phase V - Sounds disappear completely (Diastolic)

SpO2 Probe

The SpO2 probe is integrated with the Waveform Display and the physiological model.

The connection for the SpO2  probe is located on the left side of the simulator.

Instructions on connecting the SpO2 probe are shown on page 2.10.
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Capillary Refill (Big Toes/Thumbs)

The Capillary Refill parameters can be used to simulate the capillary nail refill test 
performed by blanching the nail bed.

 
	  Capillary Refill: Big Toe                                   Capillary Refill: Thumb

When activated the nail bed refills based upon the selection of greater than or less than 
three seconds. The intensity of the cyanosis may be set with the Perfusion Intensity 
parameter located on the Assessment menu on the Condition tab (see page 4.53).

The Capillary Refill parameters are located under the Assessment menu on the 
Condition tab.
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Cyanosis (Fingertips/Toes)

The Cyanosis parameters can be used to simulate the presence of cyanosis in the nail 
beds of the fingers or toes.

 
Cyanosis: Fingertips                              Cyanosis: Toes

The intensity of the cyanosis may be set with the Perfusion Intensity parameter 
located on the Assessment menu on the Condition tab (see page 4.53).

The Cyanosis parameters are located under Assessment on the Condition tab.
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Perfusion Intensity

The intensity of the brightness used to simulate cyanosis and capillary refill can be 
adjusted using the Perfusion Intensity parameter.

.
Perfusion Intensity

Perfusion intensity is used to match the intensity of the feature to that of the ambient 
surroundings. In poor light, set the feature to a low setting, and in brighter light, set the 
feature to a higher setting.

The Perfusion Intensity parameter is located on the Assessment menu on the 
Condition tab.



4.54

Using iStan

Genitourinary System
The simulator allows for the insertion of urinary catheters and excretion of urine with a 
flow rate that is controlled by the instructor.

Urinary Catheterization

Prior to use, ensure the clear secretions tank is full. 

Catheterize the simulator using a standard 14 to 16 gauge urinary catheter lubricated 
with silicone spray. 

If color is desired, place the desired amount of yellow food coloring in the Foley bag.

The bladder for the simulated urine is accessed directly via the urethra. 

Set the Urine Output to the maximum level (500 ml/hr) in the software.

Urinary Output

Urinary output can be controlled by adjusting the Urine Output value on the Fluids tab. 

Selecting Urine Output
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Advanced Cardiac Life Support (ACLS) System
The iStan includes several realistic Advanced Cardiac Life Support (ACLS) System mod-
ules offering advanced hands-on skills acquisition in airway management and ventila-
tion, chest compression, as well as the use of defibrillators and transthoracic cardiac 
pacers.

Advanced Cardiac Life Support System
Anatomy,
Physiology and 
Clinical Signs

Clinical Interventions, Patient Monitoring 
and Scenarios.

Software Control Manual Control

Airway 
Management 
and Ventilation

Alveolar and arterial gas concentrations 
appropriately reflect the efficacy of 
ventilation and oxygen administration.

Oxygen 
administration input 
by the instructor.
TAB: Respiratory
SHOW: Lung

None required.

Chest 
Compression

Effective chest compression results 
in artificial circulation, cardiac output, 
central and peripheral blood pressures, 
palpable pulses, and CO2 return.

None required, but 
adjustable.
TAB: Condition
SHOW: Trauma

None required.

Cardiac 
Arrhythmias

The desired arrhythmia can be selected. The response 
to clinical        
intervention must 
be controlled by the 
instructor.
TAB: Cardiovascular
SHOW: Heart

None required.

Defibrillation iStan supports operation with a variety 
of manual and automatic external 
defibrillators.

Defibrillation can 
be simulated by the 
instructor.
TAB: Cardiovascular
SHOW: External 
Cardiac Simulation

See 
Defibrillation 
below for 
defibrillation 
disk 
locations and 
instructions.

Cardiac Pacing Transthoracic cardiac pacemaker can 
be used with iStan. Pacing results in 
appropriate physiological changes in 
blood pressure and cardiac output.

The instructor can 
set the level at which 
electrical capture 
and mechanical 
capture occur.
TAB: Cardiovascular
SHOW: External 
Cardiac Simulation

See Pacing 
below for 
cardiac 
pacing disk 
locations and 
instructions.

Bilateral    
Autoinjection

Atropine may be administered through 
an autoinjector simulator by applying 
pressure on the lateral aspect of each 
thigh.

None required, but 
adjustable.
TAB: Condition
SHOW: Trauma

None required.
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Airway Management

Oxygen administration can be simulated using the Fraction of Inspired O2 Override 
parameter located under the Lung menu on the Respiratory tab.

Fraction of Inspired O2 Override

The percentage of oxygen administered is controlled using the slider bar. The Fraction of 
Inspired O2 (FiO2) setting is measured as a percentage, but can be converted to the liters 
per minute that flow through the nasal cannula using the following table:

Oxygen Therapy FiO2 Setting

1 liter per minute nasal cannula 24%

2 liters per minute nasal cannula 30%

3 liters per minute nasal cannula 36%

4 liters per minute nasal cannula 42%

5 liters per minute nasal cannula 48%

6 liters per minute nasal cannula 54%

10 liters per minute 78%

15 liters per minute 100%
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Chest Compression

iStan supports normal hand placement and standard compression techniques. The 
effectiveness of chest compression can be controlled using the Chest Compression 
Efficacy parameter located on the Trauma menu beneath the Condition tab.

Chest Compression Efficacy 

When Chest Compression Efficacy is set to 0%, chest compressions have no effect 
on intrathoracic pressure.

When Chest Compression is set at 100%, maintaining downward pressure on iStan’s 
lower sternum stops respiration and releasing the pressure allows the respiratory 
system to breathe again. Pressing on iStan’s sternum repeatedly increases the CVP and 
PAP blood pressure readings on the HUD and Waveform Display.
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Cardiac Arrhythmias

The patient’s underlying cardiac rhythm can be set using the Cardiac Rhythm Override 
parameter located on the Heart menu beneath the Cardiovascular tab.

Cardiac Rhythm Override

Certain settings indicate rhythms that have a corresponding fixed heart rate shown 
by parentheses. For example, if Sinus Tachycardia (120) is selected, the heart rate 
automatically becomes 120bpm. Rhythm settings that are not followed by parentheses 
may be adjusted using the Heart Rate Factor parameter also located on the Heart menu.

Heart Rate Factor

Heart rate can be increased or decreased by resetting the Heart Rate Factor.
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Defibrillation

iStan is designed to safely absorb the energy discharged from manual and automatic 
defibrillators. Standard defibrillation energy levels should be used for positive learning 
reinforcement and to avoid negative training transfer.

However, use of a defibrillator for training purposes represents an operational hazard 
equivalent to use of a defibrillator on a real patient. Consequently, ALL SAFETY 
PRECAUTIONS for the use of defibrillators MUST BE FOLLOWED as if the simulator 
were a patient. Consult the specific defibrillator’s User Manual for further information.

The following cautions should be observed:

Defibrillation should be performed on the defibrillation electrodes only. If •	
defibrillation is performed over any ECG electrode, high voltage may be present on 
the remaining connectors during the shock. This may also damage ECG circuitry.

To prevent overheating, do NOT provide more than three (3) defibrillator discharges •	
(maximum 200 joules with a biphasic defibrillator and 360 joules with a monophasic 
defibrillator) in a sequence. Do NOT exceed an average of two (2) defibrillator 
discharges per minute during the training session. 

Avoid a large number of consecutive discharges. For example, 20 or 25 discharges •	
without any recovery interval may damage the system.

Do NOT let the simulator come in contact with electrically conductive surfaces or •	
objects during defibrillation. A flame-supporting atmosphere, for example, with a 
high content of oxygen, should be avoided during defibrillation.

Keep the simulator chest dry. Special attention should be taken when using the •	
urinary system or the chest tube feature.

To prevent pitting of the chest skin electrode, do NOT apply conductive gel or •	
conductive defibrillation pads intended for patient use.

Do NOT use cables or connectors having visible damage.•	

Do NOT spill fluids over any component inside the simulator torso. This could •	
damage the system and may also present a possible hazard for the operator.

When using a manual defibrillator, the ECG can be monitored via the defibrillator •	
paddles. Coarse ventricular fibrillation and high-rate ventricular tachycardia cardiac 
rhythms are automatically recognized as “shockable” rhythms.

With each defibrillation, the iStan automatically records the amount of energy 
discharged and the time defibrillation was performed. The simulated patient response 
to defibrillation is determined by the scenario script or instructor intervention. Thus, 
cardioversion is not automatically determined by the physiological models.

The minimum electrical charge recognized by the circuitry within the simulator is 20 
joules.
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For paddle placement on the chest, the simulator has two anterior defibrillation disks, 
which can be unscrewed leaving threaded connections if required.

Monophasic and Biphasic defibrillators can be used with either paddles or hands-free 
connectors.

The Defibrillation parameter is available for virtual defibrillation.

Defibrillation

The Defibrillation parameter is located under the External Cardiac Simulation menu 
on the Cardiovascular tab.

Simulate the energy discharge by moving the slider bar or entering the desired charge 
into the Joules field beneath the bar. When you click the Set button, the energy causes 
the appropriate spike in the ECG. Cardioversion does not occur, however, and the heart 
returns to the pre-defibrillation rhythm unless changed using the Cardiac Rhythm 
Override parameter (also see Cardiac Arrhythmias, page 4.58).

Disks for defibrillation are located 
on the left side of the chest as well 

as to the right of the sternum
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Cardiac Pacing 

A standard transthoracic cardiac pacemaker can be connected to the simulator using 
the anterior contacts. The software automatically detects and responds to pacing 
signals (from 20 to 200 mA, in increments of 10).

Three parameters can be used to simulate pacing within the software:

Pacing Capture Threshold•	  - determines the minimum pacing current necessary to 
pace the heart.

Pacing Current•	  - simulates a specific amount of current discharged by an external 
cardiac pacemaker.

Pacing Rate•	  - determines the cardiac rate when the Pacing Current is at or above 
the Pacing Capture Threshold

All three parameters are located in the External Cardiac Stimulation menu on the 
Cardiovascular tab.
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Bilateral Autoinjection

Atropine may be administered into the lateral aspect of either thigh via autoinjection using the 
Autoinjection Enable option on the Trauma menu under the Condition tab.

Autoinjection Enable

Clicking Enable activates a mechanism that automatically registers the administration of atropine 
2mg intramuscularly. NO NEEDLE should be used to avoid damage to the simulator.
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Trauma System
The iStan simulator is equipped with a number of features specific to trauma care. The 
following provides a general overview of each feature.

Trauma System
Anatomy,
Physiology and 
Clinical Signs

Clinical Interventions, Patient Monitoring 
and Scenarios.

Software Control Manual Control

Chest Tube 
Placement

Chest tubes can be inserted bilaterally into 
the mid-axillary line of the fifth intercostal 
space. Suction equipment can be applied 
to withdraw fluid from the simulated 
intrapleural space.

The instructor must 
adjust the amount 
of physiologic  
intrapleural fluid 
present.
TAB: Condition
SHOW: Trauma

Chest tube 
setup, page 
4.64.

Needle 
Decompression

Decompression of a pneumothorax can be 
performed bilaterally by inserting a needle 
at the midclavicular line of the second 
intercostal space.

The instructor must 
adjust the amount 
of physiologic           
intrapleural air 
present.
TAB: Condition
SHOW: Trauma

Needle 
decompression 
setup, page 
4.66.

Secretions Blood or clear fluid may be secreted from 
either the nose, mouth or ear.

The response 
to clinical        
intervention must 
be controlled by the 
instructor.
TAB: Cardiovascular
SHOW: Heart

See Secretion 
System setup, 
page 2.13.

Intracranial 
Pressure

Cerebrospinal fluid may be injected or 
removed, head elevation decreases ICP, 
and a craniectomy may be simulated.

The response 
to clinical        
intervention must 
be controlled by the 
instructor.
TAB: Condition
SHOW: ICP

ICP probe 
setup, page 
4.71.

Bleeding/
Hemorrhage

Two simultaneous bleeding sites may be 
used. Bleeding is linked to physiology and 
may take place at all four limbs as well as 
the chest/belly.

Defibrillation can 
be simulated by the 
instructor.
TAB: Cardiovascular
SHOW: External 
Cardiac Simulation

See Secretion 
System setup, 
page 2.13.

Flail Chest Abnormal mobility and loss of normal 
chest wall movement can present on the 
lower right side of the thoracic wall.

The instructor can 
set the level at which 
electrical capture 
and mechanical 
capture occur.
TAB: Condition
SHOW: Trauma

None required.
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Chest Tube

A 26- or 28-Fr chest tube can be inserted at the mid-axillary line of the fifth intercostal 
space on either side of the simulator. Using ordinary chest tube equipment, fluid and air 
can be withdrawn from the pleural space. The volume removed influences the patient’s 
physiology to reflect improvement in pulmonary mechanics and gas exchange.

Correct insertion of the chest tube is entered into the log for use during debriefing and 
can be used as a scenario transition.

The chest tube feature is primed and enabled using the Chest Tube Enable parameter 
located under the Trauma menu on the Condition tab.

To prime the Chest Tube feature:

Insert the chest tube into the simulator as far as possible.1.	

Select the 2.	 Both and Prime options under Chest Tube Enable.

Chest Tube Enable

Once water begins to flow, remove the tube.3.	

Click 4.	 Enabled and select the location (Both, Left or Right) to be utilized.

Select Both and Prime
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Three additional parameters allow the user to set air flow and fluid rate as well as to 
determine the type of air leak:

Chest Tube Air Flow Rate•	  - determines the quantity of air that drains with the chest 
tube output.

Chest Tube Air Leak Type•	  - sets whether the leak is a pneumothorax or an air leak 
with the chest tube or the chest wall.

Chest Tube Flow Rate•	  - specifies the rate at which fluid can be removed from the 
simulated pleural space via a chest tube drainage system.

All three parameters are located in the Trauma menu on the Condition tab. 

The Intrapleural Volume parameter allows intrapleural volume to accumulate, for 
example, as happens during pneumothorax, hydrothorax and hemothorax.

To simulate a pneumothorax, set the corresponding intrapleural volume to a value 
greater than 0 ml. Values above 1500 ml reduce the corresponding lung volume 
significantly. Breath sounds are automatically diminished on the appropriate side due to 
decreased ventilation of the affected lung.

When intrapleural volume is set to a value greater than 500 ml, chest movement stops.

Intrapleural Volume

The Intrapleural Volume parameter is located on the Trauma menu under the 
Condition tab.

For information regarding cleanup after using the Chest Tube feature, see pages 5.12 
through 5.15.
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Needle Decompression

To set up a Pneumothorax Needle Decompression, enable the feature using the Needle 
Decompression option on the Trauma menu under the Condition tab.

Needle Decompression

Select Enable to activate the feature.

Needle decompression can be performed bilaterally into the small hole located in the 
mid-clavicular line of the second intercostal space. Insert a 3 to 6 cm long, 14-gauge 
needle until the hissing sound of the valve release is heard.

The Intrapleural Volume parameter (see page 4.65) can be used to allow intrapleural 
volume to accumulate.

Effective needle decompression immediately reduces the intrapleural volume. The 
hissing sound stops when intrapleural volume is zero.
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Bleeding/Hemorrhage

iStan is capable of bleeding simultaneously at two sites. The integrated hemorrhage 
system allows for the physical and modeled simulation of venous or arterial bleeding at 
moulaged wound sites at all four limbs as well as at the chest/belly.

Blood loss is continuously reported to the physiological models. The models respond 
to the reported blood loss with the appropriate cardiovascular and respiratory system 
changes to heart rate, blood pressure, and respiratory parameters.

Two parameters control the bleeding feature. 

The Bleeding: Ch.1 – Location parameter is used to activate the site of bleeding. 

Bleeding: Ch.1 - Location

The Bleeding: Ch.1 – Type of Hemorrhage is used to control the type (venous or 
arterial) and size (small, medium or large) of a bleed.

Bleeding: Ch.1 - Type of Hemorrhage

Both Bleeding parameters are located on the Trauma menu under the Condition tab.
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When selected, bleeding results in an automatic loss of blood from the physiologic 
models with subsequent changes in hemodynamics. Venous settings produce a 
continuous bleed at three user-adjustable flow rates. Arterial settings produce a pulsing 
flow based on the patient’s heart rate, at three user-adjustable flow rates. Blood loss 
will occur at a rate dependent on wound size and Mean Arterial Pressure (MAP).

For instructions on filling the fluid reservoirs see page 2.13.

Hemorrhage Setup

The user determines the type and placement of the bleeding moulage for the lesson. 
An optional Moulage Kit (see page 1.10) can provide molded gunshot wounds, broken 
and protruding bones, amputations and an abdominal wound as well as theatrical 
components.

To decrease the likelihood of staining, apply a thin coat of Vaseline to the area of 
bleeding.

Using one of the moulage wounds from the Moulage Kit:

Secure the wound over the simulator using the integrated straps.1.	

Connect this haptic to the wound umbilical, the hose running along the arm or leg 2.	
downward from the red Bleeding Connector for each limb (or abdomen).

The Bleeding Connectors for the legs can be found behind the skin on either side of the 
simulator at the hip. The Bleeding Connector for the arms can be found protruding from 
the upper arm skins. The Bleeding Connector for the abdomen is also located behind 
the skin on the right side of the simulator at the hip. Look for a male shut-off fitting 
marked with a red label. 

Hemorrhage Control

The bleeding rates at moulaged wound sites are monitored for effective hemorrhage 
control therapy (e.g. Hemostat, Tourniquet). Data from the physiological blood models is 
recorded in the physiologic logs for use during debriefing.

For information regarding cleanup after using the Hemorrhage feature, see page 5.12.
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Tourniquet Application

A tourniquet may be applied to stop the flow of blood.

The wound umbilical contains an 18-inch section of soft tubing that allows the use of 
a tourniquet to stop the flow of blood. Use the included tape to hold the hose in the 
correct location for tourniquet usage. 

For added realism, the simulator should be dressed in clothing that can be torn to 
“conform” with the type of injury being demonstrated. Bleeding moulages and the 
wound umbilical should be concealed under the victim’s clothing with only the wound 
showing.

To stop bleeding, apply the tourniquet between the wound and heart.
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Secretions

Either blood or clear fluid can be secreted from the ears, nose or mouth. This feature is 
activated by selecting the appropriate fluid from the Secretion option.

Secretion: Ears

The Secretion parameters are located on both the Assessment and Trauma menus 
under the Condition tab. 

For instructions on filling the fluid reservoirs see page 2.13. 

For information regarding cleanup after using the Secretions feature, see pages 5.13 
through 5.15.

Flail Chest

To activate the flail chest, click the Enabled option on Flail Chest parameter located on 
both on the Trauma menu under the Condition tab.

Selecting the Flail Chest Feature

Select Enabled to activate 
the Flail Chest feature
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Intracranial Pressure

Available as an option, the Intercranial Pressure feature allows for increases in 
intracranial pressure caused, for example, by intracranial lesions, hematomas, tumors, 
infection and impaired cerebrospinal fluid (CSF) dynamics. These changes in intercranial 
pressure can be simulated using the parameters located under the ICP menu on the 
Condition tab.

Selecting the ICP Menu

A series of parameters offers a variety of means to simulate various pathological 
conditions:

Autoregulation Gain Factor•	  - adjusts the gain of the system that controls arterial 
resistance and compliance.

Cerebral Autoregulation Status•	  - can be used to create a new patient with a status 
of Chronic Hypertension.

CO•	 2 Reactivity Factor - determines the change in cerebral blood flow in response 
to a change in PaCO2.

CSF Outflow Resistance Factor•	  - controls the rate of cerebrospinal fluid outflow.

ICP Override•	  - sets the ICP (uninfluenced by physiological models) on the 
Waveform Display. This parameter is also available on the Assessment menu.

Intracranial Elastance Factor•	  - determines the rigidity of the intracranial 
compartment. Increases in this factor reduce intracranial compliance.

Intracranial Venous Resistance Factor•	  - produces an increase in the resistance of 
the terminal intracranial veins when the value is increased.
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Position of CO•	 2 Regulation Curve - determines the PaCO2 set point at which 
smooth muscle tension in large and small pial arteries is at the baseline value.

Time Constant of CO•	 2 Reactivity - adjusts the delay between changes in EtCO2 
and a change in pH at the cerebral arterioles.

In addition, the following therapeutic interventions are available:

Catheter: Intracranial Pressure•	  - sets the ICP numerical value displayed on the 
Waveform Display or on the intracranial channel of a physiologic monitor.

Craniectomy•	  - simulates a decompressive craniectomy to lower ICP as a last resort 
when all other methods to decrease ICP have failed.

CSF Injection/Removal•	  - simulates the addition or removal of cerebrospinal fluid 
from the craniospinal space.

Head Elevation•	  - can be adjusted by degrees to decrease intracranial pressure.

Intracranial pressure (ICP) is displayed on both the HUD and as a numeric reading on 
the Waveform Display. Mean arterial pressure (MAP) is also displayed as a numeric on 
the Waveform Display.

ICP, cerebral blood flow (CBF), cerebral perfusion pressure (CPP) and MAP are all 
recorded on the Physiologic Data Log and may be reviewed during debriefing.

For information regarding cleanup after using the ICP feature, see page 5.16.
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Ventriculostomy

As part of the optional intercranial pressure feature, drainage of CSF through a 
ventriculostomy can be simulated using a ventricular drain and monitor. Two ports, one 
on each side of the skull, can be used to withdraw fluid from an internal ICP reservoir.

Connect the ICP Interface cable between the simulator and the Ventricular Drain’s 1.	
pressure transducer.

Connect the patient monitor’s invasive pressure cable to the ICP Interface cable’s 2.	
second port.

Connect the ICP Fluid Adapter to iStan’s head (on the left or right).3.	

Temporarily connect this hose to an empty IV bag line to capture fluid during this 4.	
set-up stage.

Select 5.	 ICP Override from the list of Parameters located under the ICP menu on 
the Condition tab.

Set the value to the maximum mmHg. Air bubbles and/or fluid will exit from ICP 6.	
reservoir, through tube and into the container.  

When bubbles and/or fluid has stopped, select 7.	 ICP Override.
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Set the value to 0 mmHg.8.	

Inject 120cc of distilled water into the ICP reservoir via the ICP Fluid Adapter.9.	

Connect the ICP Fluid Adapter to a primed Ventricular Drain device line.10.	

Set the “0” reference point on the device to be level with iStan’s ear canal.11.	

Select 12.	 ICP Override again.

Set the value to the maximum mmHg.  Allow the flow to prime the Ventricular 13.	
Drain completely.

 Return the ICP Override parameter setting to 14.	 -1 (Model Driven).

For information regarding cleanup after using the ICP feature, see page 5.16.

Cervical Spine Immobilization 

Two sensors, one in the head and a second in the torso, detect and record cervical 
spine movement. This information also appears on the HUD under the readings for 
CS-X (horizontal movement) and CS-Y (vertical movement).

Flexion and torsion of the head and detection of c-spine immobilization is entered into 
the physiologic log for use during debriefing.

For information on securing the neck and head to restrict movement, see page 5.9.
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Pharmacology System
iStan supports pharmacological interventions through pre-programmed 
pharmacokinetic and pharmacodynamic parameters that are established for more than 
50 intravenous drugs.

Standard syringes and infusion devices can be utilized to administer medications and 
fluids through veins on the left and right arms.

Additionally, medications and fluids can be administered through the permanent access 
catheters located at the right jugular and the left femoral veins.

Pharmacology System
Anatomy,
Physiology and 
Clinical Signs

Clinical Interventions, Patient Monitoring 
and Scenarios.

Software Control Manual Control

IV Access The right and left arms of the simulator 
provides intravenous access locations 
at the dorsal and cephalic veins. IV 
cannulations may be set to receive a flash.

None required. See IV Access 
and Flash 
below.

IV Medication 
Administration

Bolus injections are administered utilizing 
standard syringes while continuous IV 
infusions can be administered using 
infusion devices. Injections can be 
administered in the IV arm or in two 
permanent access catheters located at 
the right jugular and left femoral veins.

Administered IV 
medications must be 
set by the instructor.
TAB: Drugs
See page 3.67

All administered 
IV medications 
are collected 
in the bag 
attached to the 
IV Drain hose 
located on the 
simulator’s right 
hip.

IV Fluid 
Administration

IV fluids can be administered in the IV arm 
or in the two permanent access catheters 
located at the right jugular and left 
femoral veins.

Administered IV 
fluids must be set by 
the instructor.
TAB: Fluids
PARAMETER: 
Infusion (Colloids, 
Crystalloids, Packed 
Red Blood Cells or 
Whole Blood)
See page 3.68

All administered 
IV medications 
are collected 
in the bag 
attached to the 
IV Drain hose 
located on the 
simulator’s right 
hip.

Intraosseous 
Infusion

Intraosseous sites are available at the 
sternum and bilaterally at the tibia.

None required. None required.



4.76

Using iStan

Permanent IV Access Ports

Permanent IV access ports are located at the right jugular and left femoral veins.

To use the IV access ports:

In preparation, drain the fluid reservoir by connecting a 60cc syringe to the drain 1.	
port on the right side of the simulator. 

Withdraw air and excess moisture from the reservoir until a vacuum is formed 2.	
(the plunger is difficult to pull).

Connect a 60cc syringe filled with distilled water to the Jugular IV port and prime 3.	
the line with approximately 15cc.

Move the 60cc syringe to the Femoral IV port and prime the line with 4.	
approximately 15cc.

Using an empty 60cc syringe connected to the IV Source port located in the 5.	
mid-clavicular region, withdraw trapped air from the system until the plunger is 
difficult to move. 

Connect a 60cc syringe filled with distilled water to the IV Source port and firmly 6.	
inject all 60cc. This primes the arms and charges the system for Flash and 
Venipuncture support.

Intravenous fluids and medications can be administered by attaching the hose from a 
standard IV solution set to the port.

Approximately 250 ml of fluid may be administered without opening the drain (located 
on the right hip of the simulator) to allow for additional fluids.

For additional realism, use tinted red distilled water when priming the IV Source port. 
Also see Flash, page 4.77.

For information regarding cleanup after using the IV/IO feature, see page 5.16.
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IV Access

IV access is available at the dorsal and cephalic veins of iStan’s right and left arms. 

Cannulate the arm veins using standard venous access needles and catheters. 1.	
Use only 20 to 22 gauge needles. 

In the HPS6 software select and adjust the appropriate drug from the Drugs 2.	
tab (see page 3.67) to make manual modifications to influence the patient’s 
physiology.

Flash

IV cannulations receive a flash when the internal reservoir is primed. 

WARNING: If a flash does NOT occur, do NOT inject any fluid and remove the needle 
immediately. Repeat the priming directions on page 4.78 and ensure you have 
injected the needle properly and into the simulated vein.

To prime the internal reservoir:

Locate the IV Source catheter in the left mid-clavicular region.1.	

Use a 60cc syringe to withdraw any air or excess moisture from the reservoir 2.	
through the catheter.

Fill the reservoir with approximately 60cc of distilled water mixed with red food 3.	
coloring.

For additional realism, use tinted red distilled water when priming the IV Source port.

For information regarding cleanup and maintenance after using the IV/IO feature, see 
pages 5.16 through 5.18.
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Intraosseous Infusion

iStan has three intraosseous (I/O) sites, one at the sternum and one on each tibia, 
where the patient can be infused.

To prime the tibia and sternal I/O sites, 

Using the 60cc syringe, inject 30cc of distilled water into the Jugular IV port. 1.	

Carefully roll up the thigh skin and roll down the leg skin or pull back the chest 2.	
skin covering the I/O port.

Pull the I/O insert from the I/O port until the priming tube can be accessed.3.	

Insert a syringe into the tube.4.	

Pull the plunger until fluid begins to flow. (Optionally, inject 15cc of distilled water 5.	
mixed with red food coloring to simulate the color of aspirated fluid.)

Replace the insert.6.	

Fluids can now be aspirated from a correctly applied intraosseous infusion.

For information regarding cleanup after using the IV/IO feature, see page 5.16.
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Monitoring Patients
The Waveform Display provides a visual reading of key cardiovascular parameters. The 
display can be customized to suit the needs of a given scenario.

Waveform Display Parameters

There are eight parameters available that may be displayed as waveforms. When the 
waveforms for one or more ECG leads are displayed, the Heart Rate appears to the 
right of first ECG lead. The Pulse Oximetry Plethysmogram waveform appears with 
the SpO2 reading to the right. Arterial Blood Pressure, Central Venous Pressure and 
Pulmonary Artery Pressure display both a waveform and a numeric value. An additional 
12 parameters may have their numeric values displayed. 

Waveform Display Parameters

Patient Parameter Label Waveform Numeric
ECG Leads I, II, III, V ECG I, II, III, V √ Heart Rate

Pulse Oximetry Plethysmogram Pleth √ SpO2

Arterial Blood Pressure ABP √ √

Central Venous Pressure CVP √ √

Pulmonary Artery Pressure PAP √ √

Pulmonary Capillary Wedge Pressure PCWP √

Thermodilution Cardiac Output Thermodilution C.O. √

Pulse/Heart Rate Pulse √

Mean Arterial Pressure MAP √

SpO2 SpO2 √

Continuous Cardiac Output Continuous C.O. √

Blood Temperature Blood Temperature √

Body Temperature Body Temperature √

Rectal Temperature Rectal Temperature √

Axial Temperature Axial Temperature √

Noninvasive Blood Pressure NIBP √

Intracranial Pressure ICP √
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Accessing the Waveform Display

If the (Optional) Waveform Display Monitor, or another monitoring device, has been 
correctly powered on (see page 2.8), the Waveform Display software automatically 
launches with the HPS6 software when login is completed for the Instructor Workstation 
(see page 3.1). However, if the Waveform Display application has been closed or is not 
running, open the application by clicking on the Waveform Display icon located on the 
Dock.

Waveform Display Icon

When the Waveform Display opens, a blank screen appears and the Waveform Display 
menu is shown at the top of the window.

The Waveform Display with No Patient Selected

Beneath the menu bar, No Patient Selected should appear in the Waveform Display 
title bar. If No Simulator Selected appears, select the simulator from the Simulators 
menu.

Selecting a Simulator

The Waveform 
Display icon

The Waveform 
Display title bar

The Waveform 
Display menu bar
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In most cases, only one simulator will be available.Once a simulator is chosen, select a 
patient from the Patients menu. 

Selecting a Patient  

The Patients menu contains a list of all patient files currently running. If no patient is 
running, open a patient file from the Patient Palette. 

The patient’s information is loaded and displayed on the Waveform Display Monitor.

The Waveform Display with Patient Information

In the Waveform Display window, the patient’s file name and ID number appears in 
the Title bar at the top while the status bar at the bottom contains the simulator’s 
identification, the patient’s name, and the active waveform layout.

To change the patient, select a new name from the Patients menu.

NOTE: By default, the option Automatically switch to Patient on Mannequin is 
selected. When this option is chosen and multiple patients are running, the waveform 
software automatically reflects the physiology of the active patient.

The title bar displays the 
patient name and ID number

the patient’s name

and the Waveform layout

The status bar 
displays the simulator 

name (or number)
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Modifying the Waveform Display

The default configuration can be modified to change or customize the layout, suspend 
or reset alarms and change or mute the audio. 

Viewing NIBP

Initially, the NIBP panel appears with no (--- / ---) value. To take an isolated reading of 
the current, noninvasive blood pressure, select the NIBP option from the View menu.

 
Selecting NIBP to View

The NIBP reading appears in the NIBP panel and remains in view until another reading 
is taken.

Setting Up NIBP to Cycle

To schedule an NIBP reading at a set interval, select the NIBP Setup option from the 
View menu, and then choose a time interval. 

 

Selecting NIBP Setup

Once a time interval is selected, select the Start cycling option to begin the NIBP 
reading cycle.

Select NIBP Setup

Select Start cyclingChoose a time interval option
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If you wish a different time interval than those shown on the menu, select the Custom 
cycle period option to activate the NIBP Setup dialog, which provides fields for setting 
any whole number value in seconds, minutes or hours.

 
Customizing an NIBP Cycle Period

From the NIBP Setup command menu select the Stop cycling option to discontinue the 
timed readout and Start cycling to restart the timed process.

Enter a whole number in 
the NIBP Cycle Period field

Use the pull-down to 
select a time measurement

Click Set
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Changing the Layout

At any one time, the Waveform Display can show up to six waveforms plus an 
additional four numeric readouts.

There are five preconfigured METI Layouts:

EMS-ED-Telemetry - preconfigured with a waveform and numeric readout for 
ECG Lead II and numeric readouts for SpO2  and noninvasive blood pressure 
(NIBP).

ICU-OR Arterial Line Only - preconfigured with waveform and numeric readouts 
for ECG Lead II, ECG Lead V, ABP, Pleth and a numeric readout for Body 
Temperature.

ICU-OR No CVP - preconfigured with waveform and numeric readouts for 
ECG Lead II, ECG Lead V, ABP, PAP and Pleth, and numeric readouts for NIBP, 
Thermodilution C.O., Blood Temperature and Body Temperature. 

ICU-OR (default layout) - preconfigured with waveform and numeric readouts for 
ECG Lead II, ECG Lead V, ABP, PAP, CVP and Pleth, and numeric readouts for 
NIBP, Thermodilution  C.O., Blood Temperature and Body Temperature. 

Saturation-Pulse - preconfigured with numeric readouts for SpO2 and pulse.

Select the appropriate layout from the list located under the Layouts menu.

 
Selecting a Layout

Only the ICU-OR layout makes use of every parameter panel and the preconfigured 
layouts cannot be overwritten or changed, but any configuration of waveform/numeric 
and numeric values can be created by customizing the layout (see below).

When customized layouts are created, they appear in the Layouts menu beneath a 
Custom Layouts heading.
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Customizing the Layout

To customize the Waveform Display layout, select the Edit Custom Layouts option 
from the Layouts menu.

Selecting Edit Custom Layouts

The Waveform Display Layout Editor appears, displaying the current layout. This layout 
can then be modified by selecting waveform/numeric or numeric parameters for the 
various panels.

The Waveform Display Layout Editor

The Available Layouts appear on 
the right, including the Custom Layouts

A menu appears when 
one of the four Numeric 

panels is clicked

A menu appears when one of the six 
Waveform/Numeric panels is clicked
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To change the settings on a waveform/numeric panel (one of the top six panels):

Click the panel to edit. A menu with 10 options pops up.1.	

Select the appropriate menu option:2.	

Select one of the options.a.	

Select b.	 Blank if the display is to leave an unused space for the panel.

Select c.	 OFF if the display is to omit the panel, allowing additional space for 
the remaining waveform readouts. 

Use the slider bars to adjust the minimum and maximum ranges for the readings.3.	

Click the Palette icon to the right of the panel to open a window with a color 4.	
spectrum used to change the color of the waveform and numeric displays.

Click on the box on the far right to set the numerics to On or Off. (Waveform 5.	
parameters set to the OFF position have numerics set to Off by default.)

To change the settings on a numeric panel (one of the bottom four panels):

Click the panel to edit. A menu with 19 options pops up.1.	

Select the appropriate option:2.	

Select one of the options.a.	

Select b.	 OFF if the display is to darken the panel, leaving the space empty. 

Click the Palette icon at the bottom of the panel to open a window with a color 3.	
spectrum used to change the color of the numeric display.

To clear changes, click the Reset to Defaults button on the lower right-hand side of the 
window.

When changes are complete, save the new layout. (See page 4.87). 

Changes are lost if the Waveform Display Layout Editor is closed without saving the 
new layout.
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Saving a Customized Layout

To save the new format once changes are complete:

Highlight the name in the 1.	 Layout Name field.

Enter the name of the new layout.2.	

Click the 3.	 Save Layout button.

The customized layout now appears listed among the Custom Layouts in the Available 
Layouts panel on the right. This layout also appears in the Layouts menu.

Once changes have been saved, click the Close button to close the Waveform Display 
Layout Editor. The Waveform Display now displays the newly saved customized layout. 

A Customized Layout for the Waveform Display

Deleting a Customized Layout

To delete a customized layout:

Select the layout from the list beneath 1.	 Custom Layouts in the Available Layouts 
panel. 

Click the 2.	 Delete Layout button.

The customized layout is deleted.

The new layout appears in the  
Available Layouts list beneath the 

Custom Layouts

Click Reset to Defaults to clear 
changes or delete the customized layout 
by selecting it from the list and clicking 

Delete Layout

Enter the new name in the Layout 
Name field
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Changing the Audio

The Waveform Display includes an audio feature with a choice of clinical monitoring 
sounds. To choose a setting, open the Edit menu and click Audio to access the sound 
options.

Selecting the Audio Menu

All settings are synchronized with the patient’s heartbeat.

There are five available audio settings:

Auto (default) - depending on the layout, sounds are selected in order of these 
parameters: Pleth (SpO2), ECG, and Art. If, for example, both Pleth and Art 
parameters are in the layout, the sounds related to the Pleth readout are heard. 
To hear the sounds of the Art readout when either the Pleth or ECG parameters 
are also present, the Art option must be chosen.

Pleth (SpO2) - pitch changes according to the value of the SpO2. When the SpO2 
value increases, the pitch becomes higher, and when the SpO2 value decreases, 
the pitch becomes lower. 

ECG - rate of sound reflects changes to the patient’s heart rate while maintaining 
a constant unvarying pitch unaffected by the patient’s condition.

Art - rate of sound reflects changes to the patient’s Arterial Blood Pressure 
(Art) while maintaining a constant unvarying pitch unaffected by the patient’s 
condition.

Mute - eliminates all sounds based on the patient’s heartbeat. Does not remove 
any alarms set to sound when minimum and maximum levels of the layout’s 
parameters are met.

Choose the appropriate sound from the Audio menu.
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Setting the Alarms

The Waveform Display includes an alarm feature that registers a two-tone (high-low) 
sound when patient parameter readings fall below or exceed a specified minimum or 
maximum setting. The alarm feature can be turned on (the default) or off by selecting 
the option from the Alarms menu located beneath Edit on the menu bar. 

When alarms have been suspended, a diamond appears to the left of the option 
showing that Suspend has been selected.

The Alarm settings can also be modified. To change the settings for the alarms, select 
the Alarm setup option from the Alarms menu.

Selecting the Alarm Setup

The Alarm Setup screen appears, displaying six parameters, three of which have 
pull-down menus.

The Alarm Setup Screen

  

Additional parameters are available 
using the pull-down menus.

Each parameter has a minimum and 
maximum setting to trigger the alarm
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Including the pull-down settings, there are 11 parameters that may be associated with 
an alarm. However, only six alarm settings (one for each of the primary parameters 
displayed in the window) are possible at one time.

Alarm Settings
Parameter Units Minimum Default 

Range
Maximum Alarm Sound

Heart Rate BPM 30 40 to 160 250 Two-Tone/ High-Low

ABP (Sys) mmHg -40 70 to 180 300 Two-Tone/ High-Low

ABP (Dia) mmHg -40 20 to 110 300 Two-Tone/ High-Low

PAP (Sys) mmHg -40 10 to 40 300 Two-Tone/ High-Low

PAP (Dia) mmHg -40 5 to 20 300 Two-Tone/ High-Low

CVP mmHg -40 0 to 15 300 Two-Tone/ High-Low

SpO2 % 50 90 to 100 100 Two-Tone/ High-Low

Temp (Blood) ºC 10 35 to 38 45 Two-Tone/ High-Low

Temp (Body) ºC 10 35 to 38 45 Two-Tone/ High-Low

Temp (Axial) ºC 10 35 to 38 45 Two-Tone/ High-Low

Temp (Rectal) ºC 10 35 to 38 45 Two-Tone/ High-Low

ICP mmHg -50 0 to 10 300 Two-Tone/ High-Low

NIBP (Sys) mmHg -40 70 to 180 300 Two-Tone/ High-Low

NIBP (Dia) mmHg -40 20 to 110 300 Two-Tone/ High-Low

To set an alarm:

Check the box to the left of the parameter. 1.	

Choose an option from the pull-down menu, if available.2.	

Use the slider bar to set the maximum and minimum levels.3.	

Click the 4.	 OK button.

To turn off a specific parameter’s alarm, uncheck the box to left of that parameter and 
click OK.

To undo any changes, click the Restore Defaults button.
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iStan Care and Maintenance
Maintaining iStan requires careful treatment of the electronic and mechanical 
components. Each time iStan is assembled or disassembled, make sure all components 
are properly handled and either removed from or placed into storage correctly.

iStan Warranty Programs
General Information

METI patient simulator products come with a one-year Manufacturer’s Warranty 
(excluding batteries and consumables). All warranties begin at date of shipment or METI 
installation. You may upgrade your first year Warranty to an Enhanced Warranty and 
receive remedial and planned maintenance. To prevent equipment downtime and delays 
after your warranty expires, we encourage you to contract for extended maintenance 
services for all subsequent years.

Units Out of Agreement

For units no longer under warranty requiring repairs, the Time and Materials service plan 
will apply (see Time and Materials section).

To place an out-of-warranty unit under a warranty contract, METI reserves the right to 
have the patient simulator inspected by a METI-approved technician at the customer’s 
expense. If necessary, the unit would have to be repaired at the customer’s expense 
prior to issuance of a warranty contract.

The repairs required, as the result of the examination, will be quoted on a time and 
material basis.

How to Contact Customer Support

United States Office: 
Toll Free		 +1 (866) 462-7920 
Direct		  +1 (941) 342-5605 
Fax		  +1 (941) 342-5600 
Internet Address:	support@meti.com 
Web URL:	 www.meti.com

European Office: 
Phone 		  +49 (0) 6131 38075 20 
Fax		  +49 (0) 6131 38075 49 
Internet Address:	international.support@meti.com

Australian Office: 
Toll Free		 +1 (800) 656 434 
Fax		  +6173 34970 91 
Internet Address:	australia.support@meti.com

Canadian Office: 
Phone		  +1 (888) 516-9199 
Internet Address:	canada.support@meti.com

United Kingdom: 
Phone:		  +44 (0) 8009 171851 
Internet Address:	uk.support@meti.com
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Service Hours

The principal period for performance of service is:

United States Office: 
Monday through Friday 
7:00 A.M. to 6:00 P.M., Eastern Standard Time

European Office: 
Monday through Friday 
8:00 A.M. to 5:00 P.M., Central European Time

Canadian Office: 
Monday through Friday 
8:00 A.M. to 5:00 P.M., Mountain Standard Time

Australian Office: 
Monday through Friday 
8:00 A.M. to 5:00 P.M., Australian Eastern Standard Time

Holiday and non-business days are excluded.

Contract Period

Warranty contracts are not ordinarily offered for periods of less than one year. However,                 
multiple-year warranty contracts may be arranged for up to an additional three years. 
Discounts are available for purchase of multiple year contracts.

Limitations of Agreement

Your exclusive remedy for any defective patient simulator is limited to the repair or 
replacement of the defective patient simulator. 

METI may elect which remedy or combination of remedies to provide at its sole 
discretion. METI shall have a reasonable time after determining that a defective material 
exists to repair or replace defective material. METI's replacement material will be 
manufactured from new and/or serviceable parts. METI's agreement applies to repaired 
or replaced materials for the balance of the applicable period of the original warranty or 
ninety days from the date of shipment of a repaired or replaced material, whichever is 
longer. METI warrants its LABOR for 30 days or the balance at the applicable period of 
the original warranty, whichever is greater.

METI shall not be liable under this warranty for incidental or consequential damages, or 
in the event of any unauthorized repairs or modifications have been made or attempted, 
or when the product, or any part thereof, has been damaged by accident, misuse or 
abuse. This warranty does not cover normal wear and tear, staining, discoloration or 
other cosmetic irregularities that do not impede or degrade product performance. Any 
damage or malfunction as a result of the installation of software or hardware, not  
authorized by METI, will be repaired under the Time and Materials service plan (see 
Time and Materials section).

METI's warranty does not cover products that have been received improperly 
packaged, altered or physically damaged. Products will be inspected upon receipt.

Some states in the USA do not allow the exclusion or limitations of incidental or 
consequential damages, so the limitations above may not apply to you. This warranty 
gives you specific legal rights and you may also have other rights, which vary from state 
to state.
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Return Materials Authorization (RMA)

No product may be returned directly to METI without first contacting METI for an RMA 
number. If it is determined that the product may be defective, you will be given an RMA 
number and instructions for product return. An unauthorized return, e.g., one for which 
an RMA number has not been issued, will be returned at your expense. Authorized 
shipments are to be shipped prepaid to the address on the RMA. Your original box and 
packaging materials should be kept for storing or shipping your product. To request an 
RMA, please contact Customer Service.
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System Software Upgrade Support
Customers with current warranty contracts are entitled to receive upgrades to 
applications software previously purchased. Installation of the system software is the 
user’s responsibility.

The System Software Upgrades Support includes software upgrades for base software 
and purchased optional software modules.

**This does not apply for major upgrades or technological enhancements.**

Pricing Structure
Time and Materials

For those systems not under agreement, service will be provided as required on a Time 
and Material basis:

Description In-House On-Site

Technical Support As quoted at time of repair
METI’s prevailing labor rate 
with a minimum of four 
hours labor

Material As quoted at time of repair As quoted at time of repair

Travel N/A
Priced at METI’s fully  
burdened cost plus fee

Principal period of on-site support is:

Monday through Friday, 7:00 AM to 7:00 PM (Eastern Standard Time)•	

Holiday and non-business days excluded•	

Support outside the principle period is billed at the premium rate (hourly rate x 1.5)•	

A minimum of 48 hours notice is required for scheduling an on-site support call. Urgent 
on-site support with less that 48 hours notice will be charged at the premium hourly 
rate.

On-site time is described as the time period commencing from arrival at customer site 
through departure from customer site.
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Breakdown Steps

Breakdown
After each use, iStan should be properly disassembled and stored in a secure place. 
To ensure that iStan remains in good working condition, follow the prescribed METI 
breakdown procedures below. These procedures are estimated to take less than 30 
minutes.

Step 1: Shut Down the Software

To shut down both the Waveform Display and HPS6 software:

In the HPS6 software, Click the 1.	 Disconnect icon on the Patient window (see 
page 3.14 for more information on the Connection Icons).

From the Waveform Display software, select 2.	 Quit Waveform Display from the 
Waveform Display menu.

If desired, click 3.	 Save to save the patient file (see page 3.7 for information on the 
Save icon or page 3.22 to learn about Saving Data).

From the HPS6 software, click the 4.	 Stop icon in the Patient window or Patient 
Palette (see page 3.7 for information on using the Stop icon). A warning box 
appears providing another opportunity to Save the patient file.

Select5.	  Quit HPS.

If using a Wireless Remote Control, quit the HPS6 application using the same steps 
described above for the Instructor Workstation. 

Step 2: Power Off the Simulator

Carefully pull pack the skin on iStan’s left hip and flip the power switch to the 1.	
OFF position.

Carefully pull the skin back into place for storage.2.	

Step 3: Clean the Simulator and the Fluid System

For detailed instructions on cleaning, see page 5.12 below.

1

2

Shut Down the Software

Power Off the Simulator

3 Clean the Simulator and the Fluid System
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Maintenance Advice
Simple care and maintenance helps to ensure that iStan stays in good working 
condition. Many problems are caused by inadequate or improper maintenance. Perform 
a thorough check of the various components each time the simulator is used.

General Simulator Care

Avoid the use of writing instruments and sharp objects near the patient simulator to •	
prevent unattractive markings on or tears in the skin.

Lubricate airway adjuncts, urinary catheters and chest tubes with silicone spray •	
(and NOT a water-based lubricant) prior to insertion. 

A mild detergent and warm water will remove most marks and stains. Gently rub the •	
soiled area with a soft cloth. Do NOT use ABRASIVE soaps or pads.

Prior to using moulage of any kind, METI suggests the application of a very light •	
coating of petroleum jelly, followed by a light dusting of baby powder to the  
simulator’s skin. This application makes cleaning the skin easier.

If any of the trauma, genitourinary or IV features of the iStan system have been •	
used, flush out the simulator as described in the following pages. Failure to flush the 
systems may cause problems for the system during attempts at future use.

Storage

When in regular use, iStan’s breakdown procedure and general cleanup should be 
sufficient to prepare the simulator for storage.

In addition, be certain to follow these instructions:

Storage temperature should not exceed 122 F (50 C) or fall below 41 F (5 C).•	

If a soft-sided simulator case is being used, the simulator should lay flat.•	

The simulator should NEVER be stored or shipped with fluids in the system.•	

METI also recommends storing the simulator with a cervical collar in place to protect 
the neck.

Care of Electronic Equipment

Do NOT use any of the computer components associated with this system for any •	
other use.

Do NOT connect the computer components to any network of any kind.•	

Install any METI software updates as soon as they become available.•	
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Airway Inspection

iStan is equipped with an anatomically accurate airway that supports the practice of 
difficult airway management techniques. In the process of performing these techniques 
improperly or aggressively, the upper airway can be damaged. While such damage may 
be readily apparent (manifested as a leak in the breathing circuit) during connection to a 
ventilator, it may not be obvious during spontaneous or bag and mask ventilation.

Because damage can occur, occasional visual inspection of the airway is 
recommended. Using the light of a laryngoscope blade or a flashlight, visually 
examine both the upper and lower airway. While tears in the upper airway resulting 
from intubation may be obvious, needle holes in the lower bronchus resulting from 
techniques such as transtracheal jet ventilation may not be readily apparent.  

If damage to the airway is found, small cuts or tears may be reparable. However, for 
permanent repair of damaged simulators contact METI Customer Support.

Recharging the Battery

The battery should be recharged after approximately seven to eight hours. The iStan 
battery will NOT charge while the unit is in operation. 

To recharge the battery, connect the power adapter to the receptacle inside the skin on 
iStan’s left hip. Note that the power adapter connection is keyed. Care must be taken 
so that the adapter is properly oriented (the flat side of the connector is on top) when 
the connection is made.

Recharging should take approximately five hours.
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Replacing the Battery

BE CERTAIN iStan’s power ON/OFF switch located in iStan’s left hip is in the OFF a.	
position.

Position iStan so that the battery compartment located in iStan’s lower lumbar b.	
region is accessible. 

Lift the top layer of skin from the waist up to mid-torso and remove the lower c.	
lumbar foam piece covering the compartment panel. 

Remove the panel to the battery compartment by loosening the thumbscrew d.	
hardware by hand.

One by one, carefully lay in each battery pack, connecting each one to the e.	
nearest battery pack input cable. The color of the battery pack cable wires should 
match those of the input connector.

Refasten the battery compartment cover, tightening the thumbscrews.f.	

Return the lumbar foam piece to its original location.g.	

Carefully pull the top skin layer back into place.h.	

Plug in the external 20VDC, 150W AC/DC power supply into the nearest AC i.	
outlet. The fast-charge process lasts four to six hours and can only be done while 
iStan is powered down and the external power supply is plugged in. 
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Reducing Cervical Motion

To reduce cervical motion:

Remove the neck skin and pull the skin at the back of the head toward the front 1.	
to expose the neck from the rear.

Locate the neck joint at the base of the skull.2.	

Locate the steel cable attached to the back of the skull.3.	

Locate the U-shaped plate at the end of the cable.4.	

Slide the U-shaped plate onto the neck joint.5.	
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Draining Condensation from the Simulator

As part of a regular preventative maintenance schedule, condensation should be 
drained from the simulator. 

Depending on environmental conditions, moisture may condense inside the 
compressed air lines and tanks within the simulator. It is recommended that this fluid be 
drained every 40 hours of operation. In outside, high humidity conditions, the system 
should be drained more frequently. 

To drain condsnsation:

Locate the Condensation Drain Hose included with the inventory kit. 1.	

Bring the hose and a small bucket to the simulator location.2.	

Separate the skin on the left side of the simulator at the hip to reveal a hose with 3.	
the appropriate gray connector mate.  Bring to the outside for use in later steps.

With help from assistants, place iSTAN into a sitting position.  (A 45-degree angle 4.	
is fine.)

Turn iSTAN on, but do not start the application.  Give enough time for the internal 5.	
compressor to pressurize the system. (The pump will turn off automatically.)

Turn iSTAN off. 6.	

Place the tubing end of the Condensation Drain Hose into the small bucket and 7.	
then connect the gray fitting onto the simulators drain connector with a push 
and twist motion. There will be a sudden release of pressure into the bucket. Any 
condensation within the system will drain with this exhaust.

Disconnect the Condensation Drain Hose from the simulator. 8.	
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Connecting the Air Hose

The air hose can be connected to or disconnected from iStan at any time. When the 
external air pressure is sensed, the pump internal to iStan will turn off automatically.  
When you want to make iStan mobile again, simply disconnect the hose. 

The optional External Air kit (see page 1.12) consists of a flexible 30ft (9m) hose 
attached to a preset air regulator and a fitting for air compressors and adapters for wall 
or tank air.

To connect the air hose:

Connect the external air kit to a METI compressor using the Quick Coupler 1.	
attached to the regulator. (Other compressed air sources will have their own 
adapters. Locate the adapter for your compressed air source.)

Separate the skin on the left side of the simulator at the hip to reveal a hose 2.	
with the appropriate gray connector mate. Bring this hose to the outside for 
connection to the air hose.

Mate the gray connectors with a push and twist motion.3.	
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Cleaning the Simulator and the Fluid System
NOTE: A small bucket is recommended to collect wastewater during cleaning and 
flushing operations. 

Cleaning and Flushing after Use of Hemorrhage

To clean simulated blood from the simulator and fluid system:

Remove any wound haptic(s) from the wound umbilical(s) and rinse with distilled 1.	
water. 

Wipe the simulator off immediately to remove red fluid. The food color will stain 2.	
more readily if left on for an extended period.

Connect the blue and yellow connectors of an empty Trauma Fill Tank to the blue 3.	
“fill” and yellow “vent” connectors on the right side of the simulator.

Disconnect the Overfill Bottle from the Trauma Fill Tank. 4.	

Using a haptic tube from the Inventory Kit, connect the haptic tube to the Overfill 5.	
Bottle port on the Trauma Fill Tank. 

Place the other end of the haptic tube into an empty bucket to collect the 6.	
wastewater. 

Select the7.	  Bleeding: Flush parameter under the Trauma menu of the Condition 
tab and click Enabled. This setting turns on all valves to maximize the flow of the 
remaining blood mixture into the Trauma Fill Tank.

Bleeding: Flush
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Pressurize the Trauma Fill Tank by pumping no more than 20 times.8.	

Connect the wound umbilical(s) to the bleeding site(s) that were used, keeping 9.	
the ends in the wastewater bucket.

When fluid stops flowing, select the 10.	 Disabled setting on the Bleeding: Flush 
parameter.

Disconnect the blue and yellow lines of the Trauma Fill Tank from the simulator.11.	

Rinse the Trauma Fill Tank thoroughly with distilled water.12.	

Using a Trauma Fill Tank with clear, distilled water, pump the distilled water into 13.	
the simulator.

Repeat steps 1-13 until waters flows clear. 14.	

Optional15.	 : To clean lines to head, from the Condition Tab, under Assessment, 
select Secretion: Ears (Nose and Mouth) and click Blood. 

Optional16.	 : To flush the chest tube lines, with a chest or priming tube in place and 
an empty bucket to catch fluid, from the Condition Tab, under Trauma, select 
Chest Tube Enable and click Prime. 

Cleaning and Flushing after Blood Secretions

To clean simulated blood from the simulator and fluid system:

Wipe the simulator off immediately to remove red fluid. The food color will stain 1.	
more readily if left on for an extended period.

Connect the Trauma Fill Tank containing the red fluid to the blue “fill” connector 2.	
on the right side, but do not connect the yellow “vent” connection.

Turn the yellow pressure relief knob clockwise (open) on the Trauma Fill Tank. 3.	
Alternatively, loosen the Trauma Fill Tank lid so that the tank is able to vent during  
the subsequent process.

Select the 4.	 Bleeding: Flush parameter under the Trauma menu of the Condition 
tab and click Enabled. This setting turns on all valves to maximize the flow of the 
remaining blood mixture into the Trauma Fill Tank.

When fluid stops flowing, select the 5.	 Disabled setting on the Bleeding: Flush 
parameter.

Disconnect the Trauma Fill Tank from the simulator.6.	

Rinse the Trauma Fill Tank thoroughly.7.	

Pour approximately 16 ounces (the size of the Overfill Bottle) of clean distilled 8.	
water into the tank.
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Pump the distilled water into the simulator.9.	

If a chest tube was used, flush that system by selecting 10.	 Chest Tube Enable from 
the Trauma menu on the Condition tab and click Enable.

Place a chest catheter in each side until the distilled water runs clear.11.	

If red fluids were used as blood with head secretions, select the 12.	 Secretion: Ears 
(Mouth and Nose) parameter from the Trauma menu on the Condition tab and 
click Blood.

Run until the distilled water runs clear.13.	

If fluid remains in the system, reconnect the Trauma Fill Tank containing the red 14.	
fluid to the blue “fill” connector on the right side, being sure not to connect the 
yellow “vent” connection.

Turn the yellow pressure relief knob clockwise (open) on the Trauma Fill Tank. 15.	

Select the 16.	 Bleeding: Flush parameter under the Trauma menu of the Condition 
tab and click Enabled.

NOTE: Once a month, it is advised to flush the system with a 50/50 mix of 
distilled water and white vinegar to keep mineral and algae build up to a 
minimum. Always flush with distilled water to remove any trace amounts 
of vinegar.

Cleaning and Flushing after Clear Secretions

Dry off the simulator.1.	

Connect the blue and yellow connectors of an empty Trauma Fill Tank to the blue 2.	
“fill” and yellow “vent” connectors on the right side of the simulator.

Disconnect the Overfill Bottle from the Trauma Fill Tank. 3.	

Using a haptic tube from the Inventory Kit, connect the haptic tube to the Overfill 4.	
Bottle port on the Trauma Fill Tank. 

Place the other end of the haptic tube into an empty bucket to collect the 5.	
wastewater. 

Pressurize the Trauma Fill Tank by pumping no more than 20 times.6.	

When the fluid stops flowing, disconnect the blue and yellow lines of the Trauma 7.	
Fill Tank from the simulator.
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NOTE: Once a month, it is advised to flush the system with a 50/50 mix of 
distilled water and white vinegar to keep mineral and algae build up to a 
minimum. Always flush with distilled water to remove any trace amounts 
of vinegar.

Flushing the Fluid System for Storage

When storing iStan for substantial periods of time, make certain that all moisture has 
been removed from the system.

After draining the reservoirs, flush the system with air using the following steps:

Connect a clean and dry Trauma Fill Tank to both the yellow and blue connectors 1.	
on the right side.

Unlock the Trauma Fill Tank’s handle and stroke up and down 25 to 35 times to 2.	
pressurize the tank. This pressure air is transported to the on-board reservoir. 

Lock the pump handle back into the pump assembly by turning clockwise.3.	

After approximately one minute, disconnect the Trauma Fill Tank.4.	

Connect a clean and dry Trauma Fill Tank to both the yellow and blue connectors 5.	
on the left side.

Unlock the Trauma Fill Tank’s handle and stroke up and down 25 to 35 times to 6.	
pressurize the tank. This pressure air is transported to the on-board reservoir. 

Lock the pump handle back into the pump assembly by turning clockwise.7.	

After approximately one minute, disconnect the Trauma Fill Tank.8.	

If a chest tube was used, flush that system by selecting 9.	 Chest Tube Enable from 
the Trauma menu on the Condition tab and click Prime.

Place a chest catheter in each side until no distilled water runs out.10.	

If red fluids were used as blood with head secretions, select the 11.	 Secretion: Ears 
(Mouth and Nose) parameter from the Trauma menu on the Condition tab and 
click Blood.

Continue until no distilled water runs out.12.	

If Hemorrhage bleeding was used, select the 13.	 Bleeding: Flush parameter under 
the Trauma menu of the Condition tab and click Enabled, then connect the 
wound umbilical to each location until no distilled water runs out.
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Flushing the ICP System
To flush all fluid from the ICP system:

Connect the ICP Fluid Adapter to the simulator’s head.  1.	

Temporarily connect this hose to an empty IV bag line to capture fluid during this 2.	
set-up stage.  

Select 3.	 ICP Override from the list of Parameters located under the ICP menu on 
the Condition tab.

Set the value to the maximum mmHg.  Air bubbles and/or fluid will exit from ICP 4.	
reservoir, through the tube and into the container.  

When bubbles and/or fluid stops, select 5.	 ICP Override.

Set the value to 0 mmHg.6.	

Remove the ICP Fluid Adapter from iStan’s head and shut down the system.7.	

Flushing the IV/IO System
To purge fluid from the IV/IO system:

Connect an external empty 1.0L IV bag to the Drain Port. 1.	

Connect a 60cc syringe to IV Source Port and withdraw all fluid.2.	

Slowly push 2 @ 60cc of air into the IV Source Port. Replace the cap.3.	

Slowly push 60cc of air into Jugular IV Port. Replace the cap.4.	

Slowly push 60cc of air into Sternum IO Prime Port. Replace the cap.5.	

Slowly push 30cc of air into Femoral IV Port. Replace the cap.6.	

Slowly push 30cc of air into Left Tibial IO Prime Port. Replace the cap.7.	

Slowly push 30cc of air into Right Tibial IO Prime Port. Replace the cap.8.	

Evacuate all remaining air from the IV Source Port. Replace the cap.9.	

Disconnect the external IV Bag and evacuate all remaining air or fluids from the IV 10.	
Drain Port using a 60cc syringe. Replace the cap.
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IV Arm Kit
Over time, the IV arm will become worn and the skin or veins may need to be replaced 
using the contents of the IV Arm Kit included in the mannequin Replacement Kit.

To replace the skin:

Remove the used skin.1.	

Sprinkle talcum powder from the packet enclosed with the IV Arm Kit into the 2.	
interior of the new skin.

Shake out the excess powder and slide the new skin over the hand. Pull it into 3.	
place over the arm.

Palpate the veins to make sure they are positioned in the channel on the arm and 4.	
hand.
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To replace the veins:

Pull down the skin of the arm.1.	

Remove the section of tubing that needs to be replaced by cutting the tubing 2.	
on each side of the affected area. Leave at least 1” (2.5 cm) of the vein 
extending from the molded arm to ensure enough material in which to install butt 
connectors.

Insert one of the supplied butt connectors into each of the ends of tubing.3.	

Retrieve a new piece of tubing from the Replacement Kit, cutting it to the same 4.	
length as the piece you are replacing.

Install the new section by lubricating the butt connectors and sliding the new vein 5.	
all the way over the connectors. Be sure the tubing is applied all the way onto the 
connectors on both ends of the replacement section of tubing.

Replace the skin over the mannequin’s arm. 6.	
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Cleaning the Trauma Fill Tank and the Umbilical
To prolong the life of the Trauma Fill Tank assembly and the fluid reservoirs, wash and 
flush the tank and connections after each use with clean distilled water.

NOTE: A small bucket is recommended to collect wastewater during cleaning and 
flushing operations.

Do NOT store liquids in the Trauma Fill Tank. If simulated blood mixtures are stored in 
the tank, they may clog the system when they dry and possibly damage seals, filter and 
other components.

Remove and rinse the Overflow Bottle.1.	

Remove and rinse the pump assembly.2.	

Rinse the tank to remove all traces of the simulated blood.3.	

Pour 480 ml (16 oz) of distilled water into the tank and reinstall the pump 4.	
assembly. (The Overflow Bottle holds 16 ounces.)

Place the Overflow Bottle lid with umbilical attached into the wastewater bucket.5.	

Attach the fill (blue-labeled) and vent (yellow-labeled) fittings together at the other 6.	
end of the umbilical.

Pump the tank 25 times while making sure the wastewater is going into the 7.	
bucket.

Allow the tank to empty completely (the remaining air pressure will purge the fluid 8.	
from the lines.

Reinstall the lid onto the Overflow Bottle and place the bottle back onto the tank 9.	
assembly.

Remove the pump assembly and pour any remaining fluid out of the tank. Then, 10.	
reinstall the pump.

Disconnect the fill and vent fittings from each other and wrap the Trauma Tank 11.	
Umbilical around the neck of the tank.

Always depressurize the tank, remove trauma fluid and clean the tank before performing 
maintenance. The pump assembly may need periodic lubrication. Call METI Customer 
Support for details if the pump loses the ability to create pressure, squeaks loudly or is 
difficult to move. 
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Cleaning the In-Line Filter

To clean the In-line filter:

Disconnect the umbilical from the Overflow Bottle lid.1.	

Using two 3/4” (or adjustable) wrenches, separate the halves of the filter by 2.	
holding the top nut (end towards tank) stable and turning the bottom. Be sure to 
capture the spring as the halves are separated.

Remove the filter element from the female half by placing a screwdriver between 3.	
the top edge of the filter element and the female housing and gently prying the 
filter. Once the filter breaks loose, do the same on the opposite side.  This should 
allow you to turn the housing over and have the filter element fall out.

Once the filter element is out, rinse the outside of the element, and then the 4.	
inside. Then, take a 60cc syringe filled with distilled water and shoot the water 
through the open end of the element, repeating this process five to six times. This 
will back-flush the filter element and dislodge any trapped particles.

Wipe down the filter spring with a soft, lint-free cloth.5.	

Place a paper towel or soft cloth on a hard surface. Tap the open end of the long 6.	
female filter housing on the hard surface to knock out any large debris.

While holding the female housing with the open end pointed downward, use the 7.	
syringe to shoot distilled water in the housing and rinse any remaining debris out, 
then wipe down the inside of housing with a soft, lint free cloth.

Pour approximately 16 ounces of clean distilled water into the Trauma Fill Tank.8.	

Aim the short hose with the male fitting toward a wastewater bucket and 9.	
pump one time. This should flush the hose and the male fitting clear of any         
remaining debris. Stop the flow by turning the pressure relief valve.

Wipe down the inside of the male filter housing.10.	
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While holding the female housing with the open end up, place the filter          11.	
element with the open end down into the housing, Using the tip of your finger, or 
a small, soft instrument (e.g. the eraser end of a pencil), to gently apply pressure 
to the filter element and push into place.

Place spring into housing.12.	

Screw the two halves together hand tight, and then use the two wrenches to 13.	
tighten the connection.

Pump ten times to verify that the filter assembly has no leaks.14.	

Place the Overflow Bottle lid with umbilical attached into the wastewater bucket.15.	

Attach the blue and yellow connectors together at the other end of the      16.	
umbilical. This will flush the umbilical and wash any debris out.
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Troubleshooting the Trauma Fill Tank

Before making any repairs, ALWAYS depressurize the tank, remove all trauma solution 
and clean the tank.

Problem Cause Solution
Tank can be pressurized, but 
only air comes out.

Siphon tube has detached from 
insert.

Remove hose from tank and 
reinsert siphon tube.

Pressure does not buildup. 
No fluid is transported to 
simulator.

(1) �Pump assembly not sealed 
tightly into tank or

(2) Damaged pump cylinder 	
	 gasket or o-ring.
(3) Tank pressure relief valve is 	
	 set to “open.”

(1) Thoroughly clean pump  
cylinder gasket or o-ring and 
surrounding area and apply a 
light coating of silicone to pump 
gasket or o-ring.
(2) Contact METI for service.
(3) Turn valve until it returns to a 
“sealed” position.

Simulator fill time takes too 
long. (more than 5 minutes)

(1) Not enough strokes applied 	
	 to create pressure or 
(2) The In-line Filter is dirty or  
(3) The umbilical is  
	 disconnected at Overflow 	
	 Bottle or  
(4) Too much fluid in fill tank.

(1) Pump 25 to 35 times for best 
performance.

(2) Clean filter.
(3) Reconnect the overflow 

fitting.
(4) The Trauma Fill Tank works 

best with 1 gallon (3.6 liters) 
of fluid inside. If greater 
amounts of fluid are used, 
tank may require additional 
pumps as fluid is  
transported to simulator.
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Handling CO2 Canisters
Careful handling is required in the use of CO2 canisters. Please read and follow all 
appropriate cautions and warnings. 

For information on CO2 canister insertion, see page 2.11.

Removing CO2 Canisters from the Regulator

The following instructions will show you how to safely remove the CO2  canister from 
the regulator assembly for replacement or shipping.  

CAUTION: If unsure that CO2 canister is empty, eye and hand protection must be worn 
to protect from release of freezing gas or liquid.

Remove the CO1.	 2 regulator assembly from the simulator.

While holding the regulator assembly firmly, slowly unscrew the CO2.	 2 canister 
from the regulator. There is a small relief hole in the side of the regulator from 
which any remaining CO2 will bleed. If this should happen, no harm will be done 
to system, but it is rather noisy and the rapid release of CO2 gas can freeze the 
canister’s surface and frostbite unprotected skin.

Continue unscrewing the canister until it is free from the assembly.3.	

Important Canister Information

The 16 Gram CO2 Canister with threaded neck is available at most Sports Equipment 
Retailers - most often used for bicycle tire inflators. We recommend purchasing Leland 
brand canisters (P/N 82122Z), which are also available from METI.

Punctured canisters are considered to be empty. No residue remains in 
the canister after use. The steel used is a low carbon type, which will 
turn to rust quickly if disposed in a landfill. If your community requires 
recycling, then place with normal household recycling. 

CO2 Canisters are considered by the U.S. Department of Transportation 
to be “Other Regulated Materials - Domestic” (ORM-D). Ground 
shipping containers must be clearly marked with this label. CO2 
Canisters are considered hazardous material when offered for air 
transportation so different rules apply. Contact carrier for details and 
instructions.
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Related CAUTIONS/WARNINGS

CO
2
 Canister

Store the CO•	 2 canisters in a dry location between 32° and 104° F. (0 to 40°C)

Do not expose the CO•	 2 canister to heat above 140° F as rupture may occur.

Never point the CO•	 2 canister towards your face or someone nearby.

Use only METI specified CO•	 2 canisters.

CO
2
 Regulator Assembly

Care must always be taken when using high-pressure equipment.•	

Do not disassemble or alter regulator.•	

Dry completely if the regulator becomes wet.•	

Discontinue use of this equipment if leakage or visible damage is evident.•	

Use of Equipment

Canister end becomes punctured when screwed into regulator base and therefore •	
should not be removed until empty.

Unscrewing canister before it is empty will result in sudden release of all high-•	
pressure gas with a possibility of liquid CO2 spray.  Unprotected skin could receive 
freezing burns.

Wear protective gloves and eye protection when removing canister from regulator •	
assembly. 

Remove CO•	 2 canister from regulator assembly when shipping simulator. 
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Appendix A - Macintosh Fundamentals
The Macintosh desktop configured for the Instructor Workstation displays all the 
functionality needed to operate the HPS6 software. Applications can be accessed either 
by opening the Mac OS X window or by using the shortcuts assigned to the Dock.

Opening the Mac OS X Window
The icon for the Mac OS X system hard drive is located initially in the upper right corner 
of the desktop.

Clicking on this icon opens the window for the hard drive.

Selecting Applications in either the left or right panel displays the applications available 
on the hard drive.

The applications on the Instructor Workstation include those programs, such as Text 
Edit, which contain standard features that may be useful when working with the HPS6 
software.

Mac OS X Icon

Mac OS X Window

Available Applications

Click the icon to open 
the Mac OS X window

To view the applications 
on the Macintosh, select 
Applications in either the 

left or right panel
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Using the Dock
The Dock, initally located at the bottom of the desktop, displays shortcut icons to 
applications, open files that are currently minimized, and other items like the Finder and 
Trash Can.

To open or activate an item in the Dock, click the icon for that item.

To add an application to the Dock, locate the application on the hard drive, select the 
application and drag it (see Dragging below) to the Dock.

To remove an icon, click on that icon and drag it off the Dock.

The Finder

The Finder is always active and the Finder window can be accessed by clicking 
anywhere on the desktop or on the Finder icon in the Dock.

The Finder menu provides the tools for locating and managing files.

The HPS6 Launcher

To launch the HPS6 application, click the HPS6 Launcher icon located in the Dock. 
Once the software is loaded, the HPS menu bar appears at the top of the window 
indicating that the HPS6 application is running.

The HPS menu provides the basic functionality needed for opening and running the 
Patient software. Many of the options found on the menu are also located on the Patient 
Palette and the Patient window.

The Dock

Finder

Waveform Display

Trash Can

HPS Launcher

The Finder Menu

The HPS Menu
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Working with Windows
A window is the main, rectangular area in which application elements are displayed. 
The elements in a window vary from application to application. There is almost no limit 
to the number of windows that can be open on the desktop at one time, but only one 
window at a time is active. The active window appears at the uppermost level of the 
screen and the controls of the active window are enabled. The title bar displays the 
name of the file that the window represents.

Moving a Window

To move a window, click the window’s title bar and drag the window to the desired 
location (see Dragging below).

Using Window Controls

The Window Controls are comprised of three colored buttons located in the upper left 
corner of the window.

Click the green (+) Maximize button to enlarge the window.

Click the yellow (-) Minimize button to reduce the window and place it as an icon in the 
Dock. To return the window to the desktop in its original size, click on the icon.

Click the red (x) Close button to close the window.

NOTE: Windows can also be closed and minimized by using the Window menu located 
on the application’s menu bar.

An Inactive and Active Window

Window Controls

The Active Window

Window Title Bars
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Switching between Windows

To make a window active, click anywhere on an inactive window. The new active 
window moves to the foreground and title bar or the active window is highlighted. 
This action does not close any windows, but all other windows on the desktop remain 
inactive.

Dragging

To move an object on the screen, position the cursor over the object, press and hold the 
mouse button, move the object to the desired location and release the mouse button.

Scrolling

Windows that contain additional information that is out-of-view display scroll bars 
either along the right side or the bottom of the window. Moving the scroll box inside the 
scroll bar adjusts the view of the window’s contents. Clicking a scroll arrow moves the 
document one line while holding down the scroll arrow causes continuous scrolling.

Resizing

Windows can be sized to any available dimension on the screen by dragging the Size 
Box located on the bottom right corner of the window.

Window Features

Dragging
Scroll Arrows

Scroll Bar

Size Box
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Appendix B - Shortcut Keys
The keyboard can be used to access the functionality of many of the menu options 
available with the HPS software.

HPS Graphical User Interface (GUI) Shortcut Keys
The shortcut keys appear on the HPS menu beside their corresponding option with the           
command key (    ) and the shift key (    ) displayed by their symbols along with the 
character assigned as a shortcut. The option (or alt) key (    ) is also occasionally used. 
The table below summarizes the functionality available using these keys:

Command Shortcut Keys Functionality

Connect to Patient 
Model...

K
HPS Menu - Opens the Patient Models 
dialog that displays HPS models and their 
host identification numbers.

Hide HPS H
HPS Menu - Hides the HPS GUI from the 
desktop.

Quit HPS Q
HPS Menu - Quits the HPS software. 
(Patients should be stopped before quitting.)

New N Patient Menu - Opens a new patient.

Open... O

Patient Menu - Activates the Open 
navigational dialog, providing the user with 
the means to locate and select a patient from 
the system.

Save S Patient Menu - Save the active patient file.

Save As...        S
Patient Menu - Save the active patient file 
as a new filename.

Pause        U
Patient Menu - Pauses the Patient Time, 
freezing the simulation in its current state.

Fast Forward        F
Patient Menu - Advances the Patient 
Time, running the physiological model at 
approximately four times normal speed.

Print P
Patient Menu - Prints (or creates a PDF file) 
for the active tab view.

Detach Tab        T
Window Menu - Creates a separate window 
for the active tab.

Minimize Window M
Window Menu  - Creates a separate window 
for the active tab.

Close Window W
Window Menu  - Closes the active window, 
removing it from the desktop.

Show/Hide Logs Drawer L
Window Menu  - Opens or closes the Logs 
Drawer.
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HPS Text Shortcut Keys
Several shortcut keys have been provided for quick access to the functionality involved 
in the editing of the text used to create the patient’s history.

Command Shortcut Keys Functionality
Undo Z Edit Menu - Undo the last keystroke.

Redo      Z
Edit Menu  - Redo the last keystroke that 
was undone.

Cut X
Edit Menu - Remove the selected 
(highlighted) text.

Copy C
Edit Menu  - Copy the selected (highlighted) 
text to the clipboard.

Paste V
Edit Menu  - Paste the clipboard’s contents 
to the area selected by the cursor. 

Select All A
Edit Menu  - Select all the textual elements 
in the window.

Spelling ;
Edit Menu  - Locate the next text entry with           
questionable spelling.

Check Spelling        ; Edit Menu  - Open the spell check dialog.

Special Characters        F
Edit Menu  - Open the Character Palette for              
mathematical and other symbols.

Show Fonts T
Format Menu - Open the Font dialog with 
the list of available fonts and sizes.

Bold B Format Menu - Make the selected text bold.

Italic I Format Menu - Italicize the selected text.

Underline U
Format Menu - Underline the selected text.
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Scenario Shortcut Keys
Additional shortcut keys are provided for quick access to the functionality involved 
in creating and editing scenarios. All these options are located on the Scenario menu 
available under the Scenario tab.

Command Shortcut Keys Functionality
New       N Scenario Editor - Create a new scenario.

Open       O
Scenario Editor and Player - Open an 
existing scenario.

Close       W
Scenario Editor and Player - Close the 
current scenario.

Save       V Scenario Editor - Save the edited scenario.

New State       N
Scenario Editor - Create a new state in the 
edited    scenario.

New “Set” Event             S
Scenario Editor - Create a new Set event 
within a state of the edited scenario.

New “Bolus” Event             B
Scenario Editor - Create a new Bolus event 
within a state of the edited scenario.

New “Call” Event             C
Scenario Editor - Create a new Call event 
within a state of the edited scenario.

New “Go To” Event             G
Scenario Editor- Create a new Go To event 
within a state of the edited scenario.

New “Infustion” Event             U
Scenario Editor - Create a new Infusion 
event within a state of the edited scenario.

New “Multiply” Event              M
Scenario Editor - Create a new Multiply 
event within a state of the edited scenario.

New Transition              T
Scenario Editor - Create a new transition in 
the edited scenario.
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Useful Macintosh Windows Controls
Macintosh systems with Expose’ provide users with the means of opening and 
navigating between windows by using shortcut keys.

	 To see all open windows, hold down the F9 key.

	 To see all the windows open in the current application, hold down the F10 key.

	 To hide all the open windows to see the desktop, hold down the F11 key.

Point to a window to see its name, then click the window or press the Space bar to 
bring it to the front. Also use the arrow keys to highlight windows, or press Tab to cycle 
through open applications, displaying each application’s windows together.

If the function key (i.e. F9) does not open or hide the windows, hold down the Fn key 
and the function key
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Appendix C - Drug Integration
The drug responses created or modified with the Pharmacology Editor are integrated 
into the HPS software through the options available in the HPS menu located on the 
HPS menu bar.

From the HPS menu select the HPS Drug Responses command to open a pull-down 
menu with three options that provide the functionality for:

Modifying drug responses for all the patients in the HPS system

Modifying drug responses for a specific patient

Export a drug profile to the Pharmacology Editor for modification

When a new drug list is imported into the HPS software for either one patient or the 
whole system, the existing default drug file for the patient or the system is overwritten. 
Importing a new drug list for a specific patient, however, overwrites only any previously 
specified drug responses for that particular patient and not for the entire system.

Exporting Drug Profiles
Drug profiles can only be exported (saved) on the Instructor Workstation to a location 
on the HPS system by selecting the Export Pharmacology Editor Drug Profiles option 
from the HPS Drug Responses command menu.

A drug file must be exported from the HPS and used assigned as a default drug profile 
for the Pharmacology Editor to have a drug list when opened.

Selecting the Export Option

The Export System Drug Responses dialog opens with a field for naming the file to be 
exported (saved) and a navigational pull-down menu for finding the location where the 
file will be stored.
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Enter a name for the file in the Save As field and established a location in the Where 
field of the Export System Drug Responses dialog box.

The Export System Drug Responses Dialog Box

Click the Export button.

METI suggests that files stored on the Instructor Workstation be saved to the 
Documents folder. METI-created drug files have the following filenames:

	 Adult patients: 	 DRUG.MST

	 Pediatric patients: 	 DRUGY.MST

	 Infant patients: 	 DRUGI.MST

Note: The images above apply to a Mac OS 10.4 system. The navigational dialogs for 
previous       systems may have small visual differences.

Modifying System Drug Responses

No patient file should be running when the system drug responses are being modified.

To integrate a modified drug list into the HPS software system-wide, select the Modify 
System Drug Responses option from the HPS Drug Responses command menu.

Selecting Modify System Drug Responses

The Modify System Drug Responses dialog box appears.

Enter the file name in the Save As field.

Click Export.

Specify the location using the Where field.

Navigate using the pull-down menu.

Select Modify System Drug Responses 
from the HPS Drug Responses menu.
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The Modify System Drug Responses dialog box displays the path and file information 
for the HPS system’s existing drug file.

The Modify System Drug Responses Dialog Box

To locate the new drug file, click the Browse button to activate the Open navigational 
dialog box.

Navigating Using the Open Dialog Box

Use the Open dialog box to navigate to the directory where the new drug file is stored. 
Select the drug file and click the Open button to replace the drug file in the Modify 
System Drug Responses dialog box with the selected drug file.

In the Modify System Drug Responses dialog box, click Apply.

Navigate using the menu to 
locate the drug file.

Select the file and click Open.
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If a patient file is running, a warning box appears advising that the patient must be 
restarted for the new drug file’s settings to be active.

Click OK to close the box.

The modified drug file will be applied ONLY when the patient is restarted.

Opening a Patient File to Modify the Drug Response

The specific patient file should not be running when that patient’s drug responses are 
being modified. 

Note: This option is only available on the Instructor Workstation. 

To change the drug response for a specific patient, select the Open Patient for 
modification option from the HPS Drug Responses menu.

The Open patient navigational directory appears.

Locate the patient file by navigating the directory. Select the file and click the Open 
button.

The Modify System Drug Responses Warning Box

Selecting Open Patient For Modification

Locating the Patient File

Use the directory icons to navigate 
to the patient file that is to be modified.

Select the patient file and click Open.
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The Patient Drug Response Editor appears, displaying the name of the patient, the 
patient file path and a field for the new drug response profile.

To establish or change the patient’s specific drug responses, locate and enter the 
appropriate drug file into the Patient drug response profile field by clicking the 
Browse button.

The Select drug response modifications dialog appears, displaying the navigational 
windows needed to locate and select the desired drug file.

Select the drug file and double-click or click the Select button.

The Patient Drug Response Editor

Locating the Drug File

Select the drug file and click Select.

Use the directory icons to navigate 
to the appropriate drug file.

The patient’s name appears above 
the path to the patient’s file name.

Click Browse to locate the new drug file.
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The Patient Drug Response Editor now displays the drug file and its path.

Click the Save icon to set the drug response profile to the selected drug file.

The Save successful notice appears on the Editor and the new drug file name replaces 
the file path in the Patient drug response profile field.

The Patient drug response profile can be cleared by clicking the Clear button. To return 
a cleared file name, click the Reset icon.

Close the Patient Drug Response Editor by clicking the red close button in the upper-
lefthand  corner.

If the patient whose drug response is being modified is running, a warning box appears            
reminding that drug changes cannot take effect until that patient is restarted.

Click OK to close the warning box. Stop and restart all instances of the patient to use 
the newly selected drug profile.

Path to New Drug File

Click the Save icon.

The drug file path appears in the 
Patient drug response profile field.

The new drug file appears in the 
Patient drug response profile field.

The Save successful notice appears.

Patient Drug Response Profile Saved

Patient Drug Response Profile Saved
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Using the Pharmacology Editor
To launch the Pharmacology Editor, double-click on the Pharmacology Editor icon. The 
icon may initially (for Mac installations) be located in the HPS folder. If desired, drag the 
icon to the desktop or to the dock for future access.

The application opens, initially displaying the Drug List dialog box with an unspecified 
drug list.

Unless a default drug file has been established, the “untitled” drug list is empty. Once a 
default drug file is set up, that list will be shown when the Drug List appears. 

The Pharmacology Editor Icon

Double-click on the 
Pharmacology Editor icon

When the application opens, 
the Drug List is not specified.

The Drug List (Prior to File Selection)

The first time the application is opened, 
the Drug List list box is empty.

METI recommends that the HPS system drug MST file (profile) be used as the default 
drug file. Before using the system drug profile, the MST file must be exported to a 
location on the hard drive where the Pharmacology Editor can access the profile. METI 
suggests using the Documents folder on the Mac or the My Documents folder on a PC 
to store the default drug MST file. 
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Setting a Default Drug File

When the Pharmacology Editor is initially launched, no default drug file has been 
established. A Set Default Drug File dialog box automatically appears.

Click Yes on the Set Default Drug File dialog to activate the Preference dialog.

Select the Default Drug File is set to box to activate the field below and the Change 
button.

Select the Show Tool Tips box to have ToolTips displayed when the cursor is over an 
icon.

The Open dialog appears, displaying the navigational tools needed to locate the drug 
file.

Locate the drug file using the navigational pull-down, then double-click on the filename 
or select the file and click the Open button. Note that the drug file has a suffix of MST.

The path to the drug file appears in the Default Drug File is set to field in the 
Preference dialog box. Click Ok to accept the file as the default.

This drug file populates the Drug List list box and is now set as the default file

Setting the Default Drug File

Click Yes to set 
up a default drug file.

The Preference Dialog Box

Locating the Open Button

Check the Default Drug 
File is set to box.

Click the Change button.

Locate the file using the navigational 
pull-down tool.

Select the file.

Click Open.
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Understanding the Drug List

When the default drug file opens, the Drug List appears containing the drugs defined in 
that file.

When the Pharmacology Editor opens, the default drug file loads with “untitled” as the 
name of the default drug list appearing on the title bar. This “untitled” file can then be 
saved under a new filename after the drug list has been modified. 

A drug file saved from the Drug List window overwrites any other file of that name and 
location. It is recommended, therefore, that changes be made only to the “untitled” 
default file or to other user-created files. Modifying drug files supplied with the HPS6 
software may remove default information and make the information in the drug file 
unreliable. 

The lower portion of the Drug List window is inactive until a drug is selected from the 
list or added using the Add Drug command.

The default drug file opens as 
“untitled” on the title bar of the Drug 

List dialog box.

The drugs defined for the selected 
drug file appear in the Drug List list box

The lower portion of the window is 
inactive until a drug is selected or added.

The Drug List



7.18

APPENDICES

The Drug List Toolbar

The Drug List Toolbar is located beneath the title bar at the top of window.

The toolbar contains icons that provide the functionality needed to create, edit 
and remove drugs from the list. Most of this functionality can also be found in the 
Pharmacology Editor’s menu bar. 

Clicking on a icon (or selecting the menu command) accesses the functionality. 
However, not all icons are active for each drug. For example, only Generated drugs 
(newly created drugs) can be deleted and only Modified drugs (default drugs that have 
been changed) can be returned to their Default settings.

When Save is selected, an “untitled” file (loaded based upon the default drug file) must 
be renamed and saved to a user-assigned location.  Saving an existing file overwrites 
that file’s data with the new drug configuration.

ToolTips are available for the toolbar icons. To be able to view the tooltips, activate the 
Preference box by choosing the Preferences command from the PharmacologyEditor 
menu, then check the Show Tool Tips box.

The Drug List Toolbar

Icon Command Menu Command Function

New File>New
Replace the existing drug list with the default 
list

Open File > Open
Access the Open dialog to be able to locate 
and open a drug file

Save File > Save
Save the existing file (for a specific     
filename) or save and rename (an untitled file) 
using the Save Drug File As dialog

Edit Drug Open the Drug  to edit the selected drug

Drug to Default Drug > To Default
Return the selected Modified drug to the 
original default settings

Add Drug Drug > Add Add a new drug to the list

Delete Drug Drug > Delete Delete a Generated drug

The Preference Box

To turn the ToolTips on or off, 
check or uncheck the Show Tool 

Tips box.
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Drug Name

The Drug Name column on the left-hand side of the Drug List lists all the drugs avail-
able in the selected drug file. 

Drug Status

The Status column on the right-hand side of the Drug List displays a category that 
describes whether the drug has been newly created (Generated), created but not 
validated (Generated [invalid]), created from an original default drug (Modified) or 
remains in its default state (Default). 

When a drug is selected, the status of that drug determines the tools that can be used 
with that drug.

	 Default - Default drugs can be modified but cannot be deleted. 

	 �Modified - Modified drugs are default drugs that have been changed. Further 
changes can be made to modified drugs, and they can be returned to their 
default settings by selecting them and using the Drug to Default icon. Modified 
drugs cannot be deleted.

	� Generated - User-created drugs have a Generated status. Generated drugs 
can be changed and deleted.

	 �Generated [invalid] - User-created drugs that are newly created and have not 
had valid PharmacoKinetic and PharmacoDynamic profiles defined.    

All drugs can have their identification, units and physiological effects changed.

Drug Status

The drug’s status 
appears to the right of 

the drug’s name.
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Drug Administration Method, Labeling and Barcode Information

The lower portion of the Drug List window becomes active when a drug is selected.

The settings help to define the selected drug within the software. 

	 �Data Units - The option buttons in this box allow the user to set the 
drug measurement to either ug/kg (micrograms per kilogram) or mg/kg 
(milligrams per kilogram). This information is also used when editing the drug’s 
PharmacoKinetics.

	 �Drug appears on the User Interface - Checking this box activates the fields for 
the Label and the Units of measure that will be available on the HPS6 software’s 
user interface whenever the select drug appears. If this box is not checked, the 
drug will not appear on the user interface.

	 �Label identifies the name the user assigns to the drug. (Note: this field can be 
used to overwrite the generic drug name with a user-specific name.)

	 �Units determines drug’s administration methods and the respective units of 
measure that appear within the HPS system. At least one method must be 
assigned to each drug in order for the drug to be available for administration. 
An asterisk (*) or a blank entry in one of these fields disables this drug in that 
specific administration method.

Selecting a Drug
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METI recommends the following unit labels:

			   Bolus can be set in mcg or mg.

			   Infusion can be set in mcg or mg per min or hr.

			   Normalized Infusion is normalized to patient weight in kg.

		�  Drug is recognized by the Drug Recognition system - Checking this 
box    activates the fields that control the data provided by the barcoded 
syringe. 

		  �Barcode ID - This is the unique identifier for the barcoded drug. 
Duplicating an ID number overwrites the existing information for that 
number.

		  �Concentration - This value identifies for the software the concentration 
of the drug in units of the dose per milliliter.

		�  Label - This information includes the drug name and the concentration 
with its unit of measurement per milliliter and should match the label 
displayed with the barcode on the syringe. Barcodes have a  specific 
labeling format.
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Loading a Drug File

To load a drug file, click the Open icon on the Drug List toolbar or select the Open 
command from the File menu.

Once the Open command or the Open icon is selected, the Open dialog box appears,                
displaying the navigational tools needed to locate the drug file.

When the drug file is located, double-click on the filename or select the file and click the 
Open button. Note that the drug file has a suffix of MST.

With the  release of the Pharmacology Editor, the filenames assigned to the various 
profiles are as follows:

	 Adult patients: 		  DRUG.MST

	 Pediatric patients: 		  DRUGY.MST

	 Infant patients: 		  DRUGI.MST

Locating the Open Icon

The Open icon

Locating the Open Button

Click Open.

Select the file.

Locate the file using the 
navigational pull-down tool.
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Creating User-Defined Drugs
Because drugs can induce severe physiological effects, the introduction of modified or 
new drugs should be carefully considered. 

Modifying an Existing Drug

Drug modification takes place on three different interrelated screens:

The Drug List window - where the identification of the drug’s administration 
method and associated units are established. 

The PharmacoKinetics tab - where the time profile of the blood plasma and 
effector site concentrations following drug administration is determined.

The PharmacoDynamics tab - where the physiological effects of the drug are set,     
determining the patient’s reaction to the drug.

Once these screens are configured and verified, the modified drug becomes part of 
a newly defined set of drugs that can then be saved as a new drug file (with an MST 
extension). This drug file can then be used in the HPS software to modify specific drug 
responses.

Setting the HPS User Interface Information

Once a drug is selected in the Drug List window, the lower portion of the window is 
enabled. The information provided for the type of Data Units, the manner in which the 
Drug appears on the User Interface and the way in which the Drug is recognized by the 
Drug Recognition system sets the way in which these controls are identified in the HPS 
software.
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Editing a Drug’s PharmacoKinetics

Double-click on the drug name in the Drug List window or select the drug name and 
click the Edit Drug icon on the toolbar.  

Selecting a Drug to Edit

The Drug Profile screen opens, displaying the PharmacoKinetics tab.

The PharmacoKinetics Tab

ToolTips can be activated for the Drug Profile Screen by checking the Show Tool Tips 
box of the Preference box.

Select the drug to be 
modified from the list and 
click the Edit Drug icon

Or, double-click 
on the drug name

Establish the order of the 
kinetic sets using the First, 

Second and Third option buttons

Select the set to be edited 
by clicking the Base, Clinical and 

Compartment option buttons

Click the Check button to update, 
verify and populate the fields as well as 

the effector site concentration graph

Enter the new values in the 
fields of the selected set

Edit either the Tpeak or the 
Ke0 field to affect the speed of 
equilibration between the main 

effector site and the plasma

When editing is 
completed, click Apply
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The PharmacoKinetics tab allows for the user to specify the order of the kinetic data 
as First, Second or Third. Once the order of the kinetics has been selected, data can 
be entered in any of these three sets: 

Base-Set - these parameters reflect the inverse time constants and amplitudes 
of exponentials that can be fitted to plasma concentration data following a bolus 
dose, as well as the initial volume of distribution.

Clinical-Set - these parameters can be derived from the plasma concentration 
decay curve by inspection, rather than by curve fitting methods.

Compartment-Set - these parameters are used in a compartment model of                 
pharmacokinetics. 

The parameter fields available for each set are activated by clicking on the correspond-
ing button. Changing the values in these fields causes relevant corresponding changes 
to the values in the other sets when the Check or Apply buttons are selected.

Note: the pharmacokinetic order (first, second or third) affects the applicability and, 
therefore, the availability of the field. 

The Base Set
Parameter Units of 

Measure
Description

a 1/min Inverse time constant of the fastest exponential, usually reflecting distribution

b 1/min Inverse time constant of the slower exponential, usually reflecting distribution

c 1/min Inverse time constant of the slowest exponential, reflecting slow elimination for 
third order pharmacokinetics

A1 -- Relative amplitude of the fastest exponential

A2 -- Relative amplitude of the slower exponential

Vd L/kg Initial volume of distribution (bolus dose divided by initial concentration)
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The Clinical Set
Parameter Units of 

Measure
Description

Ta min Half time of the fastest decaying phase, usually reflecting distribution

Tb min Half time of the slower decaying phase, usually reflecting distribution

Tc min Half time of the slowest decaying phase, reflecting slow elimination for third 
order pharmacokinetics

Cl (L/kg)/min Clearance from the plasma

Vdss L/kg Steady state volume of distribution

Vd L/kg Initial volume of distribution (bolus dose divided by initial concentration)

The Compartment Set
Parameter Units of 

Measure
Description

k10 1/min Elimination rate constant

k12 1/min Rate constant for the distribution from the central compartment to the (first) 
peripheral compartment

k21 1/min Rate constant for the distribution from the (first) peripheral compartment to the 
central compartment

k13 1/min Rate constant for the distribution from the central compartment to the second 
peripheral compartment

k31 1/min Rate constant for the distribution from the second peripheral compartment to 
the central compartment

V1 L/kg Volume of distribution of the central compartment (identical to the initial volume 
of distribution

The PharmacoKinetics screen also allows for changes to the parameter ke0 (Ke0), the 
inverse time constant that determines the speed of equilibration between the main 
effector site and the plasma. This data can be entered specifically into the Ke0 field, or 
it can be entered as the time of peak effect, Tpeak. Checking the data (by clicking the 
Check button), automatically computes the corresponding field (i.e. if a new value is 
entered into the Tpeak field, clicking Check updates the Ke0 field and vice-versa). 

Clicking Check also updates the graph depicting effector site concentration.
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When the Check button is clicked, a verification appears in blue in the field above the 
button.

The PharmacoKinetics Data Check

If an error in data entry has occurred, the field displays a description of the computation 
error in red.

Once the application of pharmacokinetics data is successful, click Apply to apply all 
changes.

Editing a Drug’s PharmacoDynamics

From the Drug Profile screen, select the PharmacoDynamics tab.

The PharmacoDynamics Tab

A verification appears in blue or an 
error description appears in red when 
the Check or Apply button is clicked
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The PharmacoDynamics tab allows for the specification of the non-linearities 
associated to a drug response and to the independent specification of the 
magnitude of the response for neuromuscular blockade, respiratory and cardio-
vascular responses.

Threshold and saturation doses are established by completing the fields to the 
right of the graphical display of the dose response curve.

Dose Response Grraph with Threshold and Saturation Fields

The Threshold dose is the maximum bolus dose for which no noticeable effect 
occurs. 

The Saturation dose sets a limit on bolus dosage after which no further 
effect occurs. Some effect categories have “natural saturations,” such as, for 
example, a neuromuscular blocking drug when twitch height reaches 100%.  

Threshold and saturation doses apply to all three effect categories.

Clicking on NMB button activates the ED95 field.

Setting ED95

The magnitude of the effect on neuromuscular blockade (NMB) is specified by 
entering the dose that results in 95% (single) twitch height depression at the 
adductor pollicis (ED95). ED95 has to be bigger than the threshold dose. In 
METI patient simulators, neuromuscular blockade automatically reduces the 
force of the respiratory muscles, so no separate respiratory effect has to be 
entered.

After the Threshold and Saturation values have been entered, clicking the 
Check button at the bottom of the screen updates the graphical display of the 
dose response curve.

Clicking the NMB button 
activates the ED95 field
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Clicking the Effects on the respiratory system button activates fields for variables that        
determine the drug effects on breathing and ventilation.

Setting the Respiratory Effects

This data has to be specified for the baseline patient (dose equal to 0.0 by default) and 
for the maximum effect following a typical bolus dose. This dose has to be greater than 
the Threshold dose.

The Respiratory Variables
Variable Units of 

Measure
Description

Dose mg/kg Administered bolus dose

PaCO2 mg/kg Partial pressure of carbon dioxide (CO2) in the arterial blood. If this value is not 
available, the end-tidal CO2 is an alternative variable

Ve L/min Respiratory rate in breaths per minute

Slope CO2 (L/min)/
mmHg

Respiratory rate in breaths per minute

Vt ml Respiratory rate in breaths per minute

rr bpm Respiratory rate in breaths per minute

The tidal volume and respiratory rate data are used to determine the drug influence on 
the VT/rr ratio. There is no consistency check between this data and minute ventilation. 
These fields can also be left blank, resulting in no drug effect on the VT/rr ratio. 

Note that a blank or empty field (one with no data) indicates no effects while a field with 
a value input of 0 (zero) indicates that the dosage brings the value of the effect to zero.

Clicking the Check button at the bottom of the screen computes the direct drug effect 
on ventilation as well as the indirect effect on the control of breathing and transforms 
the data into the parameters used by the HPS software.
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Clicking the Effects on the cardiovascular system button activates activates fields for 
variables that determine the drug effects on the cardiovascular system.

Setting the Cardiovascular Effects

This data has to be specified for the baseline patient (dose equal to 0.0 by default) and 
for the maximum effect following a typical bolus dose. This dose has to be greater than 
the Threshold dose.

The Cardiovascular Variables
Variable Units of Mea-

sure
Description

Dose mg/kg or ug/
kg

Administered bolus dose

MAP mmHg Mean arterial pressure

hr bpm Heart rate

BRS bpm/mmHg Baroreflex sensitivity, expressed in change in heart rate over change in 
mean arterial pressure

SVR dyne sec/cm5 Systematic vascular resistance

PVR dyne sec/cm5 Pulmonary vascular resistance

LVSW gm Left ventricular stroke work. If LVSW data is not available, another measure 
for cardiac contractility, for example, ejection fraction or stroke volume, 
can be entered here. Note that these variables are only approximations

VC ml Venous capacitance. Changes in the vvenous capacitance or unstressed 
volume of the venous circulation greatly influence preload

Data for four (SVR, PVR, LVSW and VDC) of the cardiovascular variables are analyzed 
as relative changes. A reported 20% drop in SVR, therefore, can be represented by 
entering 100 in the first and 80 in the second row of the SVR column. In this case, the 
units are ignored. No change can be indicated by entering 100 (%) in both rows of a 
particular variable column. Leaving a column blank (no data) indicates no direct drug 
effect on these variables. This does not exclude changes caused by indirect drug 
effects through an activation of the baroreflex.

Clicking the Check button at the bottom of the screen computes the direct drug effect 
on cardiovascular system and the indirect on the baroreflex control of blood pressure 
and transforms the data into the parameters used by the HPS software.
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Clicking the Check button checks only the selected model (e.g. NMB, Respiratory). All 
three models must pass the check for the PharmacoDynamics check to be successful.

Whenever the Check button is clicked, a verification appears in blue in the field above 
the button.

The PharmacoDynamics Data Check

If an error in data entry has occurred, the field displays a description of the parameter 
error in red.

Once the data entry for pharmacokinetics information is complete, click Apply to apply 
all changes.

The pharmacodynamic part of the Pharmacology Editor derives drug response param-
eters from relative changes in the entered data: relative to the baseline patient data and 
normalized to patient weight. In the simulator, drug effects are computed (using these 
parameters) with respect to the simulated baseline, unmedicated patient. Resulting 
cardiovascular and respiratory drug responses may be different from the entered data 
for two reasons:

Differences between patients reported in the studies from which data are entered 
and the simulator patients, and

Differences in blood volume or ventilatory status.

A verification appears in blue or an 
error description appears in red when 
the Check or Apply button is clicked
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Creating a New Drug

Creation of a new drug occurs using the same steps as modifying an existing 
drug. To create a new drug complete the necessary information on the three 
different interrelated screens:

The Drug List window - where the identification of the drug’s administra-
tion method and associated units are established. 

The PharmacoKinetics tab - where the time profile of the blood plasma 
and effector site concentrations following drug administration is deter-
mined.

The PharmacoDynamics tab - where the physiological effects of the 
drug are set, determining the patient’s reaction to the drug.

Once these screens are configured and verified, the drug that has been created 
becomes part of a newly defined set of drugs that can then be saved as a new 
drug file (with an MST extension). This drug file can then be used in the HPS 
software to modify specific drug responses.

Note: When creating a new drug based on an existing drug, printing the Drug 
Profile Screen may be helpful.
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Pharmacology Editor Saving and Printing Options
The manner in which saving and printing information from the Pharmacology Editor 
can be performed depends on system onto which the Pharmacology Editor has been 
installed. 

Users may install the Pharmacology Editor on any system, but since printers cannot be             
connected to HPS workstations to ensure proper functionality and performance of the 
HPS software, specific procedures apply to both HPS and non-HPS workstations.

Saving on Non-HPS Workstations

If the Pharmacology Editor has been installed on a system apart from the Instructor 
Workstation and the HPS software, the saving and printing functions operate according 
to that system’s software and hardware capabilities. 

To save the active drug list, click the Save icon on the Drug List Toolbar or select Save 
from the File menu.

The drug list can also be saved as a different name or at a different location by select-
ing the Save As option from the File menu, opening the Save Drug File As navigational 
dialog. 

Saving the Active Drug List

The Save Drug File As dialog provides the ability to enter a Name and to navigate to the 
location where the new drug profile is to stored.

Click Save when the name and location have been specified.

Only valid user-generated and/or modified drugs can be saved.

Enter the name of the drug 
profile in the Name field

Click Save

Navigate using the pull-down menu 
and by clicking on folders in the panel
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Saving with the HPS System

If the Pharmacology Editor is installed on the Instructor Workstation, drug 
profiles can still be saved on the system in the same way that they are saved 
on an external system. However, if the user wishes to print or to store the files 
elsewhere, the files must be saved either to a CD or to a  USB memory device.

Saving to a CD

To save to a CD-ROM:

Insert a blank CD in the CD drive of the Instructor Workstation. A dialog 1.	
box appears with a field highlighted by default for labeling the CD.

Enter the new name in the 2.	 Name field (overwriting the default name).  

Click 3.	 OK.

Locate the folder with the information you wish to save.4.	

Select and drag the appropriate files from the drive to the CD.5.	

Double-click on the CD icon to open the window for the CD and confirm 6.	
the files have been copied.

Drag the CD file to the Trash icon on the Dock. When the CD file is over 7.	
the Trash, the icon changes to a Burn CD icon.

A dialog box appears with the options to Burn, Cancel or Eject.

CDs can also be burned by selecting the File menu from the Finder and then 
selecting the Burn Disc option.

Click the Burn button on the dialog box. Once burning is complete, the CD 
reappears on the desktop.

To remove the CD from the CD-ROM drive, drag the CD file to the Trash icon in 
the Dock. The icon changes to an Eject icon, and the CD is ejected.

CDs can also be ejected by selecting the CD file and choosing the Eject option 
from the Finder’s File menu or by pressing the Eject key (where available).
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Saving to a USB Memory Device

To save to a USB memory device:

Insert the USB memory device into an available USB port on the Instructor 1.	
Workstation. An icon appears on the desktop indicating that the memory device 
has been recognized.

USB Memory Device Icon

Locate the appropriate folder on the hard drive under HPSVersion6 containing 2.	
the file(s) to be saved.

Drag the file(s) from the folder on the hard drive to the memory device icon on the         3.	
desktop. The files are copied automatically onto the device.

Drag the icon to the Trash to disconnect the memory device.4.	

Remove the memory device from the USB port.5.	
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Printing

The Pharmacology Editor has three print options accessed by selecting the 
Print command from the File menu.

Note: The Instructor Workstation with the proprietary HPS system should 
NOT be connected to a printer. To print from the Instructor Workstation, save 
the file as a PDF (discussed below) and copy the PDF file to either a CD or a 
USB memory device (discussed above) and transfer the file to a printer-ready 
system.

The Print Options

The three print options offer three different views of the drug’s information:

Print Drug Brief - drug parameters, units and recognition in text (TXT) 
format

Print Drug Profile - drug units and label information, the PharmacoKinet-
ics profile, the PharmacoDynamics profile and the corresponding graphs

Print Drug Profile Screen - screenshots of the PharmacoKinetics and 
PharmacoDynamics tabs

Examples of these views are shown below. 

A Sample Drug Brief

The Drug Brief may be printed from either the Drug List or from the Drug Profile 
screen.
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      A Sample Drug Profile                                  A Sample Drug Profile Screen

The Drug Profile and Drug Profile Screen options are available only when the Drug 
Profile screen is active.

Saving as a PDF for Printing (for Mac)

Printing should not be performed from the Instructor Workstation. Instead, transfer the 
needed files to a CD or USB memory device and insert the CD or memory device into a 
computer with printing capabilities. 

If the Pharmacology Editor has been installed on a Mac, select the appropriate option 
from the Pharmacology Editor Print command menu. On the Print dialog, open the PDF 
pull-down menu on the lower left and select the Save as PDF option. The Save dialog 
appears, providing a Save As field for the file’s name and a Where navigational field 
to locate the place where the file is to be saved. Click Save to save the selected print 
material as a PDF.
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Order of Kinetics
The Pharmacokinetic information that must be provided for the drug profile to 
be valid is described in more detail earlier in this section, but the tables below 
show the fields that have to be completed for the first, second and third order 
of kinetics.

First Order
Base-Set Clinical-Set Compartment-Set

a Ta K10

Vd Vd V1

Second Order
Base-Set Clinical-Set Compartment-Set

a Ta K10

b Tb K12

A1 Cl K21

Vd Vd V1

Third Order
Base-Set Clinical-Set Compartment-Set

a Ta K10

b Tb K12

c Tc K21

A1 Cl K13

A2 Vdss K31

Vd Vd V1
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